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Montaža 

Osnovni pojmovi 

Kadar  je osnovna jedinica ili elemenat filma. Naziv je dobila po francuskoj reči “cadre” što znači 
okvir ili ram. U tehničkom pogledu, to je komad filmske trake koji je snimljen jednim neprekidnim 
radom kamere, a u praksi se kadrom često naziva sadržina obuhvaćena vidnim poljem objektiva. 
Karakteriše se fizičkim jedinstvom prostora, vremena i radnje. Svaki kadar sadrži u sebi 
svojevrsnu poruku, ima svoj smisao, ali istovremeno pripada većim celinama sadržaja, osnovnoj 
ideji i poruci dela. 

U svakom kadru objekti ne zauzimaju uvek isti prostor, nisu uvek iste veličine. Odnos između 

veličine objekta i vidnog polja objektiva naziva se plan; to je obim obuhvaćene sadržine u kadru. 

Svaki statičan kadar snimljen je u jednom planu, a kadar sa pokretnom kamerom ili pokretnim 
objektima snimanja može imati veći broj planova. U odnosu na veličinu ljudske figure koji 
obuhvata vidno polje objektiva kamere u jednom kadru, planovi se mogu podeliti na dve velike 
grupe: opšte planove i krupne planove. 

Opšti planovi omogućavaju gledaocu orijentaciju u prostoru, vremenu i radnji i obaveštavaju ga o 
svim prisutnim ličnostima jedne scene. U njima uvek dominira prostor koji okružuje ljudsku figuru, 
a cilj je da se pokaže gde se radnja odigrava i u kakvom se prostoru nalazi ljudska figura. 

Daleki plan (daleki total) predstavlja najšire zahvaćen prostor u kojem je ljudska figura veoma 
udaljena od kamere, 100 metara ili više. Ljudska figura je gotovo neprimetna. Najviše se koristi 
za isticanje efekata prostora (pejzaž, arhitektura), velike mase ljudi i slično. 

Opšti plan (total) sadrži objekat snimanja oko 30 metara udaljen od kamere. Ljudska figura se 
već bolje uočava, ali se lice ne može videti. Služi za prikazivanje masovnih scena ili ambijenata 
u kojima se odvija radnja. 

Srednji opšti plan (polutotal, srednji total) je deo celine u kojoj se prostor smanjio u odnosu na 
opšti plan, ali još uvek postoji velliki prostor za akciju glumaca. Nekolicina ljudi u kadru ima 
slobodan prostor iznad glave i ispod nogu za otprilike polovinu ljudske figure. 

Sredni plan je deo celine prostora u kojem se po pravilu prikazuju izbliza viđen ambijent i akcija 
jedne ili više ličnosti. Ljudska figura po visini zahvata prostor od gornje do donje ivice kadra, pa 
je pokret prema kameri ograničen, da figura ne bi bila isečena. Gestikulacija i mimika nisu 
organičene. 

Duga grupa planova (krupni planovi) takođe je određena prema veličini ljudske figure u kadru. 
Oni se dele na američki plan, srednje krupni plan, krupni plan i vrlo krupni plan (detalj). 

Američki plan ili ameriken je plan u kome se od potiljka do kolena vidi jedna ili više ljudskih figura 
u kadru. Vrlo je podesan za snimanje akcije jer omogućuje dubinsku kompoziciju kadra, kretanje 
unurar obuhvaćenog prostora, ali i mikromimiku glumaca. 
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Srednje krupni plan ili pokukrupni plan prikazuje čoveka snimljenog od temena do struka. U 
suštini je prelazna forma krupnog plana i u praksi se često koristi za snimanje ženskih likova da 
bi se istakle grudi, dekolte ili nakit. 

Krupni plan ili groplan prestavlja čovekovu glavu snimljenu od temena do ramena. Pokret u kadru 
je veoma ograničen, a lice maksimalno dolazi do izražaja. Zbog toga je veoma korišćen u 
snimanju scena koje treba da prenesu neku emociju. 

Što je plan krupniji, on je kompoziciono jednostavniji, a sadržinski i emocionalno izrazitiji. Još 
jedna njegova značajna osobina jeste nedostatak prostorno-vremenske autonomnosti iz koje 
proizilazi simbolika. 

Detalj, kao još krupnija varijanta krupnog plana, ima iste osobine i koristi se na isti način kao i 
krupni plan. U kadru je komponovan deo lica, deo tela ili neki izdvojen predmet. Pošto smo se 
objektu snimanja maksimalno približili, on je ovim planom maksimalno istaknut. 

Samo opštim ili samo krupnim planovima ne može se preneti celovita dramska radnja, odnosno, 
potrebno je koristiti kombinacije planova kako bi se uspostavio pravilan odnos celine i svih njenih 
delova. 

Položaj kamere po visini u odnosu na objekat koji snima naziva se rakurs. Rakursi mogu biti 
normalni, gornji, donji i promenljivi.  

Normalni rakurs je položaj objektiva kamere u horizontalnoj ravni, na visini čovekove figure u 
stojećem položaju, približne visine od 170 cm.  

Gornji rakurs (ptičja prespektiva, perspektiva jahača na konju) u kadru ima podignutu liniju 
horizonta, ili je ona sasvim izašla iz gornje ivice kadra. Kamera se po pravilu postavlja iznad 
objekta koji se snima. Gornji rakurs odgovara na pitanje „gde“, u smislu veličine prostora, 
masovnosti prizora i slično. Njegova osnovna vrednost je u privilegovanom, dominantnom 
položaju posmatrača, gledaoca u bioskopu ili lika na ekranu, u odnosu na posmatrani objekat. 
Zato nije slučajno da se često koristi prilikom televizijskih prenosa masovnih događaja i skupova. 

U psihološkom smislu, gornji rakurs smanjuje dimenzije objekta snimanja, pritiska ga na zemlju i 
pojačava osećanja izolovanosti, usamljenosti, podređenosti junaka, kao i osećanja kao što su 
strah, tuga, samoća, poniženje i slično.  

Donji rakurs je položaj kamere ispod objekta snimanja i ima liniju horizonta u donjem delu kadra, 
ili je ona izašla ispod donje ivice. Ljudska figura ili objekat izdvojeni su iz svoje sredine, prema 
nebu, oblacima ili nekoj drugoj udaljenoj pozadini. U psihološkom smislu, donji rakurs ističe 
sugestivnost sadržaja, sugeriše radost, polet, snagu, pobedu, superiornost. On perceptivno 
povećava dimenzije objekta u prednjem planu, pa time i njegov značaj i dominaciju.Gornji i donji 
rakurs se u paru koriste za stvaranje prostornog odnosa između pojedinih aktera ili predmeta, u 
smislu gore-dole, ali se mogu koristiti i za pojačavanje dramaturškog efekta priče. 

Rez je specifično mesto na kojem se jedan kadar nastavlja drugim kadrom. To je trenutan 
završetak jednog kadra i isto takav početak sledećeg. Nekad se rez odnosio na fizičko 
sastavljanje krajeva filmske trake, ali on označava i isti taj efekat na ekranu. 
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Možda najvažnija osobina montaže jeste mogućnost da se rezom s jednog na drugi kadar 
srvaraju specifični filmski prostor i vreme. Rez će gledaocu dati iluziju kontinuiteta prostora i 
vremena unutar filmske akcije. 

Montaža je odabiranje pojedinih odlomaka i delova i sastavljanje u jednu skladnu umetničku 
celinu prema određenom planu. Kao takvu, montažu srećemo u književnosti, muzici, radiju, 
fotografiji, filmu itd. Od najranijih dana filma, brojni stvaraoci i teoretičari smatrali su da filmska 
montaža igra veoma važnu ulogu u ovoj novoj umetnosti pokretnih slika, verujući da je montaža 
u stanju da oblikuje, poboljša, pa i stvori filmsko delo. Da je to zaista tako, potvrđuje i kategorija 
„Najbolja filnska montaža“ u kojoj se dodeljuje prestižna nagrada Oskar, još od 1934. godine. 

Da li će naš film biti zanimljiv i dobar, u velikoj meri zavisi od montaže. Da li će priča biti logična, 
da li ćemo se snaći u prostoru, odrediti pravo značenje vremena, da li će film trajati onoliko koliko 
je potrebno – sve to zavisi od montaže.  

Od dobro snimljenog materijala neretko može ispasti loš film, ukoliko nije dobro montiran. Zato 
ćemo se pozabaviti nekim osnovnim postupcima u montaži. 

Kada se u stvarnom životu nađemo usred neke scene u kojoj se nešto događa, naša pažnja i naš 
pogled se prirodno kreću u različitim pravcima, prateći događaje i predviđajući njihov budući 
razvoj. Na primer, ako na ulici vidite osobu visoko podignute ruke, pogled će vam instiktivno otići 
dalje niz ulicu da biste uočili vozilo koje ta osoba zaustavlja, a ako pored nje prođe taksi ne 
zaustavivši se, pogled će vam se vratiti na osobu, da vidite da li joj je ruka i dalje podignuta i da 
procenite da li je uopšte htela da pozove taksi ili da nešto drugo saopšti podignutom rukom. 

Osnovno psihološko obrazloženje montaže kao postupka leži u tome da ona reprodukuje umni 
proces koji je upravo opisan, a u kome se slike smenjuju kako se naša pažnja premešta sa jednog 
na drugi predmet u okolini.  

Drugim rečima, kako i naš um pomoću rezova prelazi sa jedne slike na drugu, tako smo i mi u 
stanju da filmsko prikazivanje stvarnosti uz pomoć brzih promena prihvatimo kao opravdan i 
ispravan način prenošenja zapažanja. 

Ipak, ovakvo objašnjenje, premda logično, dosta je pojednostavljeno, i to iz sledećeg razloga: u 
opisanom događaju sve slike se smenjuju bez da posmatrač promeni sopstveni položaj. On menja 
samo pravac gledanja, ostajući pritom statičan.  

U filmu to veoma često nije slučaj, i montažer ponekad ima zadatak da predstavi scenu iz različitih 
uglova gledanja ili sa različite udaljenosti, što u realnosti fizički ne bi bilo izvodljivo. 

Pozabavimo se najpre udaljenošću, odnosno veličinom kadra. Kada u stvarnom životu 
posmatrate neki prizor, naprimer kuhinjsku policu prepunu predmeta, pa vam pažnju privuče 
određeni predmet (naprimer plava šerpa na tufne), da biste je pobliže pogledali, morate da 
ustanete i približite joj se, dakle da promenite udaljenost.  

Na filmu se to može postići snimkom najpre cele police, a onda rezom na krupni kadar samo te 
šerpe. Tim postupkom montažer ne prenosi verno kako mi tu scenu doživljavamo u realnom 
životu, ali nam tumači umni proces koji nam omogućava da scenu vidimo. Gledalac zato ovaj 
postupak prihvata kao psihološki opravdan, i rez na krupni plan ne doživljava kao nasilan ili 
neprirodan. 
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Osim veličine kadra, postoje i slučajevi kada je potrebno upotrebiti rez da bi se prešlo na kadar 
snimljen iz drugog ugla ili koji čak gleda u pravcu različitom od pravca prethodnog kadra. Primer 
za to su dijalozi, kada montažer često prelazi rezom sa jednog krupnog kadra na drugi, menjajući 
pritom i pravac gledanja i položaj iz kog je kadar snimljen.  

Pošto je tako nešto nemoguće u stvarnom životu, opravdanje za ovaj postupak u montaži ne treba 
ni tražiti u paraleli sa našim doživljajem stvarnosti, već u samoj definiciji filma kao umetnosti. 

Naime, kad režiser režira film, njegov cilj nije da prikaže događaje što vernije stvarnom životu, 
već da ispriča neku priču. Dakle, on događaje tumači, prikazujući ih na način koji on smatra 
dramaturški najpogodnijim, u cilju da izazove određene reakcije kod gledalaca.  

Dramaturgija se u ovom kontekstu može definisati kao veština autora da izborom i rasporedom 
materijala upravlja pažnjom, interesovanjem i procesom mišljenja gledalaca. 

Na primeru dijaloga, cilj režisera (najčešće) nije da da sliku dijaloga iz ugla samo jednog 
sagovornika (jer bi se onda videla samo osoba koja stoji nasuprot govorniku), niti iz ugla 
neutralnog posmatrača, jer bi u tom slučaju mogao da koristi opet samo kadrove snimljene iz 
samo jednog ugla.  

Umesto toga, on želi da prikaže scenu u svoj njenoj dinamici, i zbog toga redom stavlja kameru 
u onaj položaj koji najbolje beleži određeni trenutak radnje, ili detalj koji je od dramaturškog 
značaja, naprimer emotivne reakcije sagovornika.  

Gledajući scenu iz različitih uglova istovremeno, režiser nam daje najrečitije, tj najizražajnije 
scene, bez obzira na to što niko to u realnom životu ne bi mogao na taj način da doživi. Ipak, 
gledaoci sa tim nemaju nikakav problem i ne doživljavaju te scene kao neprirodne, iz prostog 
razloga što gledaoci i ne očekuju od filma da bude prosta reprodukcija stvarnosti, na isti način 
kao što ne očekuju od umetničke slike da bude verni fotografski prikaz sveta, ili od romana da 
sadrži precizne informacije kao da je u pitanju izveštaj. 

Dugim rečima, gledalac prihvata pravo autora filma da nam interpretira događaje na način na koji 
on smatra da je najopravdanije. 

Dakle, da rezimiramo: ukoliko reditelj koristi rez da naglo pređe sa jedne slike na drugu, to može 
da bude reprodukcija normalnog mentalnog postupka kojim se u životu izoluju predmeti na koje 
je usmerena naša pažnja (primer plave šerpe). 

A može da uzima i uglove gledanja za koje ne postoji paralela u svakodnevnom životu (primer 
dijaloga), s tim da se tada opravdanje za takav postupak traži u pravu umetnika da interpretira 
stvarnost na način za koji smatra da je najopravdaniji da prenese određenu poruku. 

 

Upravljanje pažnjom gledalaca 
Sadržaj filmske slike stalno je podložan promenama usled upotrebe različitih parametara kadra: 
objektiva, uglova snimanja, rakursa, planova, vrste osvetljenja i pokreta. Nagli skokovi zona 
pažnje s jednog dela ekrana na drugi (naročito ako se radi o velikom platnu), vizuelno-dinamički 
deluju na gledaoce.  
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Zona pažnje stvara se najrazličitijim likovnim i zvučnim sredstvima kadra. Gledaočevo oko 
spontano traži mesto na kojem će se zadržati. Ali reditelj je taj koji organizuje kadar, i ništa se ne 
sme prepustiti slučajnosti, a najmanje lutanje gledaočevog oka, dakle, ono mora biti usmereno, 
organizovano. 

U kadru se najčešće nalazi samo jedna zona pažnje, a najjednostavniji način njenog usmeravanja 
jeste krupni kadar. Međutim, to nije uvek slučaj i neretko je potrebno da se pažnja gledaoca 
usmeri korišćenjem nekog od ovih postupaka: 

 

- Pokretom ili dijalogom. Osoba koja u kadru govori ili se kreće uvek na sebe privlači pažnju 
gledalaca. 

- Pokretom kamere tako da se objekat na koji se želi skrenuti pažnja najbolje vidi, tj ističe 
- Objekat pažnje u određenom trenutku počinje da se kreće, dok se ostali objekti 

istovremeno zaustavljaju. Varijacije su: objekat pažnje stoji za razliku od ostalih koji se 
kreću, ili se kreće drugom brzinom ili drugim pravcem u odnosu na ostale 

- Zona pažnje je drugačije osvetljena u odnosu na okolinu 
- Objekat pažnje je postavljen u prednji plan u odnosu na ostale koji su u pozadini 
- Centar pažnje se po boji jasno razlikuje od okoline 
- Centar pažnje se po svojim zvučnim karakteristikama razlikuje od okoline, itd. 

 
U praksi, gotovo da je pravilo da se slika optički izoštrava na predmetu pažnje; u širem smislu, 
svi navedeni postupci takođe predstavljaju svojevrsno uoštravanje zone pažnje. 

Kadar često može da bude komplikovan, jer sadrži istovremeno i pokretne i nepokretne objekte, 
kompoziciju po dubini kadra, svetle i tamne objekte i površine različitih boja, aktere okrenute licem 
ili leđima prema kameri, itd. U takvim slučajevima, odrediti preciznu zonu pažnje uopšte nije 
jednostavno, ali je neophodno, jer od toga zavise razumljivost, tečnost i ritam izlaganja sadržaja. 

Ono što umnogome olakšava ovu nedoumicu jeste upotreba kretanja. Nikako ne treba da 
zaboravimo da kretanje u kadru uvek predstavlja odlučujući faktor usmeravanja pažnje. Ovako 
stvorena zona smanjuje značaj okolne sadržine, ponekad u tolikoj meri da sve izvan kretanja 
ostaje i van precepcije. Ova pojava ima svoje dobre strane utoliko što se time uklanjaju nebitni 
elementi ili sve ono što bi delovalo kao greška. 

 

Bipolarna organizacija prostora 
Bipolarna organizacija prostora jedno je od najvažnijih i najčešće korišćenih pravila na filmu i 
televiziji. Kadar osobe koja nešto posmatra, na nešto pokazuje ili nešto nišani, sugeriše sledeći 
kadar objekta koji se posmatra, na koji se pokazuje ili nišani. To je formacija dinamičkog para, u 
kojoj posmatrač predstavlja jedan pol, koji je objektivan (viđen očima gledalaca), a posmatrani 
objekat – drugi pol, koji je subjektivan, i viđen očima posmatrača u kadru. 

Da bi shvatili smisao montažne veze dva kadra, gledaoci ne samo da anticipiraju smisao prvog 
kadra u sledeći, već i obratno: anticipiraju smisao drugog kadra u prethodni. Dakle, princip 
bipolarne organizacije primenjen na jezik pokretnih slika predstavlja spontanu fuziju dva kadra u 
montažnom spoju. 
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Na primer, u prvom kadru vidimo osobu koja gleda ulevo, a u drugom neki pejzaž. Ovaj kadar je 
subjektivan, viđen njenim očima, ali se i u našoj svesti on prostorno nalazi sa leve strane. 

Međutim, moguće je da se u drugom kadru posmatranog objekta istovremeno pojavi i sam 
posmatrač. Tada dolazi do dvostruke objektivizacije koja narušava bipolarnu organizaciju 
prostora i stvara kratkotrajnu zabunu kod gledalaca koji očekuju samo subjektivan kadar. Tako 
se dolazi do zaključka da posmatrač posmatra samog sebe. Režiser Akira Kurosava je u svom 
kultnom filmu „Rašomon“, naprimer, više puta namerno upotrebio ovaj postupak kako bi postigao 
određeni dramski efekat. 

Kako se u dvostrukoj objektivizaciji izbegava efekat dezorijentacije? Pravcem pogleda. Naime, 
na kraju prvog kadra, posmatrač treba da pogleda negde neutralno, naprimer pored sebe ili u 
neki predmet u svojim rukama. Tako će sledeći kadar biti logično objektivan, to jest biće viđen 
našim očima nevidljivih posmatrača i svedoka. 

 

Pravac pogleda 
Pravac pogleda je zamišljena prava linija koja produžava pogled subjekta van ivica kadra, 
naročito na kraju kadra. On može da se usmeri u bilo kom pravcu. 

Ako dva aktera iste visine gledaju jedan u drugog, njihovi pravci pogleda biće horizontalni i 
suprotni (slika 1).  
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Pravci pogleda u pojedinačnim kadrovima koji se međusobno povezuju nazivaju se odgovarajući 
pogledi. Oni su uvek suprotnih pravaca, čime se stvara vizualni kontinuitet i utisak da se akteri 
međusobno posmatraju (slika 2).  

 

Ako pak gledaju u istom pravcu, u oba kadra, onda na ekranu izgleda kao da gledaju u istom 
pravcu prema nekoj trećoj osobi ili predmetu, odnosno da je osoba u drugom kadru iza prve osobe 
i gleda je u leđa ili potiljak (slika 3). 

 



 

Interreg – IPA CBC Bulgaria – Serbia Programme  

CB007.2.13.212 

 
 

8 
 

Ako su akteri razlličite visine ili se u prostoru nalaze jedan iznad drugog, gledaće naizmenično u 
pravcu vertikalnih i horizontalnih ivica kadra, od sredine vertikalne ose sa leve i desne strane, 
prema sredini horizontalne ose. Na primer, ako prvi akter gleda naniže u pravcu donjeg desnog 
ugla, u drugom kadru će drugi akter gledati naviše, prema gornjem levom uglu, i obratno (slika 
4). 

 

Ako su akteri iste visine i međusobno se posmatraju, a iz nekog razloga je potrebno da se snimaju 
iz nešto oštrijih gornjih ili donjih rakursa, na ekranu će se steći utisak da ne gledaju jedan drugog, 
već da su spustili ili podigli glavu i pogled. 

Pogled aktera koji nešto posmatra van kadra kod gledalaca budi jaku radoznalost da vide u šta 
on to gleda, ali u tome ne smeju biti zbunjeni. Bipolarna organizacija prostora  pravcima pogleda 
gradi jedan specifičan prostor, njegovu veličinu i subjektivno osećanje šta je levo, desno, gore, 
dole i dr. Na osnovu daljeg razvoja kadriranja veće celine po ovoj shemi, gradi se trijada. 

Trijada je minijaturna scena sastavljena od tri kadra i ima veoma važnu ulogu u montiranju 
narativnih scena. Na primer, u prvom kadru vidimo nekog kako nešto posmatra, u drugom kadru 
vidimo šta posmatra, u trećem kako on na to reaguje. Gledalac prihvata sva tri kadra kao da su 
deo jednog istog prostora i vremena, iako su u realnosti ovi kadrovi mogli biti snimljeni na velikog 
prostornoj i vremenskoj udaljenosti jedan od drugog. 

Trijada je najmanji i najjednostavniji dramski oblik scene, relativno zatvorene i samostalne 
strukture. Prva dva kadra u osnovi sadrže elementarni oblik pariteta, akciju i reakciju koji se u 
svesti gledalaca sintetišu. Treći kadar ima istovremeno dve funkcije: da pokaže efekat ili posledicu 
neke radnje ili ponašanje ili reakciju junaka koji je nosilac radnje. Na primer: 1) čovek nešto 
posmatra van kadra; 2) vidimo predmet njegovog interesovanja ; 3) reakcija čoveka na predmet; 
ili 1) automobil juri ka čoveku; 2) čovek se uplašeno okreće; 3) automobil obara čoveka. 

Trijadom gledalac dospeva u sam dramski prostor, samo središte zbivanja ili dramskog konflikta.  
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Neprekidnost toka radnje 
Pre nego što se jedna filmska scena potpuno uobliči, montažer obavlja dva različita postupka sa 
materijalom: prvi je gruba montaža kadrova kojom se postiže da da se kadrovi nižu u redosledu 
koji stvara filmsku celinu i omogućuje neprekidnost radnje. Drugi je da još jednom obradi materijal 
kako bi kontinuitet bio i u fizičkom i u psihološkom smislu što precizniji.  

Prvi postupak se još naziva i „sečenje“ (cutting), a drugi „montiranje“ (editing), s tim što su u praksi 
često neodvojivi, tj ne sprovode se baš svaki put kao dva zasebna, strogo odvojena postupka. 
Ipak ćemo se njima ovde baviti odvojeno, jer se pri njihovoj obradi postavljaju donekle različiti 
problemi. 

Prilikom grube montaže, osnovni zahtev je da se postigne razumljiv kontinuitet i da rezovi budu 
što je više moguće glatki. Gladak rez zapravo znači povezivanje dva kadra na takav način da 
prelaz ne izaziva nikakav vidni skok niti narušava gledaočevu iluziju da prisustvuje neprekidnom 
nizu događaja.  

Na primer, ako imamo u opštem planu glumca koji se nalazi u pustinji, pa odmah potom pređemo 
na sredsnji plan tog isto glumca kako sedi u sobi, načinilli smo neprihvatljiv prelaz jer gledalac 
odmah shvata da ne prisustvuje neprekidnom toku radnje i oseća nelagodnost zbog nelogičnosti. 
Princip glatke montaže počiva, dakle, na tehničkoj osnovi: kako uskladiti kadrove da bi se postigla 
iluzija kontinuiteta.  

Međutim, treba imati u vidu da dramaturški zahtevi stoje iznad svih tehničkih zahteva, odnosno, 
pravila koja ćemo navoditi ne mogu da se uzmu kao obavezujuća, i svako pravilo se može prekršiti 
ukoliko za to postoje dramaturška opravdanja, tj ako vizija režisera zahteva da se ono prekrši. 

 

Usklađivanje radnje u redosledu kadrova 
Najosnovniji zahtev glatkog kontinuiteta je da se radnja koja sledi u kadrovima u nizu, podudara. 
Dok se film još snima, reditelj će se uvek truditi da se u svakoj sceni koja se snima iz više uglova 
glumci nalaze u istom položaju i naspram iste pozadine.  

Na primer, ako opšti plan prikazuje sobu sa određenim rasporedom nameštaja, a u srednjem 
planu se javlja drugačiji raspored, rez sa jednog na drugi kadar će stvoriti osećaj diskontinuiteta. 
Ipak, održavanje iste pozadine u nizu kadrova koji se snimaju nije težak zadatak. Ono što jeste 
teže je da se radnja i pokret u kadrovima koji doilaze u nizu, tačno podudaraju. 

Na primer, ako glumac započne pokret – recimo da je do pola stigao u pokretu otvaranja vrata – 
u jednom kadru, onda taj isti pokret mora da se nastavi u sledećem upravo tamo gde je prekinut. 
Ako montažer poveže ta dva kadra tako da se deo radnje ponavlja, to će izgledati neprirodno. 
Isto tako, ako izostavi deo radnje (naprimer, pređe iz kadra u kome su vrata poluotvorena pravo 
u kadar u kom su zatvorena), napraviće osetan skok i prelaz neće biti gladak. 

Ukslađivanje radnji u dva uzastopna kadra relativno je lak posao, i svaki montažer će već posle 
malo stečenog iskustva znati tačno gde da napravi rez. Ono što je mnogo teže je rešiti pitanje na 
kom tačno mestu napraviti rez u toku jednog određenog pokreta.  
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Uzimimo sledeći primer. Za stolom, na kom se nalazi čaša vina, sedi čovek. On se naginje napred, 
desnom rukom uzima čašu, podiže je i pije. Pretpostavimo da je ova jednostavna scena snimljena 
iz tri različita plana (krupni plan, srednji i opšti plan) i pogledajmo na koliko ih je načina moguće 
izmontirati. 

 

sl. 5 

Ako montažer namerava da rezom pređe sa opšteg plana na srednji, na raspolaganju su mu dve 
mogućnosti: radnja može da počne opštim planom da bi u nekom trenutku kretanja ruke na gore 
ili nadole, prešla u srednji plan koji odgovara tom pokretu. Ili, može da sačeka trenutak kada ruka 
hvata čašu i tako uradi rez da se ceo pokret ruke nagore vidi u sledećem kadru. 

Ovo drugo rešenje je preporučljivije, jer ako se jedan određeni pokret prikazuje u opštem planu, 
a naredni u srednjem, rez neće prekidati zamah radnje koja je u toku, već će na neki način izazvati 
ustisak da se dve posebne faze pokreta vide na dva odvojena načina, ali se tok pokreta ne prekida 
dok se sam od sebe ne zaustavi u jednom trenutku. 

Radnja se može zaustaviti još u jednom trenutku – kada glumac upravo hoće da započne pokret, 
što bi bio treći i možda i najbolji način obeležavanja mesta reza. Naime, u trenutku kada glumac 
hoće da se nagne napred, njegov izraz lica ili pogled nadole otkriće nam njegovu nameru. 

Ako se rez napravi upravo u ovom trenutku, dakle, pre nego glumac pokrene ruku, on će biti 
gladak, jer će se podudarati sa trenutkom prelaza iz stanja mirovanja u pokret. Pre reza, vidimo 
glumca kako mirno sedi, a kada gledalac shvati njegovu nameru da načini pokret, on želi da vidi 
efekat tog pokreta i spreman je da njegov ishod vidi u sledećem kadru. 

Ako je potrebno da se postigne obrnuto, to jest da se rezom pređe sa srednjeg na krupni plan, 
opet postoji rezon da se to obavi dok je pokret u toku. Najveći deo toka radnje može se prikazati 
u srednjem planu, a da se rezom pređe na krupni u onom trenutku pokreta nagore u kom ruka 
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ulazi u kadar. Ovakav rez je efektan jer on dolazi upravo u trenutku kada značaj radnje treba da 
se porenese na krupni plan. 

Iz svega ovog možemo zaključiti da je, u načelu, rez na kraju ili na početku pokreta, kao i rez 
kojim se prikazuje deo radnje koji pre toga nismo videli, obično bolji od reza kojim se nasilno 
prekida pokret u toku. Međutim, važno je naglasiti da to nije uvek slučaj i da postoje i oni slučajevi 
u kojima rez koji prekida pokret ima svoje dramaturško opravdanje. 

 

Izmene u veličini plana slike i ugla snimanja 
Na slici br 5 vidi se kako je moguće preći sa daljeg plana na dva bliža plana, između kojih može 
da se načini izbor. Primetićete da je razlika u veličini slike između a i b veoma mala, i da im je 
likovna kompozicija gotovo jednaka. Prema tome, rez sa a na b neće dati zadovoljavajuće 
rezultate.  

Slika koju gledalac vidi će se veoma malo izmeniti, ali će ta promena, ma kako bila mala, biti jasna 
i neprijatna, jer nema dovoljno promena da bi prelaz mogao da bude gladak. Međutim, prelazom 
sa a na c postiže se izražena promena- kompozicija kadrova je sasvim drugačija i rez će biti 
gladak jer neće postići neznatnu, već vrlo jasnu promenu. 

 

sl. 6 

Sličan primer vidimo i na slici br 6. I ovde se rezom sa a na b postiže toliko mala promena, da 
takav rez nije opravdan. Ako se želi rez na krupniji plan, onda takav plan treba da bude znatno 
krupniji, kao što se vidi u kadru c. 
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Osim samog mehaničkog postupka, postoji još jedan zahtev koji prelaz sa a na b ne zadovoljava. 
Naime, svakim rezom treba nešto da se saopštava, odnosno, za premeštanje pažnje gledaoca 
sa jedne slike na drugu mora uvek da postoji neki razlog. Prilikom reza sa a na b promena je 
toliko neznatna da nije opravdana ni sa dramaturške tačke gledišta. Gledalac će, naime, osetiti 
da mu se ovim rezom ništa značajno ne saopštava, a takav zaključak pobuđuje nezadovoljstvo. 

Ono što važi za veličinu slike, važi i za razliku u uglu snimanja između dva uzastopna kadra. Na 
slici br 7 vidi se plan položaja kamere prilikom prelaza sa srednjeg na krupni plan. Na crtežu se 
vidi čovek koji stoji licem okrenut kameri pored ulične svetiljke. Iz prvog položaja kamere treba 
rezom da pređemo na krupni plan. Rez sa I na IIa donosi nam krupni plan u kome je svetiljka u 
istom položaju u odnosu na čoveka, kao što je bilo u prethodnom kadru. 

sl. 7 

Rez je u ovom slučaju prihvatljiv, jer nam predstavlja istu sliku kao i prethodni kadar, samo ovog 
puta bliže. Ali, ako se krupni kadar snimi iz položaja kamere IIb, gde je ugao snimanja izmenjen 
dobiće se slika kakva se vidi na crtežu. Kao rezultat toga, gledalac će imati utisak da se svetiljka 
neobjašnjivo pomerila ulevo i unazad. Gledalac je svestan te promene čim se slika pojavi na 
ekranu, a rez, naravno, samim tim nije gladak. 
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Ako reditelj iz bilo kog razloga želi da pređe rezom na krupni kadar koji jeste snimljen iz drugog 
ugla, onda ta promena treba da bude upadljiva. Položaj kamere, kada se ona pomeri za 90 
stepeni, daće sasvim drugačiju sliku i na taj način neće zbuniti gledaoca. Naprimer, lice glumca 
će se videti iz profila umesto spreda, pa gledalac neće ni očekivati da vidi istu pozadinu kao u 
prethodnom kadru. 

sl. 8 

 

 

Poštovanje pravca 
Kad god se na ekranu prikazuju dve strane koje se na neki način suprotstavljaju (bilo da su u 
pitanju dva lica u dijalogu ili dve velike vojske u sukobu), mora se voditi računa da radnja bude 
jasna i u smislu fizičke orijentacije, odnosno da gledaocu u svakom trenutku bude jasno šta se 
gde nalazi. Na slici 8 se vidi da susedni krupni planovi imaju suprotne pravce pogleda. Kadrom I 
se utvrđuje da su A i B licem okrenuti jedan ka drugom.  

Kada su potrebna dva krupna kadra, svaki snimljen preko ramena drugog glumca, postavlja se 
pitanje gde da se postavi kamera. Ako odlučimo da to bude položaj IIa,, B će opet biti okrenut u 
pravcu s leva na desno kao što je bio u srednjem planu. U tom slučaju će rez biti jasan. 

Ako bi to bilo IIb, krupni kadar će pokazivati da je B okrenut s desna na levo, i u tom slučaju prelaz 
neće biti jasan, jer je pravac u kom glumac gleda izmenjen. Isto važi i za krupni plan osobe A: on 
mora biti snimljen iz IIIa, kao što je i prikazano na slici. 

Pravilo poštovanja orijentacije važi i u slučajevima kad se snima scena u kojoj glumac naprimer 
ulazi u kadar ili izlazi iz kadra, gde pravac njegovog kretanja mora da bude u skladu sa pravcem 
u prethodnom kadru. Na slici 9 se to vidi na primeru. Ako glumac izađe iz kadra na desno, biće 
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savršeno prirodno da u sledeći kadar uđe sleva, to jest da rezom pređemo sa I na IIa. Ukoliko 
bismo rezom prešli na IIb, stvorio bi se neprihvatljiv prelaz koji bi stvarao utisak da se glumac u 
trenutku i bez ikakvog razloga okrenuo za 180 stepeni. Ako se u scenariju zahteva da se glumac 
okrene tako da promeni pravac kretanja, onda taj trenutak mora da se na ekranu pokaže ili na 
neki drugi način saopšti gledaocu.  

 

sl. 9 

 

 

 

To je ilustrovano slikom 10, gde vidimo u a da se čovek kreće s leva na desno i izlazi iz kadra. U 
b vidimo da se okreće, te smo tako spremni da vidimo kao u c ulazi u kadar zdesna. Bez kadra b 
radnja ne bi bila jasna, jer gledalac ne očekuje da se radnja odvija u pravcu zdesna na levo, pa 
bi pojava glumca koji ulazi sa desne strane bila neprikladna i zbunjujuća. 
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sl. 10 

Još jednom naglašavamo da su ovo uopštena pravila koja važe u najvećem broju slučajeva, ali 
ne isključivo, jer postoje izuzeci koji imaju svoju svrhu u postizanju određenih dramaturških 
efekata. 

 

Poštovanje jasnog kontinuiteta 
Osim poštovanja pravca kretanja, postoje još neke stvari na koje je potrebno obratiti pažnju ako 
želimo da postignemo jasan i čist kontinuitet. Na primer, skoro bez izuzetka, sekvenca koja nas 
vodi na neko novo mesto događaja treba da počne od utvrđivanja topografskog odnosa između 
glumca i okoline. Zatim će nas više raznovrsnih krupnih planova pojedinih likova i predmeta bliže 
upoznati sa okolinom koju smo već videli u opštijim kadrovima.  

Naravno da i od ovog pravila ima izuzetaka: na primer, reditelj može da odluči da sekvencu 
namerno započne detaljem, da bi kasnije postepeno otkrivao sredinu u kojoj se on nalazi. 
Međutim, čak i u slučaju kad sekvenca počinje detaljem, važno je da se u određenom trenutku 
prikazivanja vidi ono što okružuje taj detalj. 

Ako taj princip primenimo još šire, videćemo da veoma krupnom planu treba da prethodi detalj u 
svojoj sredini, to jest kadar u komse se isti predmet vidi iz malo veće udaljenosti. 

Isto tako, ako se situacija na neki način izmeni u odnosu na ono što smo izložili kadrovima kojima 
se predstavlja situacija, tada scena mora ponovo da se predstavi. Ako, na primer, nova ličnost 
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ulazi u neku prostoriju, neophodno je da je vidimo dok ulazi i da vidimo gde ona stoji u odnosu na 
druge ličnosti, pre nego uvedemo bilo kakav krupan kadar.  

 

 

Posle toga, kada krupni kadrovi počnu da se smenjuju, mi tačno znamo gde se ko nalazi u 
prostoriji. Isto tako, kad god neko od njih počne da se kreće, kamera se povlači malo unazad da 
bi njegovo kretanje bilo jasno. 

Kao što je već rečeno, za svaki rez mora da postoji opravdan razlog: premeštanje pažnje sa slike 
na sliku, ma kako vešto izvedeno, nema nikakvog opravdanja u slučaju da se obema slikama 
saopštava isto.  

Na primer, prelazak rezom sa srednjeg na krupni kadar lica glumca može da bude gladak i 
efektan, ako se njime saopštava nešto i u dramaturškom pogledu (glumac izgovara važnu 
rečenicu ili prenosi emociju), ali može i da bude pogrešan, ako nije izveden u pravom trenutku. 
Na primer, ako pređemo na krupni plan u trenutku kad glumac izgovara banalnu rečenicu tipa 
„molim vas, jednu slađu kafu“, mi time podvlačimo dramaturški beznačajan podatak, i takav rez 
ne bi bio gladak. 

Dakle, iako se mehanička pravila montaže ne smeju zanemarivati, presudnu ulogu prilikom 
odlučivanja o rezu izmeu dva kadra imaju dramaturški zahtevi. Redosled kadrova u kome svaki 
rez ima svoju dramaturšku ulogu, često će i pored malih mehaničkih grešaka izgledati gladak. 

Pogledajmo jedan primer. Čovek sedi u fotelji. Stavio je cigaretu u usta i traži šibice, i jasno je da 
ne može da ih nađe. Pogledom prelazi preko sobe i odjednom vidimo da je zadovoljan onim što 
je ugledao. On ustaje, odlazi u drugi kraj sobe i uzima šibice sa stola. 

Ova scena može da se montira na dva različita načina. Celokupna radnja u fotelji može da se 
odigra u jednom kadru, da bi se zatim pokreti glumca nastavili u narednom kadru u kome se 
pokretom kamere prati glumac u kretanju ka stolu. Rez bi bio mehanički gladak, a radnja jasna. 

Po drugom načinu montiranja, prvi kadar mogao bi da bude isti kao u prethodnoj verziji, a zatim, 
u trenutku kad glumac ugleda ono što traži van kadra i upravo se sprema da ustane, rezom 
prelazimo na predmet njegovog interesovanja, to jest na kadar kutije šibica koja leži na stolu. Taj 
kadar zadržavamo sve dok glumac ne uđe u njega i uzme kutiju.  

Od trenutka kada glumac podigne pogled, gledalac će želeti da vidi šta je to što mu van kadra 
privlači pažnju. Znači, dobili smo opravdanje za rez, jer se tim rezom utvrđuje razlog glumčevog 
kretanja. U prvoj montažnoj varijanti koju smo prikazali, rez nije imao svoju poentu, jer se njime 
nije prikazivala nikakva zamisao - on je bio tu da prosto fizički poveže dve scene.  

Takav rez za gledaoca nema previše značenja. U drugom, pak, slučaju, rezom se nešto postiže: 
prvi kadar uslovio je drugi, a kontinuitet je zbog toga postao efektniji. 

Ipak, prilikom poređenja ova dva načina montiranja iste scene, bilo bi pogrešno izvesti zaključak 
da svaki rez treba da ima motivaciju kakva postoji u drugom primeru. Nekada je potrebno i snimiti 
scenu iz dva dela pa da se onda ti delovi spoje kako bi dali pokret koji je u toku (naprimer, kada 
osoba prelazi izjedne prostorije u drugu).  
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Međutim, ono što jeste sigurno je da je uvek bolje opredeliti se za rezove koji su dramaturški 
opravdani, čime se postiže da gladaoci sve vreme aktivno prate film. 

Postoji još jedan razlog zašto je bolje da se scena montira na drugi način. Recimo, da je glumcu 
potrebno, naprimer, deset koraka da bi došao do stola sa šibicama. U prvom slučaju, gde je 
potrebno da se prikaže njegovo kretanje u celini, moraćemo da prikažemo svih deset koraka da 
pokret ne bi bio prekraćen. U drugom slučaju, kretanje čoveka se uopšte ne vidi. 

Od trenutka kad postane jasno da će čovek da ustane, rezom prelazimo na šibice, a zatim, pošto 
nam je kadar sa šibicama neko vreme (ali ne predugo) bio na ekranu, dozvoljavamo glumcu da 
uđe u kadar.  

Gledalac, čija je pažnja uvek usmerena ka razvoju važnih događaja, neće ni primetiti da je tu, 
fizički, možda nešto neusaglašeno. Montažer je, dakle, scenu montirao tako što je događaje od 
značaja za razvoj radnje pustio u celini, a skratio fizička kretanja na najmanju moguću meru, tj 
izostavio je interval u kome glumac prolazi kroz sobu. 

U slučajevima kada neka ličnost treba da se premesti sa jednog mesta na drugo između dve 
izastopne scene, ovaj postupak kojim se skraćuju nepotrebni vremenski intervali, može da se 
razradi još više. Na primer, osoba A se nalazi pred svojom zgradom u razgovoru sa osobom B. 
Oprašta se od sagovornika i, prema scenariju, u sledećoj sceni treba da ga vidimo u razgovoru 
sa suprugom, u stanu, na trećem spratu te zgrade.  

Kada bi se na filmu sve odvojalo tačno kao u životu, mi bismo tu osobu videli kako ulazi u zgradu, 
poziva lift, čeka ga, ulazi u njega, stiže do trećeg sprata, izlazi, prilazi svom stanu i ulazi u njega. 
I tek posle svega ovoga mogla bi da počne naredna scena.  

Ovako detaljno opisivanje njegovog kretanja do stana predstavlja prosto gubljenje vremena, osim 
kada za to ne postoji opravdan dramaturški cilj (naprimer, gledalac zna da se za to vreme gore u 
stanu dešava nešto što osoba A ne bi smela da zatekne, i detaljno prikazivanje njegovog kretanja 
ka stanu ima za svrhu da podigne tenziju kod gledaoca). Ukoliko takvog cilja nema, protok 
vremena između scene na ulici i scene u stanu mora na naki način da se premosti. 

Za to postoji više načina. Na primer: A i B se opraštaju, kamera se zadržava na B, A izlazi iz kadra 
u pravcu svoje zgrade. Pošto se kamera zadržala na B neko vreme, rezom bismo mogli da 
prežemo na A u trenutku kad ulazi u stan.  

Vreme koje je proteklo dok je ličnost B bila zadržana na ekranu biće dovoljno da nagovesti da je 
A imao vremena da se popne do stana. 

Druga varijanta bi bila da A, prilikom opraštanja, nagovesti da ga supruga čeka kod kuće. Rez na 
unutrašnjost stana u kom se nalazi supruga bi ovim bio potpuno opravdan. Ubrzo zatim mogli 
bismo da pređemo na vrata, viđena iz stana, na kojima će A sada da se pojavi.  

Činjenica da A ulazi u stan samo nekoliko sekundi pošto smo ga videli na ulici nimalo neće zbuniti 
gledaoca-vreme koje je proteklo dok smo gledali suprugu koja čeka pokriće vremenski razmak 
potreban da A stigne do stana. Iako je fitički konituitet i ovde potpuno pogrešan (kao i u 
prethodnom primeru, uostalom), to ne predstavlja smetnju jer je redosled događaja dat u 
dramaturški smislenom nizu. 
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U oba slučaja ideja jedne scene se prenosi na drugu, a dramaturški kontinuitet dovoljno je jak da 
prekrije fizičke nepreciznosti. 

Skraćivanje ili produžavanje scenskog trajanja određenog događaja  predstavlja najvažnije oruđe 
koje montažer ima na raspolaganju za određivanje ritma. U slučajevima koji su napred navedeni, 
skraćivanje se postiže navođenjem gledaoca da prihvati da se deo radnje za to vreme odvija van 
kadra. Ovaj princip sažimanja stvarnog vremena može da se iskoristi i drugačije.  

Ponekad je moguće da se dva kadra tako povežu da izgleda da radnja neprekidno teče, a da se 
deo kretanja ipak izostavi. 

Na primer: glumac trči prema ulaznom stepeništu, udaljavajući se od kamere. Kamera je iza 
glumčevih leđa i treba, kad se on približi podnožju stepeništa, da pređe na krupniji plan kojim se 
hvata stepenište i glumac koji počinje da se penje. (Slika 11, kadrovi a i b). Strogo gledajući, ova 

dva kadra treba da se povežu mestom u radnji, na kome je presečen prvi kadar i odakle se pokret 
nastavlja u narednom. 

 

U praksi to nije uvek neophodno. Već u toku trajanja prvog kadra nastupiće trenutak u kom 
gledalac shvata da će čovek, koji trči ka stepeništu, na njega i da zakorači kad dotle dođe. Znači, 
bilo bi prihvatljivo da se rezom pređe na kadar b nekoliko koraka pre nego što čovek stigne do 
stepeništa u kadru a. Neka to bude mesto na crtežu označeno sa „x“.  

Činjenica da je rez mehanički pogrešan ovde se može zanemariti, kao uostalom uvek kada se 
pretpostavlja da gledalac neće zapaziti grešku, a ovde su mogućnosti da je zapazi veoma male. 
Ideja da će čovek da krene stepeništem stvorena je već u prvom kadru, tako da njeno ostvarenje 



 

Interreg – IPA CBC Bulgaria – Serbia Programme  

CB007.2.13.212 

 
 

19 
 

u drugom dolazi sasvim prirodno. Mehanička nepreciznost u odnosu na sugestivnu snagu, ovde 
je zanemarljiva. 

Da zaključimo: kontinuitet je gladak onda kada je tok misli jasan i upečatljiv. Iz ovoga se nameće 
zaključak da je mehanički glatka montaža od drugostepenog značaja kada govorimo o dobro 
montiranom filmu. Ono što je najvažnije je jasno izlaganje zamisli iz kadra u kadar i smisaono 
suprotstavljanje likovnih predstava. Glatka montaža nije sama sebi cilj – ona je sredstvo da se 
dođe do dramaturški važnog kontinuiteta. 

Trajanje 
Moć da se neki događaj prilikom montiranja produži ili skrati važno je oruđe u rukama montažera 
i reditelja. Njime oni određuju trajanje radnje. Osim već predstavljene prednosti u skraćivanju 
nepotrebnih vremenskih prelaza, upravljanje trajanjem ima i dodatnu vrednost u tome da daje 
mogućnost da se niz uzastopnih događaja predstavi tako da se svaki naredni prikaže u 
dramaturški najprikladnijem trenutku. Ovo se odnosi kako na raspoređivanje događaja u okvirima 
priče, tako i na određivanje trajanja među pojedinačnim kadrovima. 

Koliko je važno pravilno rasporediti trajanje određenih kadrova, najbolje se može videti na primeru 
filma koji gotova da uopšte nije montiran. Radi se o filmu kultnog režisera Alfreda Hičkoka, 
„Konopac“ iz 1948. godine.  

Film predstavlja eksperiment kojim je veliki reditelj hteo da ostvari kontinuitet gotovo bez ikakvih 
rezova; radnja se u okviru jedne rolne filma odvija pred kamerom koja sve vreme radi, tako da 
pojedine scene traju i po više od 10 minuta neprekidno, a oni rezovi koji su bili neophodni (jer se 
u to vreme snimalo na rolnama filma, koje su imale svoju određenu dužinu trajanja), namerno su 
ostavljeni da budu grubi i očigledni. Rezultat je da su neke scene (inače veoma napetog filma) 
dosta izgubile na svojoj efektnosti, jer ima dosta nepotrebnog odugovlačenja koje ne samo da ne 
doprinosi napetosti, već je dodatno razvodnjava.  

Suprotan primer bio bi film „Čovek-ptica“ (Birdman) iz 2014. godine, koji se takođe poigrava 
idejom jednog neprekidnog kadra, ali čija je montaža toliko dobro izvedena, da su rezovi praktično 
nevidljivi gledaocu. Naravno, nije sasvim pošteno porediti film iz prve polovine dvadesetog veka 
sa filmom iz dvadest i prvog, zbog velike razlike u napretku sveukupne tehnike i tehnologije, pa i 
one filmske; međutim, činjenica je da dobro montirani kadrovi, i u tehničkom i u dramaturškom 
smislu, utiču na sveukupni utisak koji gledalac ima o filmu. 

Usklađivanje tonaliteta svetlosti 

Sve vreme dok se film snima, snimatelj nastoji da održi ujednačen kvalitet fotografije. Kad dođe 
vreme za montiranje materijala, montažer će nastojati da ne vezuje kadrove u kojima se 
osvetljenje upadljivo razlikuje, jer su razlike u kvalitetu svetlosti i senki u dva susedna kadra uvek 
upadljive, a kao posledica nastaje grub rez. 

Osvetljenje je, naravno, moguće korigovati i u post-produkciji, ali je bolje da odmah u montaži 
bude usklađeno. 
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Tempo: Ritam 
Primenom različitih mehaničkih montažnih postupaka može da se upravlja brzinom odvijanja 
događaja, a time i uzbuđenjem koje ta scena može da izazove. Da bi mogao da upravlja tempom, 
montažeru na raspolaganju stoji nekoliko alata. 

Variranje tempa ima smisla samo onda kada podstiče interesovanje gledaoca za ono što vidi. 
Zato je neophodno da se napravi razlika između mehanički postignutog tempa, to jest, brzine koja 
se dobija bržim ređanjem slika, i onog tempa koji proizilazi iz unutarnjeg razvoja događaja. 
Sekvenca može istovremeno da bude brza i dosadna (kao naprimer scene jurnjave u lošim 
akcionim filmovima), ali i spora i napeta (od Hičkoka pa preko modernih trilera). 

Površan utisak brze i uzbudljive radnje može da se postigne na veoma jednostavan način- 
montiranjem sekvence u većoj brzini. Ređanje slika u ubrzanom nizu daje utisak pojačanog 
uzbuđenja. Ali, veoma je važno da se pri ovom ubrzavanju kadrova ne gubi iz vida njihova 
sadržina. Nije dovoljno da se dužina kadrova jednostavno mehanički skrati. Svaka slika nosi 
sopstvenu poruku, pa prema tome treba i da se posmatra izdvojeno. 

 Neka slika prenosi svoju poruku u trenutku, dok je drugoj potrebno više vremena, pa se prilikom 
montaže to mora uzeti u obzir. Čak iako montažnu brzinu određene sekvence uvažavamo da 
bismo pojačali interesovanje gledalaca, kadrovi ipak treba da traju dovoljno dugo da bi se shvatilo 
šta se svakim od njih hoće. 

Na primer, ako reditelj želi da pokaže neku napisanu poruku, dužina trajanja te slike zavisiće od 
dužine pisanog teksta. Postoji priblližno utvrđeno vreme za koje prosečan gledalac može da 
pročita tekst određene dužine.  

U slučaju da kadar traje kraće, gledaoci će biti lišeni dela poruke, a u slučaju da traje predugo, 
dosađivaće se u iščekivanju sledećeg kadra. Isto tako, scenu u kojoj glumac trči potrebno je 
prikazati u celosti, ako želimo da gledalac shvati radnju u potpunosti. Ali u isto vreme, da bi 
gledalac naprimer shvatio da je glumac u sceni naoružan, čak i jedan sasvim kratak krupan kadar 
koji prikazuje pištolj biće dovoljan da tu poruku prenese. 

Iz ovoga se može zaključiti da, u slučaju kada je potrebno više vremena da se iz nekog opštijeg 
kadra uoče bitne pojedinosti, najbolje je rezom preći na krupni plan onoga što želimo da 
naglasimo. Krupni plan je takođe u principu prihvatljivije da traje kraće nego opšti plan. 

Još jedna važna stvar koja se mora imati u vidi prillikom određivanja dužine trajanja kadra, jeste 
kontekst. Kadar kojim se iznosi neka neočekivana činjenica, mora da traje duže nego kadar kojim 
se u nekom obliku ponavlja ono što je već poznato. Svaki kadar, pri tome, mora da traje jedan 
određeni minimum vremena da bi bio razumljiv. Na taj minimum utiču u svakom pojedinačnom 
slučaju, veličina plana, sadržaj i kretanje u okviru slike i kontekst. Ovo ne znači da je dužinu 
trajanja kadra moguće matematički izračunati, niti da za tim ima potrebe. Jedino je važno da 
montažer, prilikom montiranja sekvence kojoj želi da da izuzetno bez tempo, uvek ima na umu 
osobinu svakog pojedinačnog kadra. 
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Svođenje kadrova na minimalnu dužinu nije jedini način na koji može da se stvori utisak brzine. 
Kada je potrebno da se postigne utisak brze radnje, mnogo je bolje da se brzina naizmenično 
smanjuje i povećava, nego da se radnja sve vreme vodi najbržim mogućim tempom, jer i velika 
brzina, ukoliko je ujednačena, stvara utisak jednoličnosti. Utisak brzine neke radnje zavisi od 
radnje koja joj prethodi, a stalna promena tempa stvara utisak mnogo veće aktivnosti nego velika, 
ali konstantna brzina. 

Pored određivanja montažnog tempa u okviru sekvence, montažer je takođe obavezan da vodi 
računa o vremenskim prelazima između pojedinačnih scena. U praksi to znači da od prelaza koji 
mu stoje na raspolaganju (a najčešći su rez, pretapanje ili zatamnjenje/odtamnjenje) – on treba 
da izabere odgovarajući. 

Pretapanje je jedan od najčešćih načina za povezivanje uzastopnih sekvenci. Veštački efekat 
koji se time dobija veoma upadljivo prekida kontinuitet radnje. Osim toga, pošto se već jako dugo 
koristi za prelaze među sekvencama, publika ga povezuje sa protokom vremena. Prema tome, 
ako reditelj želi da označi da se radnja u drugoj sceni događa posle radnje u prvoj, svakako će se 
odlučiti za pretapanje. Retrospekcija, ili vraćanje toka događaja u raniji vremenski period, takođe 
se može izvesti pretapanjem. Ovde je važno da se izmena vremena ne označi samo pretapanjem, 
već i još nekom promenom unutar same scene – naprimer promenom spoljašnjosti likova, mesta 
ili godišnjeg doba, tako da gledalac neće imati teškoća sa praćenjem priče. 

Ipak, korišćenje pretapanja da bi se samo označio protok vremena nije uvek najbolje rešenje. 
Uzmimo primer o kome je već bilo reči: dve osobe razgovaraju ispred kuće, a u sledećoj sceni 
treba da se vidi stan na trećem spratu te iste zgrade, u koji se jedan od sagovornika penje. Videli 
smo da te dve scene mogu da se povežu na različite načine. Prelaz je mogao teoretski da se 
izvede i pretapanjem, što bi u mehaničkom pogledu bilo podjednako glatko. Ali u dramaturškom 
pogledu, postoje razlike između ta dva načina. Povezivanje dve susedne scene pretapanjem 
dovodi do prekida radnje i stvara utisak da da se jedna radnja završila, a druga započela.  

Ako scene povežemo rezom, kako smo ranije govorili, ovaj prekid radnje ne dolazi do izražaja: 
sekvenca je sačuvala kontinuitet, a dramski tok se ne narušava.  

Naravno, postoje i situacije u kojima je varijanta sa preklapanjem bolja, ali nemoguće je odrediti 
koji je postupak bolje primeniti bez uzimanja u obzir čitav dramaturški efekat priče. 

 Dramska pauza koja se dobija pretapanjem nije neophodna kada se jedna scena nastavlja na 
drugu. Koriščenje zatamnjenja/odtamnjenja zahteva nešto pažljiviju procenu. Zatamnjenjem se 
obeležava izrazitija pauza u kontinuitetu. Ono na naki način označava granicu između radnje koja 
teče pre i posle njega. Takvo zatamnjenje može da bude veoma efektno, jer stvara pauzu koja je 
potrebna da gledalac shvati i primi dramsku poentu pre ngo što se izvrši prelaz na sledeću scenu. 
Postoje i oni filmski stvaraoci koji su protiv korišćenja zatamnjenja, jer smatraju da nema svrhe 
pokazivati gledaocima prazan ekran. Svoju praktičnu primenu zatamnjenje ima u televizijskom 
formatu, jer je dobar prelaz na pauzu za reklame, dok se na velikom platnu koristi u skladu sa 
dramaturškim potrebama scenarija. 

Pitanje montiranja kadrova u odgovarajućem ritmičkom odnosu, pitanje je malih, jedva primetnih 
razlika u dužini, koje je teško uopšteno odrediti, jer skraćivanje ili produžavanje određenog kadra 
stoji u tesnoj vezi sa njegovim sadržajem. Da li je ritam dobar može se reći tek kad se film pogleda. 
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Ako je loš ili iseckan – osetiće se odmah, ako je dobar, izgledaće da nije uložen nikakav poseban 
napor da se on postigne. 

Bilo je već reči o rezovima u pokretu i u trenutku mirovanja radnje, kada smo zaključili da je najbolji 
rez onaj koji se poklapa sa trenutkom mirovanja. Razlog za to je to što bi montažer trebalo uvek 
da se trudi da sačuva ritam glumačkog izraza. Ako rezovima prekida glumčeve pokrete, unosi 
vizuelne prekide koji se ne poklapaju sa ritmom glume. Uzmimo primer koji smo već razmatrali: 
scenu u kojoj glumac uzima čašu sa stola i pije. Njegov pokret sastoji se od dva dela: pokreta 
unapred i pokreta unazad. Na početku oba ova pokreta postoji trenutak mirovanja. Ako se rez 
poklapa sa tim trenutkom, on pojačava ritam glumčevog izražavanja. Ali ako je rez u sredini 
pokreta, onda on naglašava samu radnju. Kada rez prekida radnju usred kadra, takva sekvenca 
deluje neprofesionalno i neuredno. 

Ovo naravno nije univerzalno pravilo, jer problem ritmičnog montiranja zavisi i od ličnog 
opredeljenja montažera i reditelja. 

Opasnost da radnja dobije pogrešan ritam može da nastane iz još jednog razloga. Videli smo da 
u scenama sa dijalogom brzina prikazivanja može da se poveća i skraćivanjem delova između 
replika. Ipak, ovaj postupak treba sprovoditi veoma pažljivo, jer dobar glumac koji ima osećaj za 
ritam ostavlja pauze iz veoma opravdanih razloga: njihovo skraćivanje značilo bi mešanje u 
glumačku interpretaciju, a neretko i umanjivanje njene vrednosti. 

To što važi za scene sa djalogom važi i za druge scene. Reditelj već u toku snimanja određuje 
tempo i njegove varijacije rukovodeći se određenim razlozima. Montažer kasnije doteruje i 
usmerava kontinuitet tako da se značajna mesta istaknu, ali ritam glume, to jest ritam radnje u 
kadru, ostaje najznačajniji činilac.  

Ovo naravno ne znači da će se pitanje ritma samo od sebe rešiti ako niko ne interveniše da ne bi 
narušio ritam glumačke igre. Sekvence u kojime se radnja iznosi prvenstveno slikama mogu se 
rediteljski prikazati iz više uglova sa namerom da im se, prilikom montaže, da poseban ritam. 

Primer dobro određenog ritma je filmski klasik „Boni i Klajd“ iz 1967. godine, u kome se tempo 
postepeno ubrzava dok ne dođe do scene u kojoj glavni junaci bivaju upucani mnoštvom hitaca i 
umiru. Onda se usporava, prikazujući mrtve junake usred pucnjave i haosa, dajući time 
gledaocima vremena da u potpunosti shvate šta se dogodilo i emotivno odreaguju na to. 

 

Greške u montaži 
Najčešće greške u montaži su one u pogledu narušavanja kontinuiteta vremena i prostora i 
poremećenog ritma. 

Vremenske greške nastaju: 

- Usled nepravilnog redosleda kadrova u odnosu na hronološki redosled radnje. 
- Usled nekoriščenja postupaka kao što su zatamnjenje/odtamnjenje, pretapanje, filaž i 

slično. 
- Usled svetlosne nepodudarnosti susednih kadrova. Posle svetlog kadra, taman kadar 

izaziva vizuelni šok. 
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Prostorne greške nastaju: 

- Usled nekorišćenja orijentacionih, tj opštih planova koju omogućavaju gledaocu 
orijentaciju, ne samo u prostoru, već i u radnji. Opšti plan je naročito važno upotrebiti u 
trenutku nagle promene dramske situacije ili prelaska u novi prostor. 

- Usled prevelike upotrebe krupnih planova. Krupni plan snažno stilizuje radnju, prostor i 
vreme, i ako se na početku scene nagomilaju krupni kadrovi, doći će do gubitka orijentacije 
i opadanja pažnje. 

- Usled nepravilnih pravaca pogleda aktera u kadrovima. Ako se akteri gledaju međusobno, 
uvek je potrebno da u pojedinačnim kadrovima gledaju u suprotnim pravcima. Ako akter 
gleda nalevo, naprimer, potrebno je da bude komponovan na desnoj strani kadra, tako da 
njegov pogled i pažnja budu usmereni ka levoj strani prostora. 

- Usled nepravilnih pravaca kretanja kamere i objekata u kadru. 
- Usled nedovoljne i neprecizne povezanosti pokreta u susednim kadrovima. 

Greške u ritmu nastaju: 

- Usled nesklada između ritma montaže, tj dužine kadrova i tempa sadržaja, tj brzine 
kretanja unitar kadrova. Spora radnja i spor pokret zahtevaju duge kadrove i spor 
montažni ritam i obratno. 

- Usled nesklada brzine pokreta kamere u susednim kadrovima. 
Ovo su neke od najčešćih grešaka koje se javljaju u montaži. Njihovim izbegavanjem, postižu se 
tečnost i jasnoća pripovedanja.  

Međutim, sva ova pravila, ma kako delovala strogo, uvek imaju svoje izuzetke. Dobar primer filma 
koji ih nije dosledno poštovao a ipak se smatra veoma uspešno montiranim jeste „Titanik“ 
Džejmsa Kamerona iz 1997. godine, koji je čak i dobitnik Oskara za montažu, između ostalih 
nagrada koje je pokupio. U ovom filmu, u gotovo svim akcionim sekvencama dosledno je 
sproveden sistem kadriranja i montaže u rezu između statičnog kraja kadra i početka sledećeg 
kadra u kojem je već započeto kretanje, ili je kadar u pokretu rezom spojen sa sledećim, statičnim, 
kadrom. Takođe su direktno spojeni kadrovi sa različitim pravcima kretanja kamere. Ipak, 
kontinuitet istog „plivajućeg“ kretanja istog sadržaja unutar kadrova je dosledno sproveden, kao i 
kontinuitet iste brzine kretanja unutar kadrova i brzine kretanja kamere. Zahvaljujući svemu 
ovome, sproveden je zanimljiv dinamički efekat serije blagih vizuelnih akcenata koji neprekidno 
drže pažnju gledalaca na veoma visokom nivou. U daljem tumačenju ovog osećanja, gledaocu 
se čini kao da se prostori broda u toku brojnih akcionih scena sve vreme „lome“ u skokovima 
vizuelnog diskontinuiteta, što je ujedno i psihološka priprema za konačan „prelom“ u kom brod 
tone u svom tragičnom kraju.  

 

Korekcija boja 
Boja je čulni doživljaj koji nastaje kada svetlost određenog spektra probudi receptore, čepiće u 
mrežnjači oka. Vrste boja i njihove fizičke osobine povezuju se sa objektima kroz talasnu dužinu 
svetlosti koja se o njih reflektuje, zahvaljujući apsorpciji, refleksiji ili emisiji svetlosnog spektra. 
Zdravo oko najbolje raspoznaje crvenu, pa zatim narandžastu, žutu, zelenu, plavu te ljubičastu 
boju. S obe strane spektra nalaze se boje koje čovečje oko ne može da vidi- infracrveno i 
ultraljubičasto zračenje, a nijanse koje oko može da prepozna mere se milionima. 
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Ljudsko oko vidi boju zahvaljujući tri tipa čepića koji se popularno nazivaju: crveni, zeleni i plavi 
(RGB=Red, Green, Blue). Međutim, istraživanjima se utvrdilo da se informacija o boji u mozgu 
stvara kroz tri kanala: zeleno-crveni, plavo-žuti i crno-beli. 

U likovnoj umetnosti, bolje se dele na osnovne (primarne) i složene. Osnovne su one koje se ne 
mogu dobiti mešanjem drugih boja, to jest, crvena, žuta i plava, a složene (sekundarne) se 
dobijaju mešanjem osnovnih boja, dok se tercijarne dobijaju mešanjem primarnih i sekundarnih 
boja. Za dve boje se kaže da su komplementarne kada u jednoj nema nimalo od one druge, tj 
kada se nalaze na suprotnim stranama spektra boja, npr zelena i crvena ili narandžasta i plava. 

Druga podela boja je na tople i hladne, što dolazi iz prirodnih toplotnih stanja (crvena=vatra, 
plava=more). Ljudskom oku se dva predmeta iste veličine na jednakoj udaljenosti, ako su toplih 
boja, čine bližima, a hladnih daljima. 

Kod aditivnog mešanja boja koje se koristi u računarstvu i na televiziji najveći raspon prikaza 
dobija se kada su primarne boje RGB (crvena, zelena, plava). U štamparstvu su primarne boje 
cijan, magenta, žuta i crna. 

U promeni boja video snimaka koriste se dve dominantne tehnike: korekcija boja (color correction) 
i nijansiranje (color grading). Iako su slične, ove dve tehnike imaju različite namene. 

Korekcija boja je jedinstveni proces koji podrazumeva promene na slici koje imaju za cilj 
korigovanje bilo kakvih anomalija u odnosu na standardni izgled. Ona uključuje promene: 
ekspozicije, balansa bele, kontrasta, šuma (posledica veštačkog pojačavanja intenziteta signala 
koji dolazi na senzor kamere). 

Korekcija boja se koristi za ispravljanje grešaka koje su nastale tokom procesa snimanja, ali i za 
izvlačenje informacija koje su upisane u nisko saturisanim, bledim snimcima. Korekcija ima za cilj 
povezivanje različitih video snimaka koji su nastali pri različitim svetlosnim uslovima, kao i na 
različitim lokacijama, i to najpre u pogledu ujednačavanja temperature boje različitih kadrova koji 
treba da zadovolje određene tehničke standarde, ali i subjektivno prirodni izgled boja (ljudskom 
oku, na primer, beli predmet izgleda isto i pri toplom i pri hladnom svetlu, kameri ne). 

Jedna od prvih tehnika u korekciji boja je ujednačavanje bele, koja treba da bude bela, a ne 
žućkasta ili plavičasta, i crne, koja treba da bude crna, a ne tamno siva ili tamno braon. 

Korekcija boje se najčešće radi u dva prolaza. Primarna korekcija se radi na čitavom kadru, pri 
čemu se podešavaju intenziteti crvene, plave, zelene, game, senki i najsvetlijih tonova slike. 
Sekundarna korekcija podrazumeva menjanje zasićenosti, sjajnosti i nijansa varijanti žute, 
magente, cijan, plave, zelene i crvene boje pri čemu se vodi računa da se druge boje spektra 
menjaju u najmanjoj mogućoj meri. Uz pomoć maski, moguća je i dodatna korekcija delova slike, 
pri čemu se i primarna i sekundarna korekcija primenjuje samo na željenom odsečku kadra. 

Nijansiranje predstavlja naprednu tehniku koja se radi po završetku korekcije boja. Njegov cilj je 
promena boije iz estetskih, a ne tehničkih razloga. Nijansiranje se sprovodi promenom okvira 
maksimalnih nivoa i tolerancije unutar R, G, B kanala spektra, najčešće tokom celog filma (videa) 
ili scene, a ne samo na nivou kadra kao u slučaju korekcije boja. 
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Korekcija boja u Adobe Premiere Pro, vežba: 

1. Pokrenite Adobe Premiere Pro, izaberite New Project >korekcija boja.  

2. U prozoru New Sequence izaberite iz Available Presets > DVCPROHD > 720p > 
DVCPROHD 720p 50p.  

3.  U odeljku General, prozora New Sequence, promenite Timbase u 25,00 
frames/second, potvrdite. 

4. Iz panela Media Browser uvezite u panel Source (2xLK mišem) video klip: 00757F. 
 

5. U panelu Source, pomoću In i Out tačaka, obeležite deo klipa između: 00:17:21:21 i  

00:17:33:13. Insert. 

Kada radite s korekcijom boja, ponekad želite da imate dva istovremena prikaza različitih 
delova a/v klipa. 

 

6.  Window > Reference Monitor. 

U zasebnom prozoru pojaviće se Reference Monitor. Treba ga postaviti uz panel Program 
Monitor čime je moguće ostvariti lakše upoređivanje video sadržaja. 

 

7. U panelu Reference Monitor isključite dugme Gang to Program Monitor koje usklađuje 
poziciju CTI u oba monitora 

 
  8. U panelu Reference Monitor postavite CTI na početak, a u panelu program Monitor 
pred kraj video klipa 
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9. Iz panela Effects izaberite Video Effects > Color Correction > Fast Color Corrector i 
postavite ga na video klip.  

 

10. U panelu Effect Controls otvorite podešavanja efekta Fast Color Corrector. 
 

11. Uključite opciju Show Split View. 

Zbog kompozicije slike a/v klipa u opciji Layout, treba izabrati Vertical prikaz slike sa i bez 
primene efekta. 

12. Kako biste odredili balans bele boje pomoću pipete, pored prikaza boje izaberite belu 
boju sa šortsa skijaša na vodi.  
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13. Izmestite iz centra palete boja krug blago ulevo, kako biste plavičasti snimak učinili 
“toplijim”. Obratite pažnju na boju lišća na slici.  

14. Ukoliko želite, podignite vrednosti zasićenja boja u polju Saturation upišite 125,0. 
 

 

Često na snimcima koji su snimani po jakom suncu nema dovoljno crne boje. 

15. Uveličajte prikaz u panelu Reference Monitor na 100% i pronađite najtamniji deo slike 
(u donjem nivou drveća ili daske skijaša). Pipetom pored opcije Black Level označite to 
mesto.  

16. Ukoliko je potrebno promenite vrednosti sive boje, pomoću slajdera, u opciji Input 
Levels.  

17. Reprodukujte sekvencu. 
 

Slika izgleda mnogo bolje, međutim, potrebno je proveriti njenu tehničku ispravnost. 
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18. U panelu Reference Monitor uključite dugme Gang To Program Monitor, iz menija 
Output izaberite YCbCr Parade (umesto Composite Video). 
 

19. Vrednosti za svaku boju ne treba da prelaze nivo od 90. Primenom efekta Broadcast 
Colors i izmenama opcija Broadcast Locale u PAL, snimak će postati tehnički ispravan.  

20. Ukoliko umesto YCbCR Parede u Output opciji izaberete Vectorscope, možete proveriti 
vrednosti za crvenu, zelenu, plavu, žutu, cijan i magentu. Sve boje gledajući od centra 
ka obodu kruga ne treba da prelaze mesta obeležena pravougaonikom za svaku boju.  

 

 

 

21. Reprodukujte sekvencu. 

22. Sačuvajte i zatvorite projekat. 
 

23. Otvorite projekat: seckanje.prproj. Reprodukujte sekvencu. 
Možemo primetiti da je sekvenca izmontirana upotrebom više od jedne kamere i da npr. boje 
i balans belog nisu ujednačeni. Pokušaćemo da ujednačimo video klipove Video2_1 i 
Video2_2. 

24. Iz panela Effects izaberite Video Effects > Color Corection > Luma Curve, prevucite 
efekat na klip Video2_2. 

 

U panelu Source monitor otvorite Video2_1. Otvorite podešavanja efekta u panelu Effect 
Controls. 

25. Kako biste bolje uočili razliku sa i bez primene efekta Luma Curve, aktivirajte opciju 
Show Spit View, podesite da ekran bude podeljen po vertikali (Layout > Vertical). 
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26. Dodavanjem tačaka i njihovim minimalnim pomeranjem, pokušajte da promenite izgled 
bele boje, a nakon toga, u dodatnim opcijama, pokušajte da ujednačite tonove video 
klipa iz Source monitora i Program monitora. Probajte sve opcije efekta Luma Curve. 

 

Ukoliko niste zadovoljni postignutim rezultatima, probajte efekte iz foldera Image Control 
poput: Color Balance (RGB), Color Balance (HLS), Gamma Corection, Equalize ili iz foldera 
Adjust: Shadows/Highlights. 

27. Na video klip Video2_6 iz foldera Blur& Sharpen postavite efekat Gaussian Blur. 

 

Podešavanjem unutar panela Effect Control, izmenite vrednosti Blurriness, Blur 
Dimensionss (Horisontal & Vertical). Dodavanjem ključnih slika pred zatamnjenje pojačajte 
završetak sekvence. 

 

28. Sačuvajte i zatvorite projekat.  

29. Započnite novi projekat: korekcija boja.prproj. 
 

30. Otvorite novu sekvencu. 
 

31. U prozoru New Sequence, izaberite iz Available Presets > DVCPROHD > 720p > 
DVCPROHD 720p 50p.  

32. U odeljku General, prozora New Sequence, promenite Timbase u 25,00 
frames/second, potvrdite. 
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33. Iz panela Media Browser, iz Banke HD uvezite u novu sekvencu na traku Video 1, a/v 
klip: 0075710. 

Nekada je umesto snimanja noću, koje zahteva dodatno osvetljenje i znatno osetljivije 
kamere, jednostavnije snimati danju, a kasnije u procesu postprodukcije od snimka napraviti 
noćni video. Od ovog a/v klipa vodoskoka na Adi Ciganliji koji je snimljen danju, primenom 
video efekata napravićemo noćni snimak. 

34. Iz panela Effects izaberite Video Effects > Color Correction > Fast Color Corrector i 
postavite ga na video klip.  

35. U panelu Effect Controls otvorite podešavanja efekta Fast Color Corrector. 
 

36. Izmestite iz centra palete boja krug u plavu zonu, kako biste naglasili plavičasti ton 
mesečine.  

 

 

 

 

 

Ukoliko želite da od dnevnog snimka napravite snimak u suton, krug biste pomerili u ugao 
između narandžaste i roze boje. 

37. Smanjite Saturation na 50,0.  

38. Iz panela Effects izaberite Video Effects > Color Correction > RGB Curves i postavite 
ga na video klip.  

39. U panelu Effect Controls otvorite podešavanja efekta RGB Curves.  

40. Povucite desnu tačku Master opcije nadole.  

 

 

 

 

 

 

 

Na ovaj način, smanjićemo intenzitet najsvetlijih boja u a/v klipu. 

41. Povucite levu tačku Master opcije ulevo. 

Na ovaj način, naglasićemo najtamnije delove a/v klipa. Nakon toga potrebno je smanjiti 
intenzitet svih boja. 

42. Dodajte tačku po sredini dijagonale i povucite blago ka donjem levom ćošku opcije 
Master.  
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43. Sačuvajte projekat. 
 

Lumetri Scopes u Adobe Premiere Pro 
 
Videoskop (opseg video zapisa) obezbeđuje detaljniji uvid u video sliku. Montažeri se njima 
koriste da bi ispoštovali standarde prikazivanja i obavili što precizniju korekciju boja. Ako znate 
pravilno da čitate videoskop, moći ćete bolje da upravljate svojim slikama. 
 
Sada ćemo se pozabaviti najvažnijim videoskopima u Adobe  Premiere Pro, kao što su RGB 
parada, histogram, vejvform (waveform) i vektorskop. Na samom početku, važno je da nam 
Lumetri Scopes panel bude otvoren tako što ćemo izabrati Window > Lumetri Scopes. Možete 
izabrati i Premierovu difolt opciju Color workspace. 
 
 
 

Vektorskop 
 

 
 
 
Vektorskop nadgleda informacije o boji određene slike. Opseg je grafikon okruglog oblika, sličan 
kružnoj paleti boja. On meri zasićenje (saturaciju) od centra ka spolja, istovremeno mereći nijanse 
po kružnoj shemi kako se pokrećete po opsegu 360°.  Ako gledate crno-belu sliku, sve što ćete 
videti je tačka u centru opsega. Premiere nudi dve različite varijante vektorskopa: YUV i HLS 
(Hue, Lightness, Saturation =Nijansa, Svetlost, Zasićenje). YUV režim vam daje nekoliko paleta 
boja, omogućavajući vam da odmah vidite da li su vam nivoi nijanse i zasićenja ispravni. Inženjeri 
koriste ove oznake da bi bili sigurno da signal nalazi unutar okvira zakonski propisanih standarda 
emitovanja. 
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Histogram 
 

 
 
 
 
 
Ako ste ikad koristili program Adobe Photoshop, verovatno ste i koristili alatku Levels da napravite 
izmene u tonalitetu neke slike- A ako ste koristili levels, upoznati se i sa pojmom histograma. 
Histogram vam omogućava da vidite vrednosti tonaliteta, uključujući najsvetlije (highlights) i 
najtamnije vrednosti vaše slike. Brzo pregledajte vrednosti osvetljenja svoje slike u  256 različitih 
tonalnih nivoa, gde je čisto crna na 0 a čisto bela na 255 (za 8-bitne slike). 
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Vejvform (waveform) 
 
 

 
 
Nivoi intenziteta vaše slike mere se uz pomoć vejvform opsega. Vejvform može da prati i nivoe 
osvetljenja i hromiranosti neke slike, zavisno od opcije za pregledanje koju izaberete.  
 
Vejvformovi mere intenzitet u IRE jedinicama, od  0 – 100, gde je 0 crno a 100 belo.  
Nivoi crne su na dnu opsega vejvforma, a bele na vrhu.  
 
Promenite tip vejvforma da biste precizirali šta želite da vidite, uključujući  RGB, Luma, YC, i YC 
with no Chroma 
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RGB Parada 
 
 
Opseg RGB parade je sličan vejvform monitoru, pružajući vam priliku da pogledate nivoe 
intenziteta video signala od dna do vrha. Međutim, opseg RGB parade daje vam izdvojene 
poglede na svaki od kanala boja – crvenu, zelenu i plavu. Ovo se razlikuje od RGN vejvform 
opsega, koji pokazuje ova tri kanala boje kao kompozit. Opseg RGB parade je veoma koristan 
kada pokušavate da uskladite boje između nekoliko kadrova. Koristite efekat RGB krive u 
konjukciji sa opsegom RGB parade da brzo i lako uskladite boje nekoliko kadrova u nizu. 
 

Ključ 
 

Displej možete prilagoditi korišćenjem ikonice ključa    u dnu Lumetri Scopes panela. Premiere 
Pro nudi više različitih  unapred podešenih rasporeda, koji vam omogućavaju da se brzo 
prebacujete između različitoh opsega – čak i da gledate više opsega istovremeno. I konkretan 
vejvform i tip parade koji želite da vam se prikazuje možete dodatno prilagoditi, kao i osvetljenje 
opsega. Primetićete i nekoliko različith Color Spaces na Lumetri panelu. To su: Standard 
Definition, High Definition, i 4K. 
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DLog-M  
Napravi novi projekat i importuj video 

 

Open the video in Premiere Pro to create a new timeline.

 

Otvorite video u u Premiere Pro da napravite novu vremensku liniju  

Kada se HEVC video uvozu u Premiere pro po prvi put, potreban je HEVC dekoder. 

 

Početak    

Uđte na opciju „Effects“ 

 

1. Primenite  DLog-M na Rec. 709 LUT. 
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1. Izaberite video sa vremenske linije 
2. Izaberite “Lumetri Color”. 
3. Izaberite “Look” a potom “Browse”. Izaberite “DLog-M to Rec 709 LUT.cube” fajl. 

 

2. Uporedite Color Effect 
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Klik  na “fx”, da biste uljučivali / isključivali LUT-ove i poredili rezultate.  

3.  Modulacije boje na osnovu primene LUT-ova 

 

     
Parametri boje se mogu menjati i ovde. 

Kliknite na “Lumetri Color” da podesite parametre boje kao što su White Balance, Brightness, 
Contrast, Saturation, Curve, i Color Wheel. 
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Izoštravanje

 
Uveličajte za više detalja. Podesite opciju Sharpen u “Lumetri Color”. 

DLog-M neće izoštriti niti smanjiti šum da bi zadržao što je više moguće informacija za bolji post 
processing. 

 

Korekcija distorzije videa 

Izaberite “Effects”->“Video Effects”- >“Distort”->“Lens Distortion”. 
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Prevucite “Lens Distortion” na video na vremenskoj liniji. 

1. Podešavanje vrednosti za korekciju distorzije videa  
 

Izaberite “Effect Controls”- >”Lens Distortion”  

Podesite vrednosti zakrivljenosti. Preporučene vrednosti su navedene.  

 

 

2. Preporučene vrednosti za korekciju distorzije videa 
 

Preporučene vrednosti za korekciju distorzije videa 

4K HQ  -4  

4K FOV  -9  

2.7K  -8  

FHD 24/25/30/48/50/60p  -9  

FHD 120p  -4  

Kraj 
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U glavnom meniju Premiere Pro, odaberite “Document”->“Export”->“Media File” da biste 
kompletirali proces i videli konačan rezultat.  

 

Montiranje sa više kamera  
 

1. Napravite projekat 
 

Kliknite na New Project sa ekrana Premiere Pro Welcome, ili izaberite File > New Project. 
Dajte ime svom projektu i kliknite OK da prihvatite podrazumevana podešavanja. 
 

2. Uvezite snimak 
 
Izaberite File > Import. Izaberite direktorijum u kom se nalaze vaši audio i video fajlovi. 
Izaberite fajlove koje hoćete da importujete i kliknite na Open. 
Napomena: 
Da biste izabrali više fajlova odjednom, kliknite na prvi a onda držeći taster Shift kliknite na 
poslednji, na taj način obeležavajući sve fajlove između.  
 
 

3. Napravite izvornu sekvencu sa više kamera 
 
Izvornu sekvencu sa više kamera (multi-camera; multi-cam) možete napraviti na sledeće 
načine:  
 
 Izaberite bin koji sadrži elemente (assets) i izaberite metodu sinhronizacije iz Create Multi-

camera Source Sequence. Svi snimci unutar bina se obrađuju na osnovu metoda 
sinhronizacije (sync) i ređaju se alfa-numerički u svakoj izvornoj sekvenci koja se stvara.  

 Izaberite asete ručno i izaberite metodu sinhronizacije iz Create Multi-camera Source 
Sequence. Redosled u kom birate klipove određuje redosled u nastaloj izvornoj sekvenci.  
 

Da biste koristili Create Multi-camera Source Sequence, izaberite svoje klipove ili bin iz 
Project panela. Onda, kliknite desnim klikom (Windows) ili Ctrl-klik (Mac OS) na odabrane 
klipove i odaberite Create Multi-camera Source Sequence iz context menija. 
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4. Napravite ciljanu sekvencu sa više kamera 
 
Uredite (editujte) izvornu sekvencu u ciljanu sekvencu. 
 
Da biste napravili ciljanu sekvencu, dok je izvorna sekvenca sa više kamera odabrana u Project 
panelu, izaberite File > New > Sequence From Clip. Možete i da kliknete desni klik (Windows) 
ili Ctrl-klik (Mac OS) na izvornu sekvencu sa više kamera i odaberete New Sequence From 
Clip iz context menija. 
Premiere Pro kreira ciljanu sekvencu sa više kamera, i otvara je u panelima Program Monitor i 
Timeline. 
 

5.  Multi-cam editovanje u panelu Program Monitor 
 
Da biste ciljanu sekvencu sa više kamera osposobili za editovanje, kliknite na ikonicu ključa  , 
i izaberite Multi-camera iz pop-up menija u okviru Program Monitor. Program Monitor je sada u 
Multi-camera modu.  
U Multi-camera modu, možete da gledate sve snimke sa svih kamera istovremeno i da prelazite 
sa jedne kamere na drugu da biste odabrali snimke za konačnu sekvencu.  
 

6. Omogućite snimanje multi-camera edita 
 
Uključite  Multi-camera Record dugme. Ako dugme nije vidljivo na button bar, kliknite "+" u 
donjem desnom uglu Program Monitor panela da otvorite Button editor. Prevucite Multi-camera 
Record dugme na button bar. 
 

7. Edit multi-cam sekvence 
 
U Program Monitor ili Timeline panelu, pritisnite spejsbar ili kliknite na Play-Stop dugme da 
započnete plejbek. Dok sekvenca treje, pritisnite taster sa brojem na glavnoj tastaturi da 
pređete na kameru sa tim brojem.    
 
 
 

8. Podešavanje edita 
 
Pošto ste sinimili svoj multi-camera edit, možte uraditi nešto od ovoga: 

 Ponovo snimite finalnu sekvencu i zamenite klipove  snimkom sa jedne od ostalih kamera.  
 Editujte multi-camera izvornu sekvencu kao što bite bilo koju drugu sekvencu – koristeći 

standardne tehnike i alate za edit, dodajući efekte i slično.   
 Zamenite kamere pošto je snimanje već završeno.  
 Napravite rez na novi ugao.  

 
Napomena: 
Za multi-camera editing možete koristiti prečice na tastaturi. Možete da koristite tastere sa 
brojevima da menjate kamere dok traje multi-camera sekvenca. Prečice na tastaturi se mogu 
koristiti i da promenite uglove pošto ste završili multi-camera edit.  
 

9. Eksportovanje multi-camera sekvence 
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Dok je sekvenca aktivna u Program Monitor ili Timeline panelu, izaberite File > Export > Media. 
Podesite podešavanja za eksportovanje i kliknite na Export, ili kliknite Queue da pošaljete 
sekvencu u Adobe Media Encoder. 
 

Obeležite klipove za sinhronizaciju  
 
Napomena: 
Klipove ne morate označavati za sinhronizaciju ako imaju vrmensku oznaku (timecode) sa 
mesta snimanja.   
Pre kreiranja multi-camera izvorne sekvence, važno je obeležiti klipove za sinhronizaciju. 
Otvorite svaki klip i onda učinite nešto od navedenog:  
 

 Obeležite ulaznu tačku (In Point) na tački sinhronizacije na početku klipa.   
 Obeležite izlaznu tačku (Out point)  na tački sinhronizacije na kraju klipa.   
 Napravite klip marker na tački sinhronizacije u bilo kom delu klipa. Na primer, ako u bilo 

kom trenutku u toku trajanja klipa postoji neka akcija, kao audio replika, nagli zvuk ili 
bljesak foto-aparata. Preimenujte svaki marker tako da za potrebe sinhronizacije dobiju 
isto ime i kliknite na OK.  
 

Timecode (vremenska oznaka) se isto može korisititi za sinhronizaciju klipova, i ona to radi 
automstski. Međutim, da bi se sinhronizacija pravilno izvršila, vremenska oznaka mora da bude 
identična na svim klipovima. Ako je to slučaj, nema potrebe posebno obeležavati klipove za 
sinhronizaciju. Ako ste koristili vrednost sati (hours) u izvornom vremenskom kodu, izaberite 
opciju Ignore Hours. Premiere Pro će onda za sinhronizaciju klipova koristiti samo minute, 
sekunde i frejmove.  
 
Da biste postavili identičnu vremensku oznaku na sve klipove, snimite kamere sa fiksiranom 
vremenskom oznakom na lokaciji, ili izmenite vremensku oznaku za svaki klip ponaosob u  
Premiere Pro.  
 

Korišćenje opcije Multi-camera Source Sequence  
 
Koristite opciju Create Multi-camera Source Sequence da kombinujete klipove koji imaju 
zajedničke In/Out points ili vremenske oznake koje se preklapaju u multi-camera sekvencu. 
Možete kombinovati klipove koristeći i audio vejvforme i markere.  
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Create Multi-Camera Source Sequence  
 

Ime Multi-camera izvorne sekvence  
 
Svoju multi-camera izvornu sekvencu možete nazvati po svom osnovnom videu ili audio klipu 
unutar sekvence. Iz pop-up menija, izaberite odgovarajuću opciju da nalepite "Multicam" ili 
odabrano ime na ime primarnog videa ili audia.  
Isto tako, možete i da izaberete Custom iz pop-up menija, i ubacite željeno ime u predviđeno 
polje.   
 

 
Tačka sinhronizacije 
 
Napomena: 
Klipove za sinhronizaciju obeležavate pre kreiranja multi-kamera izvornog koda koristeći In 
points, Out points, ili klip markere kao tačke sinhronizacije.   
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Tačke ulaza i izlaza - In Points, Out Points 
 
Označite tačke za sinhronizaciju koristeći In Points ili Out Points pre nego što napravite izvornu 
multi-camera sekvencu. 

 
Vremenska oznaka (Timecode) 
 
Izaberite opciju Timecode da sinhronizujete klipove ako su snimljeni sa međusobno 
usklađenom vremenskom oznakom. 

 Odaberite opciju Create Single Multicam Source Sequence da iskombinujete klipove u 
jednu multi-camera sekvencu. Koristite ovu opciju kada pokrivenost pojedinačnih 
snimaka ima praznine, a želite da napravite sekvencu koja čuva te praznine. Ako ne 
izaberete ovu opciju, samo preklapajući klipovi se kombinuju, a klipovi bez preklapanja 
ostaju neiskorišćeni. Grupi klipova možete dodeliti  Camera Angle ili Camera Label koji 
se može iskoristiti za vreme pravljenja multicam-a. Grupe klipova sa preklapajućim 
Camera Label ili Camera Angle metapodacima se smeštaju na sopstvene trake za 
vreme procesa kreiranja metapodataka. Isti koncept se primenjuje na eksterni audio ili 
terenski audio.    

 Izeberite Ignore Hours ako svaki pojedinačni klip ima vremensku oznaku koja počinje 
drugim satom, ali se na druge načine preklapaju u vremenskoj oznaci.  
 

Premiere Pro vam omogućava da obavljate brza multi-camera editovanja zasnovana na 
sinhronizaciji vremenske oznake. Pritisnite taster za modifikovanje Ctrl (Windows) ili Cmd (Mac 
OS) dok menjate izvorne klipove da bi se frejmovi uskladili sa vremenskom oznakom na 
trenutnoj poziciji. 
 

Clip Marker 
 
Izaberite opciju Clip Marker da sinhronizujete klipove koristeći klip markere koji se ručno dodaju 
na zajedničke tačke za sinhronizaciju.    
 
 

Audio 
 
Izaberite opciju  Audio da automatski sinhronizujete klipove na osnovu audio vejvformova. 
Možete da koristite audio snimljen iz drugog izvora da automatski sinhronizujete i napravite 
multicamera i spojene klipove koristeći audio vejvforme.  
 
 

Prethodno podešavanje sekvenci 
 
Izaberite Sequence Preset pop-up meni da  odaberete sa liste ranije sačuvanih prethodnih 
podešavanja sekvenci.  
Prethodno podešavanje Automatic se bira po difoltu. Kada izaberete podešavanje Automatic, 
podešavanje videa se radi na osnovu video formata klipa snimljenog Kamerom Jedan. U 
najvećem broju scenarija, podešavanje Automatic je odgovarajuće. Za naprednije korisnike, 
može se izabrati i neko specifičnije prethodno podešavanje. Onda se za konačan edit mogu 
koristiti klipovi veće rezolucije i veličine jednog frejma. 
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Izjednačavanje audio i video klipova 
 

 Ako zasebno snimljen audio zapis nije sinhronizovan sa video klipom, možete da dodate 
izjednačavanje frejma koristeći opciju  Offset Audio by. Možete ubacivati video 
frejmove u opsegu -100 do +100 za izjednačavanje sinhronizacije za klipove koji sadrže 
samo audio. 

 Koristite opciju Move Source Clips to Processed Clips bin da biste nastale izvorne 
klipove prebacili u bin Processed Clips. Ako Processed Clips bin ne postoji, Premiere 
Pro će ga napraviti pre nego što u njega prebaci klipove. Klipovi koji nisu ispunili 
kriterijume za sinhronizaciju neće ući u Processed Clips bin. Zahvaljujući ovoj opciji, lako 
se mogu identifikovati klipovi koji nisu bili iskorišćeni u novonastaloj multicam izvornoj 
sekvenci.  
 

Podešavanja audio sekvence  
 
Opcija „podešavanja sekvence“ (Sequence Settings) određuje kako se audio zapisi u izvornoj 
sekvenci raspoređuju, kako se postavlja dodeljivanje kanala, i da li su prigušeni.  

 Izaberite Camera 1 kada se u editovanju sekvence koristi samo audio sa Kamere 1. 
Multicam editovanje je omogućeno samo za deo izvorne sekvence koji sadrži video. Ako 
koristite a/v klipove da napravite ovu sekvencu, audio zapisi za sav audio povezan sa 
videom 1 su omogućeni, a sav ostali audio u izvornoj sekvenci je isključen. Ako koristite 
samo-audio zapise sa video ili a/v klipovima, samo-audio klipovi se nalaze u gornjim 
trakama i uključeni su. Ostali audio zapisi (iz drugih povezanih klipova) su isključeni i 
nalaze se u donjim trakama. Dodeljivanje kanala i raspon svake trake su podešeni da 
prebacuju svaki izvorni kanal u nezavisne output kanale (do 32). Broj omogućenih 
kanala izvornog audija određuje broj aktivnih output kanala sekvence.  
Napomena: Ne možete koristiti opciju audio prati video u editovanju sekvenci 
napravljenih u ovom podešavanju, zato što audio deo nije omogućen za multicam.  

 Izaberite All Cameras da biste koristili sve audio kanale u izvornim klipovima. Ovo 
podešavanje je slično Camera 1 podešavanju. Omogućen je samo video deo izvorne 
sekvence. Audio-prati-video nije podržan u ovom podešavanju. Sav audio je omogućen 
(do 32 kanala). Broj omogućenih kanala izvornog audija određuje broj aktivnih output 
kanala sekvence.. 

 Izaberite Switch Audio kada želite da se audio zameni sa svojim povezanim videom. Ovo 
podešavanje omogućava sav audio. Omogućava i multicam editovanje i za video i za 
audio izvorne sekvence, kada je uključeno podešavanje audio prati video u Program 
Monitor. Ovo podešavanje takođe mapira multi-mono izvorni audio u jednu adaptivnu 
audio traku. Osim toga, podešavanje audio-prati-video zamenjuje ovu jedinstvenu traku 
sa videom. Ako su u izbor klipova uključeni i samo audio klipovi, oni se stavljaju u 
trakama ispod povezanih klipova. Prazne video trake se prave da bi se uskladile sa 
svakom samo-audio trakom.  

 

Prethodno podešavanje audio kanala 
 
Prethodno podešavanje audio kanala (The Audio Channels preset) određuje kako se mapira 
rezultirajući izvorni video.  
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Napomena: da bi se rezultirajuća izvorna sekvenca pravilno mapirala sa audio kanalima, broj 
traka u izvornim klipovima ne sme da bude veći od broja kanala povezanih sa prethodnim 
podešavanjem koje ste izabrali.   
Automatic: Čita audio tip prvog klipa i koristi ovo mapiranje.  
Mono: Mapira do onoliko mono kanala koliko ima output kanala u izvornoj sekvenci.   
Stereo: Mapira stereo trake bazirano na broju  output kanala u izvornoj sekvenci.   
5.1: Mapira do 5.1 traka bazirano na broju  output kanala u izvornoj sekvenci.  
Adaptive: Mapira do Adaptive bazirano na broju  output kanala u izvornoj sekvenci.   
 

Imena kamera  
 
Kada stvarate multi-cam izvornu sekvencu, možete prikazati imena kamera kao imena klipova ili 
imena traka. Ove opcije su dostupne uz difolt opcije imena kamera označenih brojevima, poput  
kamera 1, kamera 2. 
U zavisnosti od Camera Names opcije koju izaberete, uglovi kamera se prikazuju kao imena 
traka, imena klipova ili brojevi kamera u  Source Monitor. Da biste videli multi-cam sekvencu u 
Source monitor, kliknite desni klik na sekvencu i odaberite Multi-camera. 
 

Organizujte i odaberite uglove kamera za gledanje u  multi-camera modu 
monitora  
 
Premiere Pro vam dozvoljava da organizujete i birate uglove koje ćete videti u multi-camera modu 
iz Source Monitor.   
Iz pop-up menija iz Source monitor, izaberite Edit Cameras. 
U Edit Cameras, svi klipovi su poređani u originalnom redu u kom su postavljeni na trake 
sekvence. Klipove možete prevlačiti mišem (drag-and-drop) da menjate redosled sekvenci. 
Klipove možete i aktivirati i dekativirati ako ih selektujete, odnosno de-selektujete.   
Možete da organizujete i birate kamere u multicam pogledu širom različitih stranica. Možete da 
podesite broj izvora kamere po stranici i krećete se između stranica po potrebi. Kamere ne možete 
prevlačiti mišem u okviru jedne stranice ili od jedne stranice do druge. Ipak, možete da koristite 
opciju Edit Cameras da promenite redosled kamera u multi-cam sekvenci, pa će se i stranice 
spram toga preurediti. 
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Edit Cameras za multi-camera sekvence 
 
U okviru Program Monitor, možete da pretražujete multi-cam stranice koristeći komande koje su 
istaknute na slici dole.   
 

 
Program Monitor za multi-camera sekvence 



 

Interreg – IPA CBC Bulgaria – Serbia Programme  

CB007.2.13.212 

 
 

48 
 

Prečice za Adobe Premiere Pro 
 
Napomena: prečice u Adobe Premiere Pro rade ispravno kada je u operativnom sistemu 
podešen isključivo engleski jezik i pripadajući raspored slova na tastaturi. 

Prečice je moguće promeniti i podesiti opcijom Edit > Keyboard Customization. 
 
 Opšte prečice 

Ishod prečice Prečica (PC) Prečica (Mac) 
 

Selection tool V V 
 

Track Select tool A A 
 

Ripple Edit tool B B 
 

Rolling Edit tool N N 
 

Rate Stretch tool X X 
 

Razor tool C C 
 

Slip tool Y Y 
 

Slide tool U U 
 

Pen tool P P 
 

Hand tool H H 
 

Zoom tool Z Z 
 

Aktiviranje panela u rotaciji na levu stranu Ctrl+Shift+< Ctrl+Shift+< 
 

Aktiviranje panela u rotaciji na desnu stranu Ctrl+Shift+> Ctrl+Shift+> 
 

Aktiviranje panela Project Shift + 1 Shift + 1 
 

Aktiviranje panela Source Monitor Shift + 2 Shift + 2 
 

Aktiviranje panela Timeline Shift + 3 Shift + 3 
 

Aktiviranje panela Program Monitor Shift + 4 Shift + 4 
 

Aktiviranje panela Effect Controls Shift + 5 Shift + 5 
 

Aktiviranje panela Audio Mixer Shift + 6 Shift + 6 
 

Aktiviranje panela Effects Shift + 7 Shift + 7 
 

Zatvaranje aktivnog panela Ctrl + W Command + W 
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Pregled aktivnog panela u full--‐screen 
načinu ` ili ~ ` ili ~ 

 

Prečice u prozoru Trim   
 

   
 

Ishod prečice Prečica (PC) Prečica (Mac) 
 

Aktiviranje ulazne i izlazne strane Alt + 1 Option + 1 
 

Aktiviranje izlazne strane Alt + 2 Option + 2 
 

Aktiviranje ulazne strane Alt + 3 Option + 3 
 

Trimovanje unazad za 1 frejm Alt + Strelica levo 
Option + Shift + 

 

Strelica levo 
 

  
 

Trimovanje unapred za 1 frehm Alt + Strelica desno 
Option + Shift + 

 

Strelica desno 
 

  
 

 

 

Prečice u panelu Timeline 

 

Ishod prečice   Prečica (PC)   Prečica (Mac) 
 

Obeležavanje Work area bar (skr. WAB)  

2x LK mišem na 
WAB  

2x LK mišem na 
WAB 

 

  
 

Obeležavanje ulazne tačke na WAB   Alt + [   Option + [ 
 

Obeležavanje izlazne tačke na WAB   Alt + ]   Option + ] 
 

Brisanje ulaznih i izlaznih tačaka   G   G 
 

Brisanje obeleženog   Backspace   Delete 
 

Pomeranje na sledeći rez   Page Up   Page Up 
 

Pomeranje na prethodni rez   Page Down   Page Down 
 

Pomeranje na kraj sekvence   End   End 
 

Pomeranje na početak sekvence   Home   Home 
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Pomeranje obeležnog klipa na levu stranu   Alt + ,   Option + , 
 

Pomeranje obeleženog klipa na desnu 
stranu   Alt + .   Option + . 

 

Reprodukcija (Play/Pause)   Spacebar   Spacebar 
 

Ubrzana reprodukcija unapred  L (nekoliko puta)  L (nekoliko puta) 
 

Ubrzana reprodukcija unazad   
J (nekoliko 

puta)   
J (nekoliko 

puta) 
 

Ripple delete   Alt + Backspace   Option + Delete 
 

Postavljanje ulazne tačke (In point)   I   I 
 

Postavljanje izlazne tačke (Out point)   O   O 
 

Pomeranje za frejm u desnu stranu   Strelica desno   Strelica desno 
 

Pomeranje za frejm u levu stranu   Strlica levo   Strelica levo 
 

Uveličavanje prikaza panela Timeline = = 
 

Smanjivanje prikaza panela Timeline   --‐   --‐ 
 

Rez obeleženih kanala na poziciji CTI   Ctrl + K   Command + K 
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After Effects 
 

After Effects je sofisticirani program za komponovanje, animiranje i pravljenje slojevitih vizuelnih 
efekata. Vrlo često, After Effects  se koristi za pravljenje pokretne grafike, takve kao što su video 
montaže, animirani logotipi, specijalni titlovi i logotipski efekti za televiziju. 

Takođe, After Effects može da se koristi da komponujete, tj. kombinujete različite video materijale 
za klasičnu i multimedijalnu animaciju, kao i za vizuelne efekte. 

 After Effects može da prihvati bilo koju vrstu izvornog materijala, od fotografija, preko teksta, do 
digitalizovanog video i filmskog materijala. Pruža vam tehničke mogućnosti da radite sa bilo kojom 
rezolucijom, uključujući film, video visoke ili standardne rezolucije.  

Na brzom računaru je sasvim prihvatljivo raditi sa materijalima visoke rezolucije. After Effects 
može da obavlja konvertovanja i pripremu materijala za film, video i web.  

Mnogi After Effects koriste samo za konvertovanje i komprimovanje materijala. 

 

Izgled programa i osnove 
 

Bilo da koristite After Effects za animiranje jednostavnog niza naslova DVD-a ili za stvaranje 
složenih specijalnih efekata, generalno koristite isti osnovni tok rada.  

Interfejs After Effects olakšava vaš rad i prilagođava se svakoj fazi proizvodnje. 

After Effects nudi fleksibilno i prilagodljivo radno okruženje. Glavni prozor programa  zove se 
prozor aplikacije.  

Paneli su organizovani u ovom prozoru u aranžman zvan radni prostor. Podrazumevani radni 
prostor sadrži grupe panela kao i panele koji stoje samostalno, kao što je prikazano u nastavku. 
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A. Prozor aplikacije 

B. Traka radnog prostora 

C. Panel sa alatkama 

D. Project panel 

E. Composition panel 

F. Timeline panel 

G. Stacked paneli 

H. Vremenski grafikon 

 

Radni prostor prilagođavate povlačenjem panela u konfiguraciju koja najbolje odgovara vašem 
stilu rada. Možete da prevučete panele na nove lokacije, promenite redosled složenog panela, 
premeštanje panela u ili iz grupe, postavljanje panela jedan pored drugog, složite panele i odvojite 
panel tako da pluta u novom prozoru iznad prozora aplikacije.  

 

Dok preuređujete panele, ostali paneli menjaju svoju veličinu automatski da ostanu u prozoru 
aplikacije. Kada prevučete panel za njegovu karticu da biste je premestili, područje gde možete 
da ga ispustite - koje se naziva drop zona - postaje istaknuta. Drop zona određuje gde i kako se 
panel ubacuje u radni prostor.  
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Prevlačenjem panela do drop zone, omogućava vam da ga postavite na to mesto, grupišete ili 
složite. Ako ispustite panel uz ivicu drugog panela, grupe ili prozora, panel će se smestiti pored 
postojeće grupe, menjajući veličinu svih grupa kako bi se prilagodili novom panelu.  

Ako ispustite panel na sredini drugog panela ili grupe ili duž područja sa karticama panela, biće 
dodan postojećoj grupi i postaviće se na vrh niza. Grupisanje panela ne menja veličinu drugih 
grupa.  

Panel možete otvoriti i u plutajućem prozoru. Da biste to učinili, odaberite panel i zatim izaberite 
Undock Panel ili Undock Frame iz menija panela. Ili, prevucite panel ili grupu izvan prozora 
aplikacije. 

After Effects koristi tzv. Uslojenu vremensku montažnu liniju, a ne na trakama zasnovanu 
vremensku montažnu liniju koju obično imaju programi za video montažu. Kod montažne linije 
zasnovane na trakama, možete da dodate više klipova na istu traku.  

Međutim, kod uslojene montažne linije koju koristi After Effects, svako parče materijala koje 
dodajete vremenskoj montažnoj liniji pojavljuje se na posebnom sloju, i svaki put kada pravite rez 
i postavljate novu ulaznu/izlaznu tačku za video klip u prozoru Timeline, vi pravite novi sloj.  

Kada posmatrate prozor Composition, stavke (objekti) na vrhu steka (stoga; „plasta”) u prozoru 
Timeline, pojavljuju se ispred stavki koje su na dnu steka.  

Možete promeniti redosled slojeva u prozoru Timeline, tako da oni budu u redosledu slaganja od 
dna ka vrhu. Ako koristite program Adobe Photoshop, prepoznaćete u ovome princip koji koristi 
paleta Layers. 

Rad u After Effects 
Osnovni rad u After Effects prati šest koraka:  

1. uvoz i organizovanje snimaka,  

2. kreiranje kompozicije i aranžiranje slojeva,  

3. dodavanje efekata,  

4. animirani elementi,  

5. pregled vašeg rad,  

6. renderovanje i kreiranje konačne kompozicije, koja se može prikazivati nadalje.  

 

U ovoj lekciji, napravićete jednostavan animirani video koristeći ovaj tok rada, i usput, naučićete 
put oko After Effects interfejsa.  

Prvo ćete pregledati finalni film da biste videli šta ćete stvoriti u ovoj lekciji.  
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1. Proverite da li su sledeće datoteke u direktorijumu Data / 01 na vašem disku, 

 • U fascikli Assets: motion.mp3, swimming_dog.mp4, title.psd  

 • U fascikli Sample_Movies: 01.avi 

2. Otvorite i reprodukujte iz Sample_Movies, 01.avi  da biste videli šta ćete stvoriti u ovoj lekciji. 

 

Izrada projekta i uvoz snimaka  
 

Kada započnete svaku lekciju, dobra je ideja da vratite zadane postavke za After Effects. Vi to 
možete učiniti jednostavnom prečicom na tastaturi.  

 
 1. Pokrenite After Effects, a zatim odmah držite Ctrl + Alt + Shift (Windows) ili Command 
+ Option + Shift (Mac OS) za vraćanje podrazumevanih postavki podešavanja. Kliknete na OK 
da biste izbrisali svoje prethodne postavke. 

 

 2. Zatvorite prozor Start 

 

 

 

 

 

 

 

 

Savet: 

Vraćanje podrazumevanih podešavanja može biti komplikovano u Windows-u, posebno ako  
radite na brzom sistemu. Pritisnite tastere nakon što dvaput kliknete aplikacionu ikonu. 
Alternativno, možete da izaberete Edit> [vaše korisničko ime za Creative Cloud nalog]> Clear 
Settings, a zatim ponovo pokrenite aplikaciju. 

 

Nakon otvaranja After Effects prikazuje prazan projekat bez naslova. 
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Projekat After Effects-a je jedna datoteka koja čuva reference na sve snimke koji se koristite u 
projektu. Takođe sadrži kompozicije, koje su pojedinačni kontejneri koji se koriste za 
kombinovanje snimaka, primenjivanje efekata i, na kraju, pokretanje rezultata.  

 

Kada započnete sa projektom, prvo što ćete uraditi je dodavanje snimak.  

 

3. Izaberite File > Import > File. 

4. Pomerite se do fascikle Assets u folderu Data / 01. Pritisnite Shift i obeležite motion.mp3 i 
swimming_dog.mp4 datoteke. Zatim kliknite na Import ili Open. 
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Footage item je osnovna jedinica u After Effects projektu. Možete uvesti više vrsta item-a 
uključujući datoteke sa pokretnim slikama, datoteke sa nepokretnim slikama, nizove fotografija, 
zvučne datoteke, datoteke sa lejerima Adobe Photoshop-a i Adobe Illustrator-a, drugih After 
Effects projekata, i projekte kreirane u Adobe Premiere Pro.  

 

Nove item-e možete uvesti u bilo koje vreme. Dok uvozite item-e, After Effects izveštava o svom 
napretku na info tabli. Budući da je jedna od stavki snimka ovog projekta multy layer datoteka 
Photoshop-a, ubaciće se odvojeno kao kompozicija.  

 

 

5. Dvaput kliknite na donji deo panela Project da biste 
otvorili dijalog Import File 

 

Takođe možete da izaberete File > Import > Multiple Files 
da biste odabrali datoteke koje se nalaze u različitim 
fasciklama ili prevucite i ispustite datoteke iz Explorer-a. 
Možete koristiti Adobe Bridge za traženje, upravljanje, 
pregled i uvoz materijala. 
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6. Ponovo dođite do fascikle Data/ 01 / Assets i izaberite title.psd datoteku. Izaberite 
Composition iz menija Import As. Zatim kliknite na Import ili Open. 

 

 

 

 

 

 

 

 

 

 

 

Nakon toga After Effects otvara dodatni dijalog prozor koji prikazuje opcije za datoteku koja se 
uvozi.  

 

7. U okviru dijaloga  title.psd izaberite Composition iz Import Kind menija za uvoz layered 
Photoshop datoteka kao kompozicija. Izaberite Editable Layer Styles u polju Layer Options, a 
zatim kliknite na dugme OK. 

 

Stavke item-a pojavljuju se u panelu Project. 
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8. U panelu Project kliknite za odabir različitih stavki snimka. Primetite da se sličica pregled 
pojavljuje na vrhu panela Project. Takođe možete videti vrstu i veličinu datoteke kao i mnoge 
druge informacije o svakoj stavci u kolonama u Project panelu. 

 

Kada uvezete datoteke, After Effects ne kopira aktualne video i audio podatke u vaš projekat. 
Umesto toga, svaka stavka snimka u panelu Project sadrži referencu na izvor fajlova. Kad After 
Effects treba da preuzme slike ili audio podatke, ona ih čita iz izvorne datoteke. Ovo zadržava 
datoteku projekta malom i omogućava vam da ažurirate izvorne datoteke u drugoj aplikaciji bez 
izmene projekta.  

 

Ako premestite datoteku ili ako After Effects ne može da pristupi njenoj lokaciji, izvestiće da je 
datoteka nedostaje. Da biste pronašli datoteke koje nedostaju, izaberite File > Dependencies > 
Find Missing Footage. Možete takođe da otkucate Missing Footage u okvir za pretragu u panelu 
Project da biste tražili nestale stavke. 

 

Na isti način možete pronaći nedostajuće fontove ili efekte. Izaberite File > Dependencies, a zatim 
izaberite Find Missing Fonts (pronađi nedostajuće fontove) ili Find Missing Effects (Pronađi 
nedostajuće efekte) . Ili samo u polje za pretragu u Project panelu ukucajte Missing Fonts ili 
Missing Effects.  
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Da biste uštedeli vreme i smanjili veličinu i složenost projekta, obično ćete uvesti snimke jednom, 
čak i ako ga više puta koristite u kompoziciji. Međutim, možda je ponekad potrebno da uvezete 
izvornu datoteku više puta, na primer ako želite da je koristite sa dve različite brzine kadrova.  

Nakon što uvezete snimke, pravo je vreme da sačuvate projekat.  

 

9. Izaberite File > Save ( Datoteka> Sačuvaj). U dijalogu Save As, idite do Data / 01 / 
Finished_Project folder. Dajte naziv projektu 01_Finished.aep, a zatim kliknite na Save. 

Stvaranje kompozicije i rad sa lejerima 
 

Sledeći korak u radnom toku je kreiranje kompozicije. Kreirate sve animacije, slojeve, i efekte u 
kompoziciji. Kompozicija After Effects-a ima i prostornu dimenziju i vremensku dimenziju (vreme).  

 

Kompozicije uključuju jedan ili više slojeva, raspoređenih u panelu Composition i u panelu 
Timeline. Bilo koja stavka koju dodate kompoziciji - poput nepokretne slike, pokretne slike, zvučne 
datoteke, layer svetla, layer kamere ili čak drugu kompoziciju - postaje novi layer (sloj). 
Jednostavni projekti mogu obuhvatati samo jednu kompoziciju, dok složeni projekti mogu 
uključivati nekoliko kompozicija za organizovanje velike količine snimaka ili zamršenih efekata.  

 

Da biste kreirali kompoziciju, povući ćete stavke snimka na panel Timeline i    After Effects će 
stvoriti slojeve za njih.      
 

1. Na panelu Project, pritisnite taster Shift da biste odabrali movement.mp3, swimming_dog.mp4 
i title aset. 

 

2. Prevucite izabrane stavke snimaka na panel Timeline. New Composition From Selection dijalog 
za izbor se otvara.  

 

After Effects dimenzije nove kompozicije zasniva na odabranim snimcima. U ovom našem 
primeru, svi snimci su jednake veličine, tako da ćete prihvatiti podrazumevana podešavanja za 
kompoziciju.  
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3. Izaberite swimming_dog.mp4 u meniju Use Dimensions From, a zatim kliknite na OK da stvorite 
novu kompoziciju. 

 

Stavke snimka prikazuju se kao slojevi na panelu Timeline, a After Effects prikazuje  kompoziciju, 
nazvanu swimming_dog, na Composition panelu. 

 

Kada kompoziciji dodate stavku, snimak postaje izvor novog layer-a. Kompozicija može imati bilo 
koji broj layer-a, a možete dodati i kompoziciju kao layer drugoj kompoziciji, što se naziva 
gnezdenje. 

 

Neki itemi su duži od drugih, ali želite da svi traju samo onoliko dugo koliko pas pliva. Promenite 
dužinu cele kompozicije u 1:12 da se podudaraju sa klipom sa  psom.  

 

4. Izaberite Composition> Composition Settings. 
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5. Preimenujte ime kompozicije u dijalogu Composition Settings u movement, otkucajte 1:12 za 
trajanje, a zatim kliknite na dugme OK. 

 

 

 

 

 

 

 

 

 

 

 

 

Panel Timeline prikazuje isto trajanje za svaki od slojeva. U ovoj kompoziciji postoje tri itema, a 
samim tim i tri sloja u Timeline panelu. U zavisnosti od redosleda odabira elemenata kada ste ih 
uvezli, vaš sloj layera može se razlikovati od onog prikazanog na prethodnoj stranici. Layer-i 
moraju biti svrstani određenim redosledom kako dodajete efekte i animacije, tako da ćete ih sada 
preurediti.  
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O lejerima (slojevima) 
 

Slojevi su komponente koje koristite za pravljenje kompozicije. Bilo koju stavku koju dodate 
kompoziciji - kao što su nepokretna slika, datoteka sa pokretnim slikama, audio datoteka, layer 
svetla, layer kamere ili čak druga kompozicija - postaje novi sloj. Bez slojeva, kompozicija se 
sastoji samo od praznog okvira.  

 

Pomoću slojeva možete raditi sa određenim stavkama snimka u kompoziciji bez uticaja na bilo 
koji drugi snimak. Na primer, možete da pomerate, rotirate i crtate maske za jedan sloj bez 
ometanja drugih slojeva u kompoziciji ili možete koristiti iste snimke u više slojeva i koristite ih 
različito u svakom od slučajeva. Redosled slojeva na Timeline panelu odgovara vrednosti 
redosleda slaganja na panelu Composition. 

Napomena: Možda će biti potrebno da kliknete prazno polje u panleu Timeline ili pritisnite F2 da 
biste poništili izbor slojeva pre nego što možete da izaberete pojedinačni sloj.  

6. Kliknite prazno područje u panleu Timeline da biste poništili odabir slojeva, a zatim prevucite 
title layer na vrh snopa layer-a, ako ga tamo već nema. Povucite movement.mp3 na dno snopa 
layer-a. 

 

 

 

 

 

7. Odaberite File > Save da biste dosad sačuvali svoj projekat. 

 

Dodavanje efekata i modifikacija svojstava layer-a  
 

Sada kada je vaša kompozicija postavljena, možete početi da se zabavljate - dodavanjem 
animacija, primenjujući efekte i praveći transformacije. Možete dodati bilo koju kombinaciju 
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efekata i modifikovati bilo koje osobine sloja, poput veličine, pozicije i neprozirnosti. Koristeći 
efekte, možete da promenite izgled ili zvuk sloja, pa čak da generišete vizuelne elemente iz 
početka.  

 

Najlakši način za početak je primeniti bilo koji od stotina efekata koji su uključeni u After Effects.  

 

Transformisanje svojstava layer-a  
 

Naslov se trenutno nalazi na sredini ekrana, zatamnjujući psa i odvlačeći pažnju od akcije. 
Premestićete je u donji levi ugao, gde će ostati vidljiv, ali ne i na smetnji.  

 

1. Izaberite title layer (sloj 1) u panelu Timeline. Primetite da se pojavljuju ručke sloja oko layera 
na Composition panelu. 

 

2. Kliknite trougao levo od broja sloja da biste proširili sloj, a zatim proširite Transform svojstva 
sloja: Anchor Point, Position, Scale, Rotation, i Opacity ( tačka sidrenja, položaj, skala, rotacija i 
neprozirnost). 

 

 

 

 

 

 

 

 

3. Ako ne možete da vidite svojstva, pomerite se niz panel Timeline pomoću trake za pomeranje 
na desnoj strani panela. Još bolje, ponovo odaberite ime title layera-a i pritisnite P. 

Ova prečica na tastaturi prikazuje samo svojstvo Position, koje je jedino svojstvo koje želimo da  
promenimo za ovu vežbu. Premestićete ovaj sloj u donji levi ugao. 

 

4. Promenite koordinate za svojstvo Position na 265, 635. Ili koristite alat za odabir da prevučete 
naslov u donji levi ugao ekrana. 
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5. Pritisnite P da biste sakrili svojstvo Position i zadržali čist Timeline (vremensku traku). 

 

Dodavanje efekta za ispravljanje boje 
 

After Effects uključuje nekoliko efekata za ispravljanje ili modifikaciju boje u vašim projektima. 
Koristićete efekt automatskog kontrasta za podešavanje ukupnog kontrasta u klipu i pojačavanje 
boje vode.  

 

1. Izaberite layer swimming_dog u Timeline panelu. 

 

2. Kliknite panel Effects & Presets (u snopu panela na desnoj strani aplikacije prozora) da biste 
ga otvorili i u polje za pretragu otkucajte contrast. 

 

 

 

 

 

 

 

Ako kliknete dvaput na layer u panelu Timeline, After Effects otvara sloj unutra Layer panela. Da 
biste se vratili na panel Composition, kliknite na karticu Composition.  

After Effects traži efekte i unapred postavljene vrednosti koje sadrže slova koja unosite i 
prikazuje im rezultat interaktivno. Pre nego što završite sa unosom, efekat automatskog 
kontrasta - koji se nalazi u Auto Contrast - pojavljuje se na panelu.  
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3. Povucite efekt Auto Contrast na swimming_dog layer u panelu Timeline. 

 

 

 

 

 

 

 

 

 

Nakon što After Effects primeni efekat,  automatski se otvori panel Effect Controls gore levo  u 
okviru radnog prostora. 

 

 

 

 

 

 

 

Kontrast pojačava boje malo više nego što nam je potrebno. Prilagodite podešavanja da 
smanjite efekat.  

 

4. Na Effect Controls panelu kliknite broj pored „Blend With Original“, otkucajte 20%, i pritisnite 
Enter ili Return da prihvatite novu vrednost. 

 

Dodavanje stilskog efekta  
 

After Effects takođe uključuje mnogo stilskih efekata. U klip ćete dodati snop svetlosti radi 
laganog umetničkog dodira. Promenite podešavanja ovog efekta da biste izmenili ugao i 
intenzitet svetla. 
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1. Kliknite x u polju za pretragu na panelu Effects & Presets da biste ga očistili, a zatim 
pronađite CC Light Sweep efekat na jedan od sledećih načina: 

• U polje za pretragu otkucajte CC Light.  

• Kliknite na trougao pored Generate da biste proširili kategoriju po abecednom redu. 

 

 

 

 

 

 

 

 

 

2. Povucite efekt CC Light Sweep iz kategorije Generate na swimming_dog layer ime u Timeline 
panelu. After Effects dodaje CC Light Sweep podesavanja Effect Controls panelu ispod Auto 
Contrast efekta. 

 

 

 

 

 

 

 

 

 

 

3. U Effect Controls panelu kliknite na trougao pored efekta Auto Contrast da biste se sakrili ta 
podešavanja kako biste lakše videli podešavanja CC Light Sweep. 

Prvo ćete promeniti ugao svetlosti.  

4. Za Direction, otkucajte 37 °. 
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5. Iz menija Shape izaberite Smooth da biste proširili i omekšali svetlosni snop. 

6. Za Width, otkucajte 68 da biste malo više proširili snop. 

7. Promenite vrednost Sweep Intensity u 20 da bi snop bio malo suptilniji. 

 

 

 

 

 

 

 

 

8. Izaberite File > Save da biste sačuvali dosadašnji rad. 

Animiranje kompozicije  
 

Do sada ste započeli projekat, stvorili kompoziciju, uvezeli snimke i primenili neke efekte. Sve 
izgleda sjajno, ali kako je s nekim pokretom? Primenjivali ste samo statičke efekte.  

 

U After Effects možete promeniti bilo koju kombinaciju svojstava sloja koristeći keyframe-ove, 
izraze ili keyframe pomoćnike. 

Za ovaj projekat, primenićete unapred postavljenu animaciju (preset) da se naslov prikaže na 
ekranu, a vi ćete animirati boju naslova tokom vremena.  

 

Priprema kompozicije teksta  
U ovoj vežbi ćete raditi sa zasebnom kompozicijom - onom koji ste uvezli iz layered Photoshop 
datoteke. 

Ako kartica Project nije vidljiva, odaberite Window > Project da biste otvorili Project panel.  

 

1. Izaberite karticu Project da biste prikazali panel projekta, a zatim dvaput kliknite title 
kompoziciju da bi ste je otvorili kao kompoziciju na sopstvenom timeline-u. 
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Ova kompozicija je slojevita datoteka Photoshopa koju ste uvezli. Dva layer-a - Title Here i Ellipse 
1 - pojavljuju se u Timeline panelu. Layer Title Here sadrži mesto za tekst koji je stvoren u 
Photoshopu. 

 

 

 

 

 

 

 

 

 

 

Na vrhu panela za kompoziciju nalazi se traka za navigaciju za kompoziciju, koja prikazuje 
odnos između glavne kompozicije (movement) i trenutne kompozicije (title), koja je ugniježđena 
u glavnoj kompoziciji. 

 

 

 

 

 

 

 

Možete ugraditi više kompozicija međusobno; traka Composition Navigator prikazuje celokupnu 
putanju kompozicije.  

 

Strelice između naziva kompozicije označavaju pravac u kome teče informacija. Pre nego što 
možete zameniti tekst, morate da layer učinite spremnim za uređivanje.  

Ako vidite upozorenje o nedostajućim fontovima ili zavisnostima layer-a, kliknite na dugme OK.  

 

2. Izaberite Title Here layer (layer 1) na u Timeline panelu a zatim odaberite Layer > 

Convert To Editable Text. 
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Ikona T pojavljuje se pored naziva sloja u Timeline panelu, što ukazuje da sada layer teksta  može 
da se uređuje. Sloj je takođe izabran na panelu Composition,i spreman je za uređivanje.  

 

Plave linije na vrhu, dnu i bočnim stranama kompozicije prikazuju sigurne zone za naslove i  
akcije. Televizori povećavaju video sliku i time omogućavaju da deo njenih spoljašnjih ivica može 
biti odsečen ivicom ekrana. To je poznato kao overscan efekat.  

 

Količina overscan -a nije dosledna između televizora, tako da treba da zadržite važne delove 
video slika, poput radnje ili naslova, u marginama koje nazivamo sigurnim zonama.  

Zadržite svoj tekst unutra unutrašnje plave vodilice kako bi se osiguralo da se nalazi u zaštićenoj 
zoni i zadržite važne elemente scene unutar spoljnjih plavih vodilica kako bi se osiguralo da se 
nalaze u sigurnoj zoni akcija.  

 

Panel sa alatkama  
 

Čim napravite kompoziciju, alati na panelu sa alatkama u gornjem levom uglu prozora aplikacije 
After Effects postaju dostupni. After Effects uključuje alate koji vam omogućavaju da menjate 
elemente svoje kompozicije. Neki od ovih alata - na primer, alat za odabir i Hand tool (alat) – 
biće vam poznati ako koristite druge Adobe aplikacije, kao što je Photoshop. Ostali će biti novi. 

 

 

 

A. Izbor  

B. Ruka  

C. Zum 

D. Rotacija 

E. Alati za kamere  
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F. Pan Behind  

G. Alati za masku i oblik  

H. Olovka alati 

I. Tekst alati 

J. Brush  

K. Clone Stamp  

L. Eraser (gumica) 

M. Roto četkica i Refine Edge alati 

N. Puppet alati 

Kada zadržite pokazivač miša preko bilo kojeg dugmeta na panelu sa alatkama, tool tip 
identifikuje alatku i prečicu na tastaturi. Mali trougao u donjem desnom uglu dugmeta označava 
da se iza njega krije jedan ili više dodatnih alata. Kliknite i držite dugme za prikaz skrivenih alata, 
a zatim izaberite alat koju želite da koristite. 

Uređivanje teksta  
 

Počećete tako što ćete primer tekst  zameniti stvarnim tekstom. Tada ćete ga formatirati da bolje 
pristaje veličini okvira. 

 

1. Izaberite alat Horizontal Type (T) na ploči sa alatkama i prevucite ga preko primera teksta na 
Composition panelu da ga izaberete. Zatim upišite u on the move. 

 

 

 

 

 

 

 

After Effects nudi robusne kontrole formatiranja znakova i odlomaka, ali podrazumevana 
podešavanja - koji god font koristite kad kucate - trebale bi da budu u redu za ovaj projekat.  

Animiranje teksta sa unapred postavljenim animacijama  
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Sada kada je tekst formatiran, možete primeniti unapred postavljenu animaciju. Koristićete Fade 
Up Words unapred podešenu animaciju, pa će se reči s vremenom pojavljivati po redosledu.  

 

1. Izaberite ponovo sloj Title Here u Timeline panelu i uverite se da ste na prvom frejmu animacije 
koristeći jedan od sledećih postupaka: 

• Povucite indikator trenutnog vremena sve do leve strane merača vremena, do 0:00.  

• Pritisnite taster Home na tastaturi.  

 

 

 

 

 

 

 

2. Odaberite karticu Effects & Presets da biste prikazali panel Effects & Presets. Zatim otkucajte 
fade up words u polju za pretragu. 

 

3. Izaberite efekat Fade Up Words u kategoriji Animate In i prevucite je na on the move tekst u 
Composition panelu. 

 

 

 

 

 

After Effects dodaje efekat. Pošto je to jednostavan efekat, u efektu nema podešavanja u Effect 
Controls panelu.  

 

4. Ručno pregledajte efekat povlačenjem indikatora trenutnog vremena od 0:00 do 1:00. Reči se 
postepeno pojavljuju, tako da će sve biti na ekranu do 1:00. 
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O vremenskom kodu i trajanju  
 

Primarni koncept vezan za vreme je trajanje ili dužina. Svaka stavka sa snimkom, layer i 
kompozicija u projektu ima svoje trajanje, što se odražava na početno i krajnje vreme prikazano 
u  prikazivaču vremena u Composition, Layer  i Timeline panelima.  

 

Način na koji vidite i odredite vreme u After Effects-u zavisi od stila prikaza, ili jedinice mere, koju 
koristite da opišete vreme. Zadato, After Effects prikazuje vreme u Society of Motion Picture and 
Television Engineers (Društvo inženjera filmova i televizije), (SMPTE) vremenski kod: sati, 
minute, sekundi i frejmovi (okviri,kadrovi).  

 

Da biste saznali kada i kako da se prebacite na drugi sistem prikaza vremena, kao što su kadrovi 
ili feet i frejm filma potražite u After Effects Help-u.  

Timeline panel 

 

Upotrebite Timeline panel da biste animirali svojstva layera i podesili In i Out tačke za layer. (In i 
Out tačke su tačke u kojima jedan sloj počinje i završava  se, u kompoziciji.) Mnoge kontrole 
Timeline panel su organizovane u kolonama povezanih funkcija. Podrazumevano, Timeline panel 
sadrži veći broj kolona i kontrola, kao što je ovde prikazano: 

 

A. Trenutno vreme  

B. Ime kompozicije  

C. Meni na panel traci 

D. Kolona za audio / video prebacivanje 
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E. Kolona Ime / Naziv sloja  

F. Layer sklopke  

G. Područje vremenskog grafikona / oblast uređivača grafikona  

 

 

Razumevanje vremenskog grafikona ( time graph ) 
 

Deo vremenskog grafikona Timeline panela (desna strana) sadrži merač za vreme , markere za 
označavanje određenog vremena i trake trajanja za layer-e u vašoj kompoziciji. 

 

 

 

 

 

 

 

 

A. Početna i krajnja zagrada navigatora  

B. Početni i krajnji nosači radnog područja  

C. Klizač vremenskog zumiranja 

D. Merač vremena 

E. Bin za markere kompozicije  

F. Dugme za kompoziciju  

 

Pre nego što se previše duboko udubite u animaciju, pomoći će vam da bar malo razumete ove 
kontrole. Trajanje kompozicije, sloja ili elementa sa snimkom je predstavljeno vizuelno na 
vremenskom grafikonu.  

 

Na meraču vremena, indikator tekućeg vreme označava frame koji gledate ili uređujete, a frejm 
se pojavljuje u Composition panelu.  
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Početne i krajnje zagrade za radno područje označavaju deo kompozicije koji će biti prikazan radi 
pregleda ili konačnog izlaza. 

Kada radite na kompoziciji, vi ćete možda želeti da prikažete samo njen deo označavanjem 
segmenta u meraču vremena kompozicije. Trenutno početno vreme kompozicije pojavljuje se u 
gornjem levom uglu Timeline panela.  

 

Da biste prešli na drugo vreme, prevucite indikator trenutnog vremena u meraču vremena  ili 
kliknite na polje trenutnog vremena uTimeline panelu ili Composition panelu, i unesite novo vreme 
a zatim kliknite na dugme OK.  

 

Efekti animiranja pomoću keyframe-ova 
 

Dodaćete efekat type layer-u, ali ovaj put ćete animirati njegova podešavanja pomoću keyframe-
ova.  

 

1. Idite na početak merača vremena tako što ćete uraditi nešto od sledećeg: 

• Povucite indikator trenutnog vremena ulevo u meraču vremena tako da je postavljen na 0:00.  

• Kliknite polje Current Time u Timeline panelu ili Composition panelu i otkucajte 00.  

Ako ste kliknuli na polje Current Time na kompoziciji, kliknite OK da biste zatvorili dijalog Go to 
Time.  

2. U polje za pretraživanje upišite channel blur u panelu Effects & Presets. 

3. Povucite efekt Channel Blur na sloj Title Here u Timeline panelu. After Effects dodaje Channel 
Blur efekat layer-u i prikazuje njegove postavke u Effect Controls panel. Channel Blur pojedinačno 
zamagljuje crveni, zeleni, plavi i alfa kanal u sloju. Stvoriće zanimljiv izgled naslova. 

4. Na panelu Effect Controls postavite Red Blurriness, Green Blurriness, Blue Blurriness, i Alpha 
Blurriness vrednosti na 50. 

5. Kliknite ikonu štoperice pored svakog podešavanja koje ste promenili da biste kreirali početni 
keyframe. Tekst će biti zamagljen kada se prvi put pojavi. 

Keyframe-ovi se koriste za kreiranje i kontrolu animacija, efekata, audio svojstava i mnogih drugih 
vrsta promena koje se dešavaju tokom vremena. Keyframe označava tačku u kojoj ste odredili 
vrednost, kao što su prostorni položaj, neprozirnost ili jačina zvuka.  

Vrednosti između ključnih tačaka se interpoliraju. Kada koristite keyframe-ove za kreiranje 
promena tokom vremena, morate da koristite najmanje dva keyframe-a : jedan za stanje na 
početku promene i jedan za stanje na kraju promene promena. 

6. Na meniju Blur Dimensions odaberite Vertical. 
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7. Idite do 1:00 na vremenskoj traci. 

 

 

 

 

 

 

8. Promenite vrednosti u sledeće: 

• Crvena zamućenost: 0  

• Zelena mutnost: 0  

• Plava zamućenost: 0  

• Alpha Blurriness: 0 

 

 

 

 

 

 

 

 

9. Ručno pregledajte efekat pomeranjem indikatora trenutnog vremena sa 0 na 1:00 

 

 

Promena neprozirnosti pozadine  
Naslov izgleda dobro, ali elipsa je previše svetla. Izmenićete njenu neprozirnost, tako da se voda 
u video klipu nazire.  
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Da biste zapamtili prečicu na tastaturi za svojstvo Opacity, mislite na to transparentnost. Da 
biste videli kako se naslov pojavljuje nad vodom, kliknite na karticu movement u Timeline 
panelu.  

 

1. U Timeline panelu odaberite sloj Ellipse 1. 

2. Pritisnite T da biste otkrili svojstvo Opacity layer-a. 

3. Promenite vrednost Opacity na 20% 

 

 

 

 

 

 

 

Pregled vašeg rada  
 

Verovatno ste nestrpljivi da vidite rezultate svog rada. Možete pregledati svoju kompoziciju 
pomoću panela Preview koji se nalazi na složenim panelima na desnoj strani  prozora aplikacije 
u podrazumevanom radnom prostoru. Da biste pregledali kompoziciju, kliknite na dugme 
Play/Stop u  Preview panelu ili pritisnite spacebar na tastaturi.  

 

1. U title Timeline panelu sakrijte sva svojstva sloja i deselktujte sve slojeve. 

2. Proverite da li je za slojeve koje želite da pregledate odabran Video switch (*), u ovom slučaju 
slojevi Title Here i Ellipse 1. 

3. Pritisnite taster Home da biste se prebacili na početak merača vremena. 

4. Uradite nešto od sledećeg: 

• Kliknite na dugme Play / Stop (>)  u panelu Preview.  

• Pritisnite spacebar. 

 



 

Interreg – IPA CBC Bulgaria – Serbia Programme  

CB007.2.13.212 

 
 

77 
 

 

 

 

5. Da biste zaustavili pregled, uradite nešto od sledećeg: 

• Kliknite na dugme Play / Stop  u panelu Preview.  

• Pritisnite spacebar. 

 

 

Pregledali ste jednostavnu animaciju, pa će se verovatno reprodukovati u realnom vremenu.  

Proverite da li zagrade radne površine sadrže sve okvire koje želite da pregledate.  

Kada pritisnete spacebar ili kliknete na dugme Play / Stop, After Effects kopira u memoriju 
kompoziciju i dodeljuje dovoljno RAM-a za reprodukciju (uz zvuk) onoliko brzo koliko sistem 
omogućava, do brzine kadrova kompozicije. Broj odigranih kadrova zavisi od količine RAM-a 
dostupnog aplikaciji. Često se pregled reprodukuje u realnom vremenu, samo nakon što After 
Effects kešira sve uključene okvire.  

U Timeline panelu, pregled reprodukuje snimak u trajanju istom kao raspon vremena koji 
navedete kao radnu oblast, ili s početka merača vremena. Na panelima Layer i Footage pregled 
reprodukuje samo neskraćene snimke. Pre pregleda, proverite koji su okviri označeni kao okviri 
oblasti.  

Sada ćete pregledati celokupnu kompoziciju - animirani tekst plus grafički efekti.  

 

6. Kliknite karticu movement u Timeline panelu da biste je izveli napred. 

7. Proverite da li je video prekidač (*) uključen za sve slojeve u kompoziciji osim zvučnog sloja i 
pritisnite F2 da biste poništili odabir svih slojeva. 

8. Povucite indikator trenutnog vremena na početak merača vremena ili pritisnite Home dugme. 
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9. Da biste započeli pregled, pritisnite dugme Play / Stop (>) na panelu Preview ili pritisnite 
spacebar. 

 

Zelena traka napretka označava koji su okviri u keširani u memoriju. Kad su svi kadrovi unutra 
radne površina keširani, pregled se reprodukuje u stvarnom vremenu.  

 

Dok se svi okviri ne keširaju, reprodukcija može biti sporija i zvuk može da se izobliči. 

 

 

Što više detalja i preciznosti želite da pregledate, potrebno je više RAM-a. Možete da 
kontrolišete količinu prikazanih detalja promenom rezolucije.  

 

Takođe možete ograničiti broj pregledanih slojeva isključivanjem Video prekidača za određene 
slojeve ili da ograničite broj frame-ova koji se pregledavaju podešavanjem radnog područja 
kompozicije.  

 

10. Pritisnite spacebar da zaustavite pregled. 

11. Izaberite File > Save da biste sačuvali svoj projekat. 

 

Maske i  animacija maski 
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Maska u Adobe After Effects je put ili kontura koja se koristi za izmenu efekata sloja i svojstva. 
Najčešća upotreba maski je za izmenu alfa kanala sloja. Maska se sastoji od segmenata i vrhova: 
Segmenti su linije ili krivulje koje povezuju vrhove. Vrhovi određuju gde počinje i gde završava 
svaki segment puta.  

 

Maska može biti otvorena ili zatvorena staza. Otvorena staza ima početnu tačku koja nije ista 
kao i krajnja tačka; na primer, ravna linija je otvorena staza. Zatvorena staza je kontinuirana i 
nema početka ni kraja, kao što je krug.  

Maske zatvorenog puta mogu da kreiraju transparentne oblasti za layer. Otvorene staze ne 
mogu da stvaraju providna područja za sloj, ali su korisni kao parametri za efekat.  

Na primer, možete da koristite efekat za generisanje rasipanja svetla oko maske.  

Maska pripada određenom sloju. Svaki sloj može da sadrži više maski. Možete crtati maske u 
uobičajenim geometrijskim oblicima - uključujući poligone, elipse i zvezde - pomoću alata za 
oblik ili pomoću alata Pen možete crtati proizvoljnu putanju. 

U ovoj lekciji napravićete masku za ekran televizora i zameniti na ekranu originalni sadržaj sa 
svojim filmom. Tada ćete prilagoditi pozicioniranje novog snimaka tako da odgovara perspektivi 
starog snimka na ekranu televizora. Konačno ćete polirati scenu dodavanjem refleksije, 
stvaranjem efekta vinjete i prilagođavanjem boje.  

Započnite pregledom filma i postavljanjem projekta.  

 

1. Proverite da li su sledeće datoteke u direktorijumu Data / 02 na vašem disku 

• U fascikli Assets: Turtle.mov, Watching_TV.mov 

• U fascikli Sample_Movies: 02.avi 

2. Otvorite i reprodukujte primer filma 02.avi u programu Windows Media Player da biste videli 
šta ćete stvoriti u ovoj lekciji. 

Kada započnete lekciju, vratite zadate postavke aplikacije za After Effects.   

3. Pokrenite After Effects, a zatim odmah držite Ctrl + Alt + Shift   za vraćanje podrazumevanih 
podešavanja postavki.  Kliknete na OK da biste izbrisali svoje postavke. Zatvorite prozor Start. 

After Effects otvora novi projekat bez naslova.  

4. Odaberite File > Save As > Save As i otvorite Data / 02 / Finished_Project folder. 

5. Dajte naziv 02_Finished.aep, a zatim kliknite na Save. 

 

Stvaranje kompozicije  
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Za ovu vežbu uvezite dva snimka. Tada ćete kreirati kompoziciju zasnovanu na odnosu slike i 
trajanju jednog od snimaka.  

 

1. Dvaput kliknite prazan deo panela Project da biste otvorili dijalog Import File. 

 

2. Otvorite folder Data/02/Assets, pritisnite Shift da biste odabrali Turtle.mov i 
Watching_TV.mov, a zatim kliknite Import ili Open. 

 

3. Izaberite stavku snimka Watching_TV.mov  u Project panelu i povucite je na Create A New 
Composition dugme   pri dnu panela. 

 

 

 

 

 

 

 

Izrada maske pomoću alata Pen  

 

TV ekran je trenutno prazan. Da biste ga napunili sa video klipom morske kornjače, trebate 
maskirati ekran.  

1. Pritisnite Home taster ili pomerite indikator trenutnog vremena na početak merača vremena. 

2. Zumirajte na panel Composition sve dok TV ekran skoro ne ispuni prikaz. Možda treba da 
upotrebite alat Hand  da biste pozicionirali prikaz na ploči. 

3. Proverite da li je u Timeline panelu izabran sloj Watching_TV.mov, a nakon toga izaberite alat 
Pen    na ploči sa alatkama. 
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Savet  
Takođe možete da kreirate masku pomoću dodatka za oblik mocha, koji dolazi zajedno sa After 
Effects, a zatim uvezite u After Effects. 

Alat olovke stvara ravne linije ili zakrivljene segmente. Čini se da je TV pravougaonik, dakle 
prvo ćete pokušati da koristite ravne linije.  

4. Kliknite gornji levi ugao TV ekrana da biste postavili prvi vrh. 

5. Kliknite gornji desni ugao TV ekrana da postavite drugu tačku. After Effects povezuje dve 
tačke sa segmentom. 

6. Kliknite da biste postavili treću tačku u donji desni ugao TV ekrana, a zatim kliknite da 
postavite četvrtu tačku u donji levi ugao ekrana. 

7. Pomerite alatku olovke preko prve tačke (u gornjem levom uglu). Kada se pojavi krug pored 
pokazivača (kao na srednjoj slici ispod) kliknite da biste zatvorili put maske. 

 

 

 

       

 

 

 

 

 

 

Uređivanje maske  

 

Maska izgleda prilično dobro, ali umesto da maskira informacije unutar monitora, maska je 
uklonila sve izvan monitora. Morate da preokrenete masku. Takođe ćete koristiti Bezierove krive 
da biste stvorili tačniju masku.  

Za ovaj projekat, potrebno vam je da sve unutar maske bude transparentno, a sve spolja maske 
mora biti neprozirno. Sad ćete preokrenuti masku.  

Savet  
Dvaput brzim uzastopnim pritiskom na taster M prikazuju se sva svojstva maske za izabrani 
sloj.  

1. Izaberite sloj Watching_TV.mov u Timeline panelu i pritisnite taster M da biste videli Mask 
Path svojstva za masku. 
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Postoje dva načina za okretanje ove maske: odabirom Subtract iz pop-up Mask Mode menija ili 
odabirom opcije Inverted.  

2. Izaberite obrnutu opciju za masku 1. 

 

Maska se okreće.  

3. Pritisnite F2 ili kliknite prazan deo panela Timeline da biste poništili izbor 
Watching_TV.mov sloja. 

4.  

O modovima maskiranja  

 

Režimi Blending-a za maske (modovi maski) kontrolišu kako maske unutar sloja međusobno 
komuniciraju. Podrazumevano su sve maske postavljene na Add, što sabira vrednosti 
prozirnosti svih maski koje se preklapaju na istom sloju. Možete primeniti jedan režim na svaku 
masku, ali ne možete da menjate režim maske tokom vremena.  

Prva maska koju kreirate utiče na alfa kanal sloja. Ako taj kanal ne definiše celokupnu sliku kao 
neprozirnu, tada maska interaguje sa layer frame-mom. Svaka dodatna maska koju stvorite u 
interakciji je sa maskama koje se nalaze iznad nje u panelu Timeline.  

Rezultati modova maski variraju u zavisnosti od režima rada podešenih maski koje se nalaze pri 
vrhu panela Timeline. Možete koristiti samo modove maski između maski u istom sloju. 
Korišćenjem  modova maskiranja možete stvoriti složene maskirane oblike sa više prozirnih 
područja.  

Na primer, možete postaviti mod maske  koji kombinuje maske i postavlja neprozirno područje 
na ona područja maske se presecaju. 
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Ako pažljivo pogledate televizor, verovatno ćete videti da se delovi ekrana i dalje pojavljuju oko 
ivica maske. Ove greške će sigurno privući neželjenu pažnju i one moraju biti sređene. Da biste 
ih popravili, izmenićete ravne linije u suptilne krivine. 

 

Izrada zakrivljenih maski  
 
Zakrivljene ili slobodne maske koriste Bezier krivulje za definisanje oblika maske. Bezier krivulje 
vam daju najveću kontrolu nad oblikom maske. Pomoću njih možete direktno da kreirate linije 
sa oštrim uglovima, savršeno glatke krivine ili kombinacije ova dva.  

1. U panelu Timeline izaberite Mask 1, masku za sloj Watching_TV.mov. Ako odaberete Mask 1, 
maska je aktivna i takođe bira sve vrhove. 

2. Na ploči sa alatkama izaberite alatku Convert Vertex tool, koja je skrivena iza Pen alatke. 
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3. U Composition panelu kliknite bilo koji vrh. Alat Convert Vertex menja ugaone vrhove u glatke 
tačke. 

 

 

4. Prebacite se na Selection alat, kliknite bilo gde u panelu Composition da biste poništili izbor 
maske, a zatim kliknite prvu tačku (vertex) koju ste kreirali. 

Dve ručice pružaju se od glatke tačke. Ugao i dužina ovih ručica kontrolišu oblik maske.  

5. Prevucite desnu ručicu prvog vrha oko ekrana. Primjetite kako to menja oblik maske. 

 Kliknite na vertex       Povucite ručicu 

6. Jednom kada udobno pomerate ručke, postavite ručicu u gornju levu stranu vertex-a kao na 
prethodnoj slici. Kao što ste videli, možete da kreirate veoma tečne oblike. 

Savet  
Ako pogrešite, pritisnite Ctrl + Z da biste poništili poslednju radnju. Takođe možete promeniti 
nivo zuma i upotrebiti alat Hand da tokom rada postavite sliku u  Composition panelu. 
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Savijanje ručica smera  
Podrazumevano su ručke pravca glatke tačke povezane linijom jedna s drugom. Kako pomerate 
jednu ručicu, tako se pomera i suprotna ručica. Međutim, možete prekinuti ovu vezu da biste 
stekli veću kontrolu nad oblikom maske i možete da stvorite oštre tačke ili dugačke, glatke 
krivine.  

1. Izaberite alatku Convert Vertex na ploči sa alatkama. 

2. Povucite desnu ručicu gornjeg levog vertex-a. Leva ručica smera ostaje nepomičana. 

3. Podesite ručicu u pravom smeru sve dok gornji segment maske ne počne pratiti oblik  
televizora u tom uglu. Ne mora biti savršeno. 

4. Povucite levu ručicu istog vertex-a dok levi segmenti oblika ne počne preciznije da prati krivu 
televizora u tom uglu. Prevucite desnu ručicu gornjeg levog vrha, a zatim levu ručicu da sledite 
krivu TV ekrana. 

Savet  
Opet, možda ćete morati da prilagodite svoj pogled na kompoziciji tokom rada. Možete prevući 
sliku pomoću alata Hand. Da biste privremeno prešli na Hand alata, pritisnite i zadržite 
spacebar.  

5. Za svaku od preostalih tačaka u uglu kliknite alatku Convert Vertex, a zatim ponovite korake 
2–4 dok oblik maske ne odgovara zakrivljenosti televizora. Ako morate pomeriti ugaonu tačku, 
koristiti Selection alat. 

6. Kada završite, poništite odabir Watching_TV.mov sloja u Timeline panelu da biste proverili 
ivicu maske. Ne bi trebalo da vidite nijedan deo TV ekrana. 

 

7. Izaberite File > Save da biste sačuvali svoj rad. 

Kreiranje Bezierove maske  
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Koristili ste alatku Convert Vertex da promenite ugaoni vrh u glatku tačku sa Bezier ručkama, ali 
mogli ste da stvorite Bezier masku u prvom trenutku. Da biste to učinili, kliknite na panel 
Composition sa alatkom olovke tamo gde želite stavite prvi vrh. Zatim kliknite gde želite da 
postavite sledeću tačku, i povucite u pravcu u kojem želite da kreirate krivu. Kada ste zadovoljni 
sa krivom, otpustite taster miša. Nastavite da dodajete tačke dok ne kreirate oblik koji želite. 
Zatvorite masku klikom na prvi vrh ili dvostrukim - klikom na poslednji vertex. Zatim pređite na 
Selection alat da biste pročistili masku.  

Feathering ( omkešavanje ) ivice maske  
Maska izgleda dobro, ali je potrebno da malo omekšate ivice.  

1. Izaberite Composition> Composition Settings. 

2. Kliknite na polje Background Color i izaberite belu boju pozadine (R = 255, G = 255, B = 
255). Zatim kliknite na OK da biste zatvorili alat za odabir boja i ponovo OK da biste zatvorili 
Dijalog  Composition Settings. Bela pozadina vam omogućuje da vidite da rub TV ekrana 
izgleda previše oštro i nerealno. Da biste to rešili, ivice ćete ublažiti ili omekšati. 

3. Izaberite sloj Watching_TV.mov u panelu Timeline i pritisnite taster F da biste se prikazali 
svojstvo Mask Feather za masku. 

4. Povećajte Mask Feather na 1,5, 1,5 piksela 

5. Sakrijte svojstva za sloj Watching_TV.mov, a zatim izaberite File > Save da biste je sačuvali 
svoj rad. 

Zamena sadržaja maske  
Sad ste spremni da zamenite pozadinu video klipom sa morskom kornjačom i ubacte u završni 
snimak.  

1. Na panelu Project odaberite datoteku Turtle.mov i prevucite je u Timeline panel ispod layer-a 
Watching_TV.mov. 
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2. Izaberite Fit Up To 100% iz pop-up menija Magnification Ratio na dnu Composition panela 
tako da možete videti celu kompoziciju. 

3. Izaberite alatku Selection, a zatim prevucite sloj Turtle.mov u Composition panel dok se tačka 
sidra ne centrira u TV ekran. 

Zumiranje i pomicanje dodirom  

Ako koristite uređaj koji podržava dodir, kao što je Microsoft Surface, Vacom Touch ili trackpad 
sa više dodira, možete koristiti prste za zumiranje i pomeranje. Pokreti dodirom omogućavaju 
vam zumiranje i pomeranje kompozicije, sloja, snimka, i Timeline panela.  

Da biste zumirali: Približite dva prsta bliže jednom za zumiranje ili ih udaljite jadan od drugog za 
udaljavanje  

Za pomicanje: Pomerite dva prsta zajedno da biste se pomerali prema gore, dole, levo ili desno 
u trenutnom panelu.  

Premeštanje i promena veličine snimka  
Klip morske kornjače je prevelik za TV ekran, pa ćete mu promeniti veličinu preko 3D sloja. Što 
vam daje veću kontrolu nad njegovim oblikom i veličinom.  

1. Sa slojem Turtle.mov odabranim u panelu Timeline, kliknite na 3D prekidač za sloj. 

2. Pritisnite taster P da biste prikazali Position svojstva layer-a Turtle.mov. 
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Svojstvo Position za 3D sloj ima tri vrednosti: s leva na desno, oni predstavljaju x, y i z osu slike. 
Osa z kontroliše dubinu sloja. Možete da vidite ove ose predstavljene u Composition panelu. 

3. Uverite se da je izabran Selection alat , a zatim postavite pokazivač u Composition panelu 
preko crvene strelice, tako da se pojavljuje malo x. Crvena strelica upravlja x (horizontalnom) 
osom sloja. 

4. Povucite levo ili udesno ako je potrebno da biste isečak vodoravno centrirali na ekranu 
monitora. 

5. Postavite pokazivač na Composition panel preko zelene strelice tako da se malo y pojavi. 
Zatim povucite prema gore ili dole ako je potrebno da biste isečak uspravno postavili na ekran 
monitora. 

6. Postavite pokazivač na Composition panel preko plave kocke na kojoj se crvena i zelene 
strelice susreću  i tada se pojavljuje malo z. Zatim povucite prema dole i udesno da povećate 
dubinu polja, tako da se sloj Turtle.mov čini manji. 

7. Nastavite da vučete ose x, y i z sve dok se ceo isečak ne uklopi u TV ekran, kao prikazano 
na sledećoj slici. Naše poslednje vrednosti x, y i z su otprilike 390, 146, 825. 

 

Savet  
Takođe možete da unesete vrednosti pozicije direktno u Timeline panelu umesto  prevlačenja u  
Composition panelu. 

Video klip se bolje uklapa, ali morate ga malo okrenuti da biste poboljšali perspektivu.  

1. Izaberite sloj Turtle.mov u Timeline panelu i pritisnite taster R da biste otvorili Rotation 
svojstva (rotacije). Ponovo, s obzirom da se radi o 3D sloju, možete kontrolisati rotaciju na osi x, 
y i z. 
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2. Promenite vrednost X rotacije na 1 stepen, a vrednost Y rotacije na –40 stepeni. Ovo okreće 
sloj da odgovara perspektivi TV ekrana. 

3. Promenite vrednost Z rotacije u 1 stepen da biste sloj poravnali sa TV ekranom. 

 

Vaša kompozicija sada treba da podseća na prethodnu sliku.  

4. Sakrijte svojstva za sloj Turtle.mov, a zatim izaberite File > Save da biste sačuvali svoj rad. 

 

Dodavanje refleksije  
 

Maskirana slika izgleda ubedljivo, ali dodavanjem odraza na TV ekran možete je učiniti još 
realnijom. 

 

1. Kliknite prazno područje  u Timeline panelu da biste poništili odabir svih slojeva, a zatim 
odaberite Layer> New > Solid. 

 

2. U dijalogu Solid Settings imenujte layer Reflection , kliknite na Make Comp Size dugme, 
promenite Color u belu, a zatim kliknite na dugme OK. 
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Umesto da pokušavate da tačno obnovite oblik maske Watching_TV.mov, lakše je kopirati je u 
sloj Reflection.  

3. Izaberite sloj Watching_TV.mov u panelu Timeline i pritisnite taster M da se prikaže svojstvo 
Mask Path za masku. 

4. Izaberite Mask 1, a zatim izaberite Edit > Copy ili pritisnite Ctrl + C. 

5. Izaberite sloj Reflection u panelu Timeline, a zatim izaberite Edit> Paste ili pritisnite Ctrl + V 

 

 

 

 

 

 

 

Ovog puta želite da površinu unutar maske zadržite neprozirnom i da prostor van teme zadržite 
prozirnim.  

6. Izaberite sloj Watching_TV.mov, a zatim pritisnite U da biste sakrili svojstva maske. 

7. Odaberite sloj Reflection u panelu Timeline, i pritisnite taster F da biste otkrili Mask 1 Mask 
Feather podešavanja za layer. 

8. Promenite vrednost Mask Feather na 0 . 
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9. Poništite odabir opcije Inverted. Sloj Reflection sada zamračuje Turtle.mov sloj. 

 

10. Povećajte prikaz da biste videli ekran,  a zatim izaberite alat Mask Feather , 
sakriven ispod Convert Vertex alata na ploči sa alatkama. 

Kada istanjujete masku, širina feather-a je ista oko cele maske. Alat Mask Feather omogućava 
vam da promenite širinu istanjivanja u tačkama koje odredite na zatvorenim maskama. 

 

11. Kliknite sloj Reflection u panelu Timeline da biste ga izabrali. Zatim kliknite donji levi deo 
vertex-a da kreirate feather tačke. 

 

12. Ponovo kliknite feather tačku i bez puštanja dugmeta miša povucite feather tačku i usmerite 
prema unutra tako da se odražava samo sredina ekrana i feather tačka je postavljena kao što je 
prikazano na slici ispod. 

 

 

 

 

 

 

 

Trenutno se feather ravnomerno proteže preko maske. Dodaćete još tačaka za feather radi 
veće fleksibilnosti. 

13. Kliknite na sredinu vrha maske da biste stvorili još jednu feather tačku. Zatim prevucite 
feather blago prema dole, u masku. 

14. Kliknite desnim tasterom miša ili držite Control, a zatim kliknite feather tačku koju ste upravo 
stvorili i izaberite Edit Radius. Promenite Radijus na 0 i kliknite na OK. 
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Ovo je dobar početak, ali se stranice naglo savijaju. Na to ćete dodati još feather tačaka da 
promenite ugao.  

15. Dodajte još jednu feather tačku klikom na levu ivicu TV-a, otprilike jednu trećinu od vrha. 

16. Dodajte sličnu feather tačku na desnoj strani. 

 

 

 

 

 

 

 

Oblik refleksije je dobar, ali zamračuje sliku. Promenite neprozirnost da umanji njegovo dejstvo.  

17. Izaberite Reflection sloj u Timeline panelu, a zatim pritisnite taster T da biste otvorili Opacity 
svojstvo. Promenite njegovu vrednost na 10%. 

18. Pritisnite T da biste sakrili svojstvo Opacity, a zatim pritisnite F2 ili kliknite prazno područje u 
panelu Timeline da deselektujete slojeve. 

 

Primena režima mešanja  ( Blending ) 
Da biste stvorili jedinstvene interakcije između slojeva, možda biste želeli da eksperimentišete 
sa Blending modovima.  

Načini mešanja kontrolišu kako se svaki sloj meša sa slojevima ispod njega ili reaguje na njih. 

Režim Blending za slojeve u After Effects identičan je načinima miješanja u Adobe-u Photoshop.  
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1. Na meniju panela Timeline odaberite Columns > Modes kako biste prikazali pop-up prozor 
Mode meni. 

2. Izaberite Add iz pop-up menija Reflection. 

 

 

 

 

 

 

 

Ovo stvara čvrst odsjaj na slici TV ekrana i pojačava boje ispod njih.  

3. Izaberite File > Save da biste sačuvali svoj rad. 

 

Rad da Photoshop-om i After Effects 
 

Adobe After Effects pruža nekoliko alata i efekata koji vam omogućavaju da simulirate video 
zapis pomoću Photoshop fajla.  

After Effects čuva redosled slojeva, podatke o transparentnosti i stilove slojeva iz izvornog fajla 
Photoshop-a. Takođe zadržava i druge karakteristike, kao što su slojevi za podešavanje i tip, 
koje ne koristite u ovom projektu.  

O stilovima  Photoshop layer-a ( slojeva ) 
Adobe Photoshop nudi različite stilove slojeva - kao što su senke, sjaj, i nagibi - koji menjaju 
izgled sloja. After Effects može sačuvati ove stilove slojeva kada uvezete Photoshop slojeve. 
Takođe možete da namestite stilove slojeva u After Effects.-u .Iako se stilovi slojeva u 
Photoshopu nazivaju efektima, oni se ponašaju više poput blending (mešanja) modova u After 
Effects. Stilovi slojeva prate transformacije po standardnom redosledu prikazivanja, dok efekti 
prethode transformacijama. Druga razlika je u tome što se svaki stil sloja direktno meša sa 
narednim slojevima u kompziciji, dok se efekat primenjuje samo na sloj na koji je nanesen. 
Rezultat toga je da takav sloj stupa u interakciju sa ostalim slojevima kao celina. Svojstva stila 
sloja dostupna su za sloj u panelu Timeline. 
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O solid-color layer-ima  (sloj čiste boje) 

 

Možete da kreirate slike bilo koje boje ili veličine (do 30.000 x 30.000 piksela) u After Effects-u. 
After Effects tretira solid-color layer-e kao i bilo koji drugi snimak: Možete da modifikujte masku, 
transformišite svojstva i primenite efekte na solid-color layer-u.  Upotrebite solid-color layer-a da 
biste obojili pozadinu ili stvorili jednostavne grafičke slike. 

 

Video FX  
 

After Effects poseduje veliki broj efekata koji se mogu primenjivati. 

Efekat Fractal Noise, Directional Blur   

Efekat Fractal Noise se može koristiti da se stvori nalet vetra.  

Efekat Directional Blur stvoriće zamagljivanje u pravcu u kome nešto leti.  

1. Na panelu Effects & Presets potražite efekat Fractal Noise; to je u Noise & Grain kategoriji. 
Dvaput kliknite efekat Fractal Noise da biste ga primijenili. 

2. U panelu Effect Controls uradite sledeće: 
• Odaberite Smeer za Fractal Type.  
• Izaberite Soft Linear za Noise Type.  
• Podesite Contrast na 700.  
• Podesite Brightness na 59.  
• Proširite svojstva Transform i postavite Scale na 800.  

3. Kliknite štopericu pored Offset Turbulence da biste stvorili početni keyframe na početaku 
merača vremena. 

4. Idite na 2:00 i promenite vrednost k za Offset Turbulence na 20 000 pk. 
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5. Sakrijte Fractal Noise svojstva  u Effect Controls panelu . 

6. U Effects & Presets potražite efekat Directional Blur, a zatim ga dvo-kliknite da biste ga 
primijenili. 

7. U Effect Controls panelu postavite pravac na 90 stepeni, a dužina zamućenja na 236. 

 

 

 

 

 

 

Stvorili ste osećaj pokreta. 

 

Korekcija boje (color correction) 

 

Većina snimaka zahteva određenu korekciju boje. Sa Adobe After Effects, možete lako ukloniti 
boje, osvetliti slike i promeniti atmosferu snimka.  

Kao što pojam implicira, korekcija boje je način promene ili prilagođavanja boje snimljene slike.  

Strogo govoreći, korekcija boje je čin prilagođavanja boja na snimku, da bi se ispravile greške u 
balansu i white exposure (ekspozicija bele), kao i da se osigura konzistentnost boja od jednog 
do drugog  kadra.  

Međutim, možete koristiti iste alate i tehnike za color grading (nijansiranje).   
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Color grading pretstavlja tehniku subjektivne manipulacije bojom da bi se pažnja usmerila na 
ključne elemente u kadru ili stvorila paleta boja za tačno određeni vizuelni izgled. 

Podešavanje ravnoteže boja s nivoima  
 

After Effects nudi nekoliko alata za korekciju boje. Neki mogu obaviti posao s jednim klikom, ali 
razumevanje ručnog načina  podešavanja boja daje vam najveću slobodu da postignete izgled 
kakav želite.  

Koristićete Levels efekat za podešavanje senki, uklanjanje sloja plave boje. 

Levels efekat (Individual Controls) u početku može biti pomalo zastrašujući, ali  omogućuje 
odličnu kontrolu vašeg snimka. 

Moguće je mapirati raspon nivoa ulazne boje ili alfa kanala na  novi raspon izlaznih nivoa, koji 
funkcionišu slično kao podešavanje nivoa u Adobe Photoshop-u.  

Channel meni određuje kanal koji treba izmeniti, a histogram prikazuje broj piksela sa svakom 
vrednošću osvetljenja na slici. 

 Kad je odabrani kanal RGB, možete da podesite ukupnu svetlost i kontrast slike.  

Da biste uklonili sloj boje, prvo morate znati koja područja slike trebaju biti siva (ili bela ili crna).  

 

 

 

 

 

 

 

 

 

 

 

 

 

Za svaki kanal, postavke unosa povećavaju vrednost, dok postavke izlaza smanjuju vrednost.  

Na primer, spuštanje vrednosti crvene ulazne bele boje dodaje crvenu boju u svetlima, a 
povećanje vrednosti crvenog izlaza bele dodaje crveno senkama ili tamnim područjima na 
snimku. 
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Renderovanje i snimanje 
 
Kad objavljujete svoje kompozicije  možete odabrati  pojedinačni prikaz i podešavanja izlaznog 
modula.  

1. Izaberite kompoziciju izlaska sunca u panelu Project, a zatim izaberite Composition > Add To 
Render Queue. Otvara se panel Render Queue. U zavisnosti od veličine vašeg ekrana, možda 
ćete morati maksimizirajte panel da biste videli sva podešavanja. 

2. (Neobavezno) Dvaput kliknite karticu panela Red Render da biste povećali panel. 

3. Prihvatite zadate postavke Render Settings u Render Queue panelu. Zatim kliknite plave, 
kurzivne reči Not Yet Specified pored iskačućeg menija Output To. 

 

4. Pomerite se do direktorijuma Data/ 03 /Assets i imenute datoteku 03_retime.avi.  Zatim 
kliknite na Save. 

5. Proširite grupu Output Module, a zatim izaberite Import iz Post-Render Action menija. After 
Effects će uvesti datoteku filma nakon što je izrenderuje. 



 

Interreg – IPA CBC Bulgaria – Serbia Programme  

CB007.2.13.212 

 
 

98 
 

 

 

6. Sakrijte odeljak Output Module. 

7. Kliknite na dugme Render u panelu Render Queue. 

After Effects prikazuje traku napretka dok renderuje i izvozi kompoziciju i emituje audio signal 
kada je završeno. Takođe uvozi rezultirajuću datoteku filma u projekat. 

 

8. Kada After Effects završi renderovanje i izvoz kompozicije, dvaput kliknite karticu u Render 
Queue panelu ako ste maksimizirali panel ranije. Zatim kliknite x u Render Queue kartici da 
biste zatvorili Render Queue panel. 

 

Pravljenje obrazaca za red rendera  
U ovoj lekciji ćete kreirati šablone i za podešavanja prikazivanja i za podešavanja izlaznog 
modula. Ovi šabloni su predefinisane vrednosti koje možete da koristite za pojednostavljenje 
podešavanja obrade kada renderujete stvari za isti tip formata isporuke.  

Nakon što ih definišete, šabloni se pojavljuju u Render Queue panelu na odgovarajućem pop-up 
meniju (Render Settings ili Output Module).  

Onda, kada ste spremni da izrenederujete kompoziciju, možete jednostavno da odabere 
odgovarajući šablon za format isporuke koji vaš posao zahteva i šablon automatski primenjuje 
sva podešavanja.  

 

Izrada šablona za podešavanje rendera za probni prikaz  
Napravićete šablon za podešavanja rendera, birajući podešavanja odgovarajuća za prikazivanje 
test verzije vašeg finalnog filma. Probna verzija je manja - i zato se renderuje brže - nego film u 
punoj rezoluciji. Kada radite sa složenim kompozicijama kojima treba relativno dugo vremena za 
renderovanje, dobra je praksa da se prvo napravi mala test verzija. Ovo vam pomaže da 
pronađete bilo koje nepravilnosti koja želite da rešite pre nego što renderujete završni film.  
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1. Odaberite Edit> Templates> Render Settings. Dijalog  Render Settings Templates se 
pojavljuje. 

2. U polju Settings kliknite na New da biste kreirali novi obrazac. 

 

 

 

 

 

 

 

 

 

 

 

3. U dijalogu Render Settings uradite sledeće: 

• Ostavite Quality kao  Best.  
• Za Resolution, izaberite Third, što smanjuje linearnu dimenziju kompozicija do jedne trećine. 

4. U oblasti Time Sampling uradite sledeće:  
• Za Frame Blending izaberite Current Settings.  
• Za Motion Blur izaberite Current Settings.  
• Za Time Span odaberite Length Of Comp. 
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5. U području Frame 
Rate izaberite Use This Frame Rate, i otkucajte 12 (fps). 

Zatim kliknite OK da vratite se na dijalog Rende Settings Templates. 

6. U Settings Name upišite Test_lowres (za malu rezoluciju). 

7. Ispitajte svoja podešavanja koja se pojavljuju u donjoj polovini dijaloga. Ako trebate da 
izvršite bilo kakve promene, kliknite na dugme Edit da biste podesili podešavanja. Zatim kliknite 
na dugme OK. 

 

 

 

 

 

 

 

 

 

 

Opcija Test_lowres biće dostupna u pop-up meniju Render Settings u Render Queue panelu.  

Izrada obrazaca za izlazne module  
Koristićete sličan postupak za kreiranje šablona koji će se koristiti za podešavanje izlaznog 
modula. Svaki šablon izlaznog modula uključuje jedinstvene kombinacije postavki prikladnih za 
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određenu vrsta izlaza. Napravićete onu koja je pogodna za test verziju niske rezolucije filma, 
tako da možete brzo videti renderovanu verziju da identifikujete sve promene koje želite da 
unesete.  

1. Izaberite Edit > Templates > Output Module da biste otvorili dijalog Output Module Templates. 

2. U polju Settings kliknite na New da biste kreirali novi šablon. 

3. U dijalogu Output Module Settings odaberite QuickTime za format. 

4. ZaPost-Render Action izaberite Import.. 

5. U području Video Output (Opcije video izlaza) kliknite Format Options. 

 

 

 

 

 

 

 

 

6. Izaberite sledeća podešavanja u dijalogu sa opcijama QuickTime: 

• Za Video Codec odaberite MPEG-4 Video. Ovaj kompresor automatski određuje dubine boja  

• Podesite klizač Quality na 80.  

• U polju Advanced Settings izaberite Key Frame Every, a zatim otkucajte 30 (frame-ova).  

• U području Bitrate Settings odaberite Limit Data Rate To na i otkucajte 150 (kbps). 
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7. Izaberite karticu Audio i izaberite IMA 4: 1 iz menija Audio Codec. 

8. Kliknite OK da biste zatvorili dijalog sa opcijama QuickTime Options i vratili se u Output 
Module Settings dijalog. 

9. Izaberite Audio Output On iz pop-up menija na dnu dijaloga. Onda izaberite sledeća audio 
podešavanja, s leva na desno: 
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• Rate: 22.050 kHz  
• Use: Stereo  

10. Kliknite OK da biste zatvorili dijalog Settings Output Module. 

 

 

 

 

 

11. U donjoj polovini dijaloga Output Module Templates pregledajte podešavanja, i kliknite na 
dugme Edit ako trebate izvršiti bilo kakve izmene. 

12. Unesite naziv Test_MPEG4 za Settings Name, a zatim kliknite na dugme OK. Sada će ovaj 
izlazni šablon biti dostupan u pop-up meniju Output Module u Render Queue panelu. 

 

 

 

 

Kao što možete očekivati, veća kompresija i niski vrednosti semplovanja zvuka stvaraju manju 
veličinu datoteke, ali oni takođe smanjuju kvalitetu proizvoda.  

Međutim, ovaj šablon male rezolucije je dobar za testiranje filma pre nego što izvršite konačne 
izmene.  

Izvoz pomoću Render Queue 

Sada kada ste napravili šablone za podešavanja rendera i izlazne module, možete ih koristiti da 
izveze test verziju vašeg filma.  

1. Izaberite kompoziciju Desktop u Project panelu i izaberite Composition > Add To Render 
Queue. 
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U panelu Render Queue obratite pažnju na podrazumevana podešavanja u Render Settings i 
Output Module pop-up menijima. Ta podešavanja ćete zameniti kada odaberete šablone niske 
rezolucije.  

2. Izaberite Test_lowres u meniju Render Settings. 

3. Izaberite Test_MPEG4 iz menija Output Module. 

4. Kliknite plave reči pored Output To. 

 

 

 

 

 

 

 

5. U dijalogu Output Movie To pronađite direktorijum Data / 03 i kreirajte  novu fasciklu koja se 
zove Final_Movies: 
• Kliknite na New Folder (Nova fascikla), a zatim ukucajte ime za fasciklu. 

6. Otvorite folder Final_Movies ako već nije otvoren. 

7. Imenujte datoteku Final_MPEG4.mov, a zatim kliknite na Save da biste se vratili u Render 
Queue panel. 

8. Izaberite File > Save da biste sačuvali svoj rad. 

 

 

 

 

 

 

 

 

9. Kliknite na dugme Render u Render Queue panelu. After Effects prikazuje film. Ako je u redu 
bilo dodatnih filmova - ili isti filma sa različitim podešavanjima - After Effects će to takođe 
izrenderovati. 

Kada je obrada završena, film Final_MPEG4 pojavljuje se na panelu Project.  
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Da biste pregledali film, dvokliknite ga na panelu Project, a zatim pritisnite spacebar da biste 
pogledali film.  

Ako trebate da izvršite bilo kakve poslednje promene filma, ponovo otvorite kompoziciju i 
napravite nova podešavanja. Ne zaboravite da sačuvate svoj posao kada završite, a zatim 
izvezite test video ponovo koristeći odgovarajuća podešavanja. Nakon pregleda test filma i 
pravljenja bilo koje potebne izmene, nastavite sa eksportovanjem filma za emitovanje u punoj 
rezoluciji. 

O kompresiji  
Kompresija je neophodna za smanjenje veličine filmova tako da mogu da se jednostavnije 
čuvaju, prenose i efektivno reprodukuju. Prilikom izvoza ili renderovanja filma za reprodukciju na 
određenoj vrsti uređaja na određeno bit rate-u ( propusnoj moći ), vi birate kompresor / 
dekompresor (takođe poznat kao koder / dekoder), ili kodek, za komprimovanje informacija i 
kreiranje datoteke koja je čitljiva toj vrsti uređaj u tom bit rate-u.  

Na raspolaganju je širok spektar kodeka; nijedan kodek nije najbolji za sve situacije. Na primer, 
najbolji kodek za komprimiranje animacije iz crtanih filmova uglavnom nije efikasan za 
komprimovanje video zapisa uživo.  

Kada komprimujete datoteku filma, vi ga može fino podesiti za najkvalitetniju reprodukciju na 
računaru, video rekorderu, internetu ili DVD plejeru.  

U zavisnosti od toga koji koder koristite, možda ćete moći smanjiti veličinu komprimovanih 
datoteka uklanjanjem artefakata koji ometaju kompresiju, kao što je nasumično kretanje 
kamere.  

Kodek koji koristite mora biti dostupan celoj vašoj publici. Na primer, ako vi koristite hardverski 
kodek na kartici za grebovanje, vaša publika mora imati  instaliranu kartica za grebovanje ili 
softverski kodek koji je oponaša.  

Priprema filmova za mobilne uređaje  
Možete da kreirate filmove u After Effects-ima za reprodukciju na mobilnim uređajima, kao što 
su tableti i pametni telefoni. Da biste prikazali svoj film, dodajte kompoziciju u Adobe Media 
Encoder, red za kodiranje i izaberite odgovarajući uređaj- posebna podešavanja kodiranja.  

Za najbolje rezultate uzmite u obzir ograničenja mobilnih uređaja tokom snimanja filma i rada sa 
After Effects-om. Za malu veličinu ekrana obratite pažnju na osvetljenje i koristite nižu brzinu 
kadrova. 

Prikazivanje filmova pomoću Adobe Media Encoder-a  
Vaš film je spreman za krajnju produkciju. Adobe Media Encoder, koji se instalira kada vi 
instalirate After Effects, ima najširi izbor kodeka koji su dostupni za različite formate, uključujući 
popularne video usluge kao što je YouTube.  

Renderovanje filma sa visokim  kvalitetom emitovanja  
Prvo ćete izabrati podešavanja da biste film prikazivali u kvalitetu pogodnom za emitovanje.  
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1. Na panelu Project izaberite kompoziciju Desktop i izaberiteComposition > Add To 
Adobe Media Encoder Queue. 

After Effects otvora Adobe Media Encoder i dodaje vašu kompoziciju sa podrazumevanim 
podešavanjima rendera .  

 

 

 

 

 

 

 

 

 

 

 

2. Kliknite plavu vezu u koloni Preset. 

 

 

 

 

 

Adobe Media Encoder povezuje se na Dynamic Link server, što može potrajati nekoliko 
trenutaka.  

3. Kada se pojavi dijalog Export Settings, izaberite H.264 iz menija „Format“ i a zatim izaberite 
HD 1080p 23.976 iz menija Preset. 

 

 

 

 

Renderovanje  kompletnog filma uz prethodno podešenu HD 1080p 23.976 može trajati 
nekoliko minuta.  
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Možete da promenite podešavanja da biste prikazali samo prvih pet sekundi filma tako da 
možete da ga proverite kvalitet.  

Možete da promenite opseg  korišćenjem vremenskog merača na dnu Export Settings dialog 
okvira. 

4. Pomerite indikator trenutnog vremena na 5:00, a zatim pritisnite dugme Set Out Point  na 
levo od pop-up menija Select Zoom Level. 

 

 

 

 

 

5. Kliknite na dugme OK da biste zatvorili dijalog Export Settings. 

6. Kliknite plavu vezu u koloni Output File. Nazovite film HD-test_1080p.mp4, i odredite fasciklu 
Data / 03 / Final_Movies. Zatim kliknite na Save ili OK. 

  

 

 

 

 

 

Dodavanje još jednog unapred podešenog kodiranja u red  
Adobe Media Encoder dolazi sa desetinama ugrađenih predeseta pogodnih za izvoz za 
tradicionalni emitovanje, mobilne uređaji i veb. Isporučićete verziju kompozicije spremnu za 
postavljanje na YouTube.  

1. Na panelu Preset Browser idite na Web Video > YouTube > YouTube 480p SD Wide. 
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2. Prevucite unapred podešeni YouTube 480p SD Wide na kompoziciju Desktop u Queue 
panelu. 

Adobe Media Encoder dodaje još jednu izlaznu stavku u red.  

 

 

 

 

 

 

 

 

 

 

 

 

3. Kliknite plavu vezu u koloni Output File za stavku koju ste upravo dodali. Zatim imenujte  
datoteku Final_Web.mp4, odredite fasciklu Data / 03 / Final_Movies i kliknite na Save ili OK 

 

 

 

 

 

 

Prikazivanje filmova  
Postavljali ste dve verzije filma u redu čekanja. Sada ćete ih renderovati i pregledati.  

Renderovanje zahteva puno resursa i može potrajati neko vreme, u zavisnosti od vašeg 
sistema, složenosti i dužina kompozicije i podešavanja koja koristite.  

1. Kliknite zeleno dugme Start Queue(>) u gornjem desnom uglu ploče čekanja. 

Adobe Media Encoder kodira filmove u queue istovremeno, prikazujući status bar i vrednosti  
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preostalog vremena.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Kada je Adobe Media Encoder završen, idite u folder Final_Movies i dvaput kliknite na 
datoteke da biste ih reprodukovali. 

 

Prečice 

 
Organizovanje slojeva (layer-a)  

idi do in tačka layer-a i 

idi do out tačke layer-a o 

Namesti in ili out tačku [] 

trim in ili out tačku option + [ /option +] 

Namesti in ili out tačku razvlačenjem vremena cmd +shift +,    
cmd+ option +    

Pomeri izabran frame 1 frame ranije,kasnije option +page up, 
cmd +page down 

izaberi sledeći / prethodni layer cmd+donja strelica ili 

idi napred 1 frame page  up ili    
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cmd+ desna strelica 

idi unazad 1 frame  page  up ili    
cmd+ leva strelica 

unazad / napred 10 frame-ova page  up + shift ili    
cmd+ leva/desna strelica + shift 

Svojstva layer-a i navigacija 

proširiti opacity svojstvo t 

proširiti position svojstvo p 

proširiti scale  svojstvo s 

proširiti effects svojstvo e 

Prikaži samo svojstva sa keyframe-ovima u 

prikaži/skloni sva svojstva layer-a ctrl  +  `    

dodati / ukloni keyframe u Trenutni vreme option +  shift  + property    

pomeri keyframe 1 frame kasnije, ranije option +  left  /  right  arrow    

pomeri keyframe 10 frame-ova kasnije, ranije option   +  shift  +  left  /  right  arrow    

pomeri izabrani sloj 1 piksel arrow  keys (strelice)   

modifikuj vrednost podešavanja za 10 drag  +   shift    

modifikuj vrednost podešavanja za 1/10 (0.1) drag  +   ctrl    

idi do prethodni / sledeći vidljivi keyframe j  /  k    

Alati 

aktiviraj selection  alat v 

privremeno aktiviraj  hand  alat  spacebar    

aktiviraj Zum in  alat Z 

aktiviraj Zum out alat ( kada zum je aktivan ) option 

aktiviraj Rotation alat w 

aktiviraj i prođi kroz camera alate c 
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DRON 

Uvod  
DJI Mavic 2 Pro / Zoom odlikuje se svesmernim Vision sistemima i infracrvenim senzorima. 
Jednostavno snimanje složenih snimaka omogućuju specijalizovane DJI tehnologije kao što su 
Obstacle Sensing i Inteligentni modovi letova poput Hiperlapse, Tačka interesa, ActiveTrack TM 
2.0, TapFly, QuickShots i Napredni pilotski sistemi za pomoć (APAS).  

Mavic 2 Pro odlikuje se potpuno stabilizovanim sa tri-ose gimbal sistemom sa CMOS senzornom 
kamerom od 1 ".  

Kameru su zajedno razvili DJI i Hasselblad. Kamera snima 4K video zapise, fotografije od 20 
megapiksela i podržava filtere.  

Mavic 2 Zoom odlikuje se potpuno stabilizovanom tro-osnom gimbal kamerom koji snima 4K 
video, 12 megapiksela fotografije, podržava 2k optički zum, objektiv 24-48 mm i podržava filtere. 

Mavic 2 Pro / Zoom koristi najnoviju tehnologiju za povećanje stabilnosti i kvaliteta snimka, 
smanjujući opseg vibracije ugla Mavic 2 do ± 0,005 ° i opseg vibracija Mavic 2 Pro ugaonog 
opsega ± 0,01 °.  

U daljinski upravljač ugrađena je DJI-jeva tehnologija daljinskog prenosa OCUSINC TM 2.0, koja 
nudi maksimalni domet prenosa od 5 mi (8 km) i prikazivanje videa iz letelice do DJI GO 4 na vaš 
mobilni uređaj rezolucijom do 1080p.  

Daljinski kontroler radi i na 2,4 GHz i na 5,8 GHz i može da bira najbolji kanal prenosa automatski 
bez ikakvih kašnjenja. 

Letelica  i kamera mogu lako da se kontrolišu pomoću dugmića na uređaju. Ugrađeni LCD ekran 
prikazuje podatke i informacije o letelici u realnom vremenu, a odvojive upravljačke palice 
olakšavaju skladištenje daljinskog upravljača.  

Maksimum vreme korišćenja je 2 sata i 15 minuta.  

Mavic 2 Pro / Zoom ima maksimalnu brzinu leta od 44,7 mph (72 km / h) i maksimalno vreme leta 
31 minut. 

Daljinski upravljač dostiže svoj maksimalni put prenosa (FCC) u široko otvorenom prostoru bez 
elektromagnetskih smetnji na nadmorskoj visini od oko 120 m.  

Maksimalno vreme izvođenja je testirano u laboratorijskom okruženju. Ove vrednosti su samo za 
referencu.  

5.8 GHz nije podržan u nekim regionima. Potrebno je pridržavanje se lokalnim zakonima i 
propisima. 
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Priprema letelice  

 
Svi krakovi letelice su savijeni u fabričkom pakovanju. Sledite dole navedene korake do otklopite 
letelicu.  

1. Uklonite zaštitni poklopac sa fotoaparata. 

2. Odvijte prednje krake, a zatim odvijte stražnje krake. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

* Pričvrstite zaštitni poklopac kada se ne koristi. 

1) Držite gimbal na mestu i umetnite klipnu stezaljku između letelice i gimbala. 

2) Proverite da li su kuke na Gimbal mehanizmu zatvorene u ležištu letelice, a zatim spustite 
Gimbal zaštitnik preko trake i osigurajte kopčom. Kopča će kliknuti kad bude sigurno vezana. 
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3. Pričvršćivanje propelera. 

Pričvrstite propelere sa belim tragovima na motore obeležene belom bojom. Pritisnite propeler na 
dole na motor i okrećite ih dok nisu učvršćeni. Ostale propelere pričvrstite na neobeležene 
motore.  

Raširi sve oštrice propelera. 
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Pre otklopa stražnjih krakova rasklopite prednje krakove i propelere. Normalno je ako dolazi do 
trenja na krakovima i letelici zbog čvrsto sklopivog dizajna letelica Mavic 2 Pro / Zoom. 

Obavezno uklonite zaštitne trake i uklonite sve sa krakova i propelera pre uključivanja letelice. 

U suprotnom, to može uticati na samodijagnostiku letelice. 

4. Sve baterije za inteligentno letenje su u stanju hibernacije pre isporuke da bi se osigurala 
sigurnost. Koristiti obezbeđen ispravljač za naizmeničnu struju za prvo punjenje i aktiviranje 
Inteligentnih Letnih Baterija. Da bi  napunili inteligentnu bateriju nakon leta, izvadite je iz letelice i 
priključite na ispravljač za napajanje. 

 

 

 

 

 

 

 

 

Vreme punjenja: 

 

~ 1 sat 30 minuta 
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Priprema daljinskog upravljača  
 

1. Odvijte stezaljke i antene za mobilne uređaje. 

2. Izvadite upravljačke palice iz njihovih ležišta na daljinskom upravljaču i umetnite ih mesto. 

 

 

 

 

 

 

 

 

 

3. Izaberite odgovarajući RC kabl na osnovu vrste mobilnog uređaja. Kabl sa strelom konektor je 
podrazumevano povezan na klizač kabla. Micro USB i USB-C kablovi takođe su uključeni u 
pakovanje. Priključite kraj RC kabla u svoj mobilni uređaj. Osigurajte svoj mobilni uređaj guranjem 
obe stezaljke prema unutra. 
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Pogledajte donju sliku kako biste zamenili RC kabel. Klizač RC kabla mora biti zamenjen ako se 
koristi USB-C RC kabl. 

Takođe možete povezati svoj mobilni uređaj sa daljinskim upravljačem pomoću USB kabla, ako 
je mobilni uređaj prevelik da bi se mogao ubaciti u stezaljke. Priključite jedan kraj kabla u svoj 
mobilni uređaja i drugi kraj u USB priključak na dnu daljinskog upravljača. Ne koristite Micro USB 
i USB portove istovremeno za povezivanje video zapisa. Izvadite kabl sa jednog porta pre 
povezivanja uređaja s drugim portom za povezivanje video zapisa. 

 

Dijagram letelice 
 

1. Prednji Vision Sistem 

2. Propeleri 

3. Motori 

4. Prednje LED diode 

5. Antene 

6. Gimbal i kamera 

 

7. Zadnji Vision Sistem 

8. Pokazatelj statusa 
letelice 
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9. Kopče za baterije 

10. Bočni Vision Sistem 

11. USB-C priključak 

12. Dugme za vezu/ Status 
povezivanja  

 

 

13. LED indikatori za nivo 
baterije 

14. Dugme za napajanje 

15. Inteligentna baterija za let 

16. Gornji infracrveni 
senzorski sistem 

 

 

 

 

 

17. Donji Vision Sistem 

18. Slot za microSD kartice 

19. Donji infracrveni 
senzorski Sistem 

20. Pomoćna donja svetlost 
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1. Antene 

Relejno upravljanje letelicom i bežični 
video signal. 

 

2. Dugme za povratak kući 

ReturnToHome (RTH) 

Pritisnite i držite dugme za pokretanje 
RTH. Letelica se vraća u poslednju 
snimljenu matičnu poziciju. Ponovo 
pritisnite da biste otkazali RTH.  

 

3. LCD ekran 

Prikazuje letelicu i status daljinskog 
upravljača sistema.  

 

4. Uklonjive upravljačke palice Uklonjive upravljačke palice se jednostavno skladište. Zadana 
kontrola leta postavljena je na režim 2. Podesite režim kontrole leta u DJI GO 4. 

 

5. Dugme "Pauziranje leta" 

Pritisnite da biste zaustavili letelicu i lebdili na mestu (samo kada su GPS ili Vision sistem  
dostupni). Dugme za pauzu za let ima različite funkcije u različitim Inteligentnim modovima 
letenja. Za detalje pogledajte Intelligenti Režim leta.  

 

6. Mesto za skladištenje upravljačkih ručica 

Za odlaganje kontrolnih palica. 

 

7. Stezaljke za mobilne uređaje 

Sigurno montirajte svoj mobilni uređaj na daljinski upravljač. 

 

8. Rezervni priključak za video vezu (USB) 

Povežite se sa mobilnim uređajem za video vezu putem standardnog USB kabla. 
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9. 5D dugme 
Podrazumevana konfiguracija 
je navedena dole. 
Konfiguracija se može 
podesiti na osnovu vaše 
postavke u DJI GO 4. 

Levo: Smanjite EV vrednost.  

Desno: Povećajte vrednost 
EV.  

Gore: Usmeri gimbal / gimbal 
nadole.  

Na dole: Usmeri gimbal / gimbal prema dole.  

Pritisnite dole: Povezuje DJI GO 4 meni za Intelligenti Režim leta. 

10. Prekidač za režim leta 
Prelazite između S-režima, P-režima i T-mod. 

11. Dugme za napajanje 
Pritisnite jednom da proverite trenutnu bateriju nivo. Pritisnite jednom, a zatim ponovo i držite 
uključite / isključite daljinski upravljač. 

12. Taster C1 (prilagodljiv)  
Podrazumevana konfiguracija je fokusiranje na sredini. Prilagodite konfiguraciju na osnovu DJI 
GO 4 po vašim željama. 

13. Gimbal Dial 
Kontroliše nagib kamere 

14. Video izlaz / priključak za napajanje (mikro USB) 
Povežite se sa mobilnim uređajem za video povezivanje preko RC kabla. Povežite se sa AC 
napajanjem za punjenje baterija daljinskog upravljača. 

15. Dugme za snimanje  
Pritisnite za početak snimanja video zapisa. Pritisnite ponovo da biste stali sa snimanjem. 

16. Dugme za fokusiranje / okidanje 
Pritisnite na pola da biste automatski fokusirali. Pritisnite jednom da biste uslikali fotografije u 
skladu sa režimom odabranim u DJI GO 4. 

17. Brojčanik za podešavanje blende / okidača (Mavic 2 Pro)  
Okrenite kotačić da biste podesili kompenzaciju ekspozicije (kada je u programskom režimu), 
otvor blende (kada je u režimu prioriteta blende i ručnom režimu) ili zatvarač (u režimu prioriteta 
zatvarača). 
17. Brojčanik za podešavanje zuma (Mavic 2 zum) 
Okrećite za podešavanje zuma Mavic 2 Zum kamere. 
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18. Dugme C2 (prilagodljivo) 
Zadana konfiguracija je reprodukcija. Podesite konfiguraciju u DJI GO 4 na osnovu vaših 
sklonosti. 

 

Aktivacija  
Mavic 2 Pro / Zoom zahteva aktiviranje pre prve upotrebe. Pratite vodič na ekranu da biste ga 
aktivirali Mavic 2 Pro / Zoom pomoću DJI GO 4. 

Letelica 
Ovaj odeljak predstavlja let kontroler za letenje, inteligentna bateriju leta i Prednji, Zadnji i Donji 
Vision Sistem. 

Mavic 2 Pro / Zoom sadrži kontroler leta, sisteme vida, sistem za preuzimanje video signala, 
pogonski sistem i inteligentna bateriju leta. Pogledajte dijagram letelicaa u odeljku Profil 
proizvoda. 

Modovi letenja  
Mavic 2 Pro / Zoom ima tri načina leta, plus četvrti režim leta u koji se letelica prebacuje određene 
okolnosti:  

P-mod (Pozicioniranje):  
P-režim najbolje funkcioniše kada je GPS signal jak. Letelica koristi GPS i Vision Sistems da se 
locira, stabilizuje i kreće između prepreka. Inteligentni modovi letenja su omogućeni u ovom 
režimu. Kada su sistemi za gledanje napred i nazad omogućeni i uslovi osvetljenja su dovoljni, 
maksimalni uspinjući ugao leta je 25 °, maksimalna brzina leta unapred je 50 km/  i maksimalna 
brzina leta unazad je 43 km/h.  

Napomena: P-režim zahteva veće pokrete ručica da bi se postigle velike brzine. Letelica se 
automatski prebacuje u režim Stativa (ATTI) kada Vision Sistems nisu dostupni ili su onemogućeni 
i kada je GPS signal slab ili kompas doživljava smetnje. Kada Vision Sistemi nisu dostupni, letelica 
se ne može pozicionirati ili kočiti automatski, što povećava rizik potencijalnih opasnosti tokom 
leta. U režimu ATTI, na letelicu okolina može više da utiče. Faktori iz okruženja, poput vetra, mogu 
rezultirati horizontalnim pomeranjem, koje može da predstavlja opasnost, posebno tokom leta u 
zatvorenim prostorima. 

S-mode (Sport):  
U S-režimu su Vision sistemi onemogućeni i letelica koristi samo GPS za pozicioniranje. 
Maksimalna brzina leta je 72km/h  Inteligentni modovi leta nisu dostupni a letelica ne može da 
oseti ili izbegne prepreke. Napomena: U S-modu su reakcije letelice optimizovane za okretnost i 
brzinu čineći je fleksibilnijom pokretima upravljača.  

T-mod (Stativ): 
T-režim se zasniva na P-režimu, a brzina leta je ograničena, što čini letelicu stabilnijom tokom 
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snimanja. Maksimalna brzina leta, maksimalna brzina uzleta i maksimalna brzina spusta je 1 m / 
s. Inteligentni modovi leta nisu dostupni u T-režimu. 

Sistemi prednji, zadnji i bočni vid i infracrveni senzorski sistem su onemogućeni u S-režimu, što 
znači da letelica ne može automatski da oseti prepreke na svojoj ruti. Maksimalna brzina i put 
kočenja letelice značajno se povećavaju u S-režimu. Minimum kočioni put od 30 m je potreban 
kad nema vetra. Brzina spuštanja značajno se povećava u S-režimu. Reagovanje letelicaa 
značajno se povećava u S-režimu, što znači malo pomeranje ručice na daljinskom upravljaču 
pretvara se u velika pomeranja letelice. Budite oprezni i održavajte odgovarajući manevarski 
prostor tokom leta. Pomoću prekidača Flight Mode na daljinskom upravljaču prelazite između 
načina letenja.  

Omogućite Višestruki načini leta u DJI GO 4 za prebacivanje između režima leta. 

LED-ovi i indikator statusa 
 

Mavic 2 Pro / Zoom ima prednje LED i indikatore statusa letelicaa kao što je prikazano na donjoj 
slici. 

 

Stanje indikatora stanja letelicaa   

 Boja Treperenje / 
Upaljeno 

Opis stanja letelice 

Normalna stanja    

 

Naizmenično crvena, zelena 
i žuta 

Trepere  Uključivanje i obavljanje testa 
samo-dijagnosticiranja 

 Žuta Treperi četiri 
puta 

Zagrevanje 
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 Zelena Treperi polako P-mod sa GPS-om 

 Zelena Periodično 
trepće dva puta 

P-mod sa Vision Sistemom 
unapred i nadole  

 Žuta Trepće polako  Bez GPS-a, Vision sistema za 
napred ili nadole 

 Zelena Brzo treperi Kočenje 

Stanja 
Upozorenja 

   

 Žuta Brzo treperi Signal daljinskog upravljača je 
izgubljen 

 Crvena  Slaba baterija 

 Crvena Brzo treperi Kritično slaba baterija 

 Crvena Treperi IMU greška 

 Crvena Upaljeno Kritična greška 

 

Naizmenično crveno i žuto Brzo treperi Potrebna je kalibracija 
kompasa 

Povratak kući  
Funkcija Povratak kući (RTH) vraća letjelicu do zadnje zabilježene početne tačke. Postoje tri vrste 
RTH: Smart RTH, RTH sa slabom baterijom i Faithsafe RTH.  

Matična tačka  

Ako je pre poletanja stečen snažan GPS signal, matična tačka je lokaciju sa koje je letelica 
poletela. Snaga GPS signala je naznačeno ikonom GPS     .  

Indikator statusa letelice će treptati zeleno brzo kad se snimi matična tačka. 

Smart RTH  
Ako je GPS signal dovoljno jak, Smart RTH se može koristiti za vraćanje letelice u matičnu 

tačku. Pametni RTH pokreće se dodirom   u DJI GO 4 ili pritiskom i držanjem 
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RTH dugmeta u na daljinskom upravljaču. 

Izađite iz Smart RTH dodirom     u DJI GO 4 ili pritiskom na RTH dugme na daljinskom  

upravljaču.  

RTH slabe baterije  
RTH slabe baterije aktivira se kada se Inteligentna baterija leta istroši do tačke kada je siguran 
povratak letelice možda ugrožen.  

Kad se to od vas zatraži, vratite se kući ili spustite letelicu odmah. DJI GO 4 prikazuje upozorenje 
kada je nivo baterije nizak.  

Letelica će se automatski vratiti u matičnu tačku ako se ne odradi ništa posle odbrojavanja od 
deset sekundi. Korisnik može otkazati RTH pritiskom na RTH dugme ili dugme Flight Pause na 
daljinskom upravljaču.  

Ako se RTH otkaže nakon upozorenja o slabijoj bateriji, Inteligentna baterija leta možda neće 
imati dovoljno snage da letelica sigurno sleti, što može dovesti do pada letelice ili gubitka.  

Pragovi za upozorenja o nivou napona baterije automatski se određuju na osnovu trenutnih 
vrednosti visina leta letelice i udaljenost od početne tačke. 

 Letelica će automatski da sleti ako je trenutni nivo napona baterije dovoljan samo da se spusti 
sa svoje trenutne visine.  

Korisnik ne može otkazati automatsko slijetanje, ali može koristiti daljinski kontroler da izmeni 
orijentaciju letelice tokom procesa sletanja. 

Ako se pojavi upozorenje o nivou baterije, poduzmite korake kao što je opisano u donjoj tabeli. 

Upozorenja o RTH i nivou baterije (kada koristite firmvare 
v00.06.00.00) 

Upozorenje Indikator statusa DJI GO 4 App Napomene / uputstva 

 
 
 
 

Slaba baterija 

 
 
 
 

Trepće polako 
crveno 

Pruža mogućnost povratka 
na matičnu tačku automatski 
ili da nastavite normalan let. 
Ako nema akcije letelica će 
se automatski da odleti na 

matičnu tačku posle 10 
sekundi. 

Nivo baterije je nizak. 
Doletite nazad i sletite, 

zatim zaustavite 
motore i zamenite 

bateriju. 

 
 
 

Kritično Slaba Baterija 

 
 
 

Trepće brzo 
crveno  

 
 
 

Ekran treperi crveno. 

Letelica se spušta i 
sleće automatski. Ovaj 
postupak ne može biti 
otkazan. Ako postoji 
opasnost od sudara, 

pojačajte gas i 
pokušajte da se 

odmaknete. 
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Upozorenja o RTH i nivou baterije (kada koristite ažurirani firmver 
v01.00.00.00) 

Upozorenje Instrukcije Indikator 
statusa 

DJI GO 4 App Akcije 

 
 
 
 
 
 
 
 

Slaba 
baterija 

Preostali nivo baterije 
podržava RTH. 

 
 
 
 
 
 
 
 

Trepće 
polako 
crveno 

Odaberite RTH ili 
nastavite 

normalno sa 
letom 

Izaberite opciju. Ako nema 
akcije, letelica će ući u RTH. 

Preostali nivo baterije 
podržava Hitan RTH. 

(kada je u RTH sa 
normalnim RC 

signalom i visinom 
preko 50m) 

Izaberite Hitan 
RTH ili nastavite 

RTH. 

Izaberite opciju. Hitan RTH 
(letelica se spušta na 50m i 

vraća se na matičnu tačku) ili 
nastavite RTH (letelica se vraća 

na matičnu tačku bez 
spuštanja). Ako nema akcije, 
letelica će ući u Hitan RTH. 

Preostali nivo baterije 
podržava Hitano 

Sletanje.  
( kada je u RTH sa 

normalnim RC 
signalom) 

Letelica sleće. 
Akcija se ne 

može prekinuti. 

Letelica odmah sleće. 

 
 
 
 

Kritično 
Slaba 

Baterija 

Letelica sleće posle 
10 s. (kada leti 

normalno sa kritično 
slabom baterijom). 

 
 
 
 

Trepće 
brzo 

crveno  

Letelica sleće 
posle 10 s. 
Akcija se ne 

može prekinuti. 

Letelica sleće posle 10 sekundi. 

Letelica sleće posle 
10 s. (kada leti 
normalno sa 

ekstremno kritično 
slabom baterijom). 

Letelica sleće 
odmah. Akcija se 

ne može 
prekinuti. 

Letelica sleće odmah. 

 

Failsafe RTH  

Prednji Vision Sistem omogućava letelici da kreira u stvarnom vremenu mapu putanje leta dok 
leti. Ako je matična tačka uspešno snimljena i kompas normalno funkcioniše, Failsafe RTH 
automatski se aktivira nakon što se signal daljinskog upravljača izgubi duže od dve sekunde. 
Kada se aktivira Failsafe RTH, letelica počinje da se vraća nazad svojom prvobitnom rutom leta 
do početne tačke. Ako se daljinski kontrolni signal ponovo uspostavi u roku od 60 sekundi nakon 
aktiviranja Failsafe RTH, letelica lebdi na trenutnoj lokaciji 10 sekundi i čeka pilotske komande.  

Korisnik može dodirnuti DJI GO 4 ili da pritisnite dugme RTH na daljinskom upravljaču da bi se 
otkazao Failsafe RTH i ponovo preuzeo kontrolu. Ako nema signala od pilota, letelica leti ravno 
do početne tačke. Ako je signal daljinskog upravljača i dalje izgubljen 60 sekundi nakon aktiviranja 
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Failsafe RTH, letelica prestaje da prati svoju originalnu rutu leta i leti do početne tačke u pravoj 
liniji. 

 

RTH postupak  

Pametni RTH, RTH sa malo baterije i Failsafe RTH slede RTH postupak:  

1. Letelica odredjuje svoju orijentaciju. 

2.    

 a. Ako je letelica udaljena više od 20 m od početne tačke kada započne RTH  postupak, 
onda se penje na unapred postavljenu visinu RTH i zatim leti do početne  tačke brzinom od 12 
m / s. Ako je trenutna nadmorska visina veća od visine RTH,  letelica leti prema početnoj 
tački na trenutnoj visini. Prednji i zadnji Vision  sistemi su omogućeni.  

b. Ako se letelica nalazi između 5 m i 20 m od početne tačke kada započne RTH postupak:  

 i. Ako je omogućena opcija RTH na trenutnoj visini, letelica leti u matičnu tačku  trenutnom 
visinom, osim ako je trenutna visina manja od 2 m, u tom  slučaju se letelica penje na 2 m a 
zatim leti do početne tačke brzinom od 3 m / s. 

 ii. Ako je opcija RTH na trenutnoj visini onemogućena, letelica se odmah spušta. 

c. Ako se letelica nalazi manje od 5 m od početne tačke kada započne RTH postupak, sleće 
odmah. 

3. Nakon dolaska do početne tačke, letelica sleće i motori se zaustavljaju. 

 

 

Izbegavanje prepreka tokom RTH-a  
Pod uslovom da su uslovi osvetljenja dovoljni da sistem za gledanje napred i nazad deluje, Mavic 
2 Pro / Zoom opaža i aktivno pokušava izbeći prepreke tokom RTH-a. Postupak izbegavanja 
prepreka je sledeći:  

1. Letelica usporava kada se opazi prepreka. 
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2. Letelica se zaustavlja i lebdi, a zatim se penje dok se ne prevaziđe prepreka. 

3. Postupak RTH se nastavlja. letelica leti na matičnu tačku na novoj nadmorskoj visini. 

 

 

 

 

 

 

 

Napomena: 

Letelica se ne može vratiti na matičnu tačku ako je GPS signal slab ili nedostupan.  

U Smart RTH i RTH s niskom baterijom, letelica se automatski uspinje do nadmorske visine od 
65 stopa (20 m). Jednom kada je nadmorska visina 65 metara ili viša, pomerite dugme za gas i 
letelica će prestati da se penje i poleteće do matične tačke na svojoj trenutnoj visini.  

Letelica ne može da izbegne prepreke tokom Failsafe RTH-a ako su prednji, zadnji i donji Vision 
Sistemi nedostupni. Važno je podesiti odgovarajuću visinu RTH pre svakog leta. Pokrenite DJI 
GO 4,tapnite na        a  zatim podesite visinu RTH.  

Tokom RTH-a brzina i visina letelice mogu se kontrolisati pomoću daljinskog upravljača ili DJI GO 
4, ali kontrolor leta kontroliše orijentaciju i smer leta.  

Tokom RTH-a, prepreke sa obe strane letelicaa ne mogu se otkriti ili izbeći. 

Zaštita sletanja  
Zaštita sletanja se aktivira tokom Smart RTH-a i letelica vrši sledeće:  

1. Kada zaštita sletanja utvrdi da je tlo pogodno za sletanje, letelica nežno sleti. 

2. Ako zaštita sletanja utvrdi da tlo nije pogodno za sletanje, letelica lebdi i čeka pilota da potvrdi 
da li je pogodno za sletanje. 

3. Ako zaštita sletanja nije operativna, DJI GO 4 prikazuje objavu za sletanje kada se letelica 
spusti ispod 0,5 m. Povucite nadole ručicu za gas na jednu sekundu ili koristite klizač za 
automatsko sletanje u aplikacija za sletanje. 

Zaštita sletanja aktivira se tokom RTH slabe baterije i Failsafe RTH.  

Letelica se ponaša na sledeći način:  

Za vreme RTH sa niskom baterijom i Failsafe RTH, letelica lebdi na 2 m iznad zemlje i čeka pilota 
da potvrdi da je pogodno za sletanje. Povucite nadole ručicu za gas na jednu sekundu ili koristite 
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klizač  za automatsko sletanje u aplikaciji za sletanje. Zaštita od sletanja se aktivira i letelica 
izvršava gore navedene korake.  

Napomena: 

Sistemi vida su onemogućeni tokom sletanja. Obavezno spustite letelicu s oprezom. 

 

Vision sistemi i infracrveni sistemi  
Mavic 2 Pro / Zoom opremljen je sistemima za napred, nazad, nadole i bočno gledanje, i 
infracrveni senzorski sistem prema gore i dole, koji pruža svesmerno opažanje prepreka (ako su 
uslovi osvetljenja adekvatni).  

Glavne komponente sistema za gledanje napred, nazad i nadole su šest kamera koje se nalaze 
na nosu, zadnjoj strani i donjoj strani letelice. Sistemi za bočni vid su dve kamere koji se nalaze 
sa obe strane letelice.  

Glavne komponente infracrvenog senzorskog sistema prema gore i dole su dva 3D infracrvena 
modula smeštena na gornjoj i donjoj strani letelice.  

Vizuelni sistem za dole i infracrveni senzor pomaže letelici da održi trenutnu poziciju i da lebdi na 
mestu preciznije i da leti u zatvorenom prostoru ili u drugim okruženjima gde je GPS signal  
nedostupan. Pored toga, pomoćno donje svetlo koje se nalazi na donjoj strani letelice poboljšava 
vidljivost donjeg sistema za gledanje u uslovima slabog osvetljenja. 

 

Opseg detekcije  

Raspon detekcije Vision Sistems je prikazan na sledeći način. Imajte na umu da letelica ne može 
da opazi ili izbegne prepreke koje nisu u dometu otkrivanja. 
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Kalibrisanje Vision sistem kamera 

Kamere za Vision Sistem instalirane u letelici su fabrički kalibrirane. Ako letelica doživi sudar ili 
pad, možda će biti potrebna kalibracija preko DJI Assistant 2 za Mavic ili DJI GO 4.  

Najtačniji način kalibracije kamera Vision Sistem-a je korišćenjem DJI Assistant 2 for Mavic.  

Sledite dole navedene korake za kalibraciju kamera Prednji Vision , a zatim ponovite korake za 
kalibraciju ostalih kamera Vision Sistem-a. 

 

 

 

 

 

 

Kada je potrebna kalibracija Vision sistema za gledanje, DJI GO 4 šalje obaveštenje. 

 Ako računar nije u blizini, u aplikaciji se može izvršiti brza kalibracija. Dodirnite traku statusa 
letelice i Vision senzore za početak brze kalibracije.  

Napomena: Brza kalibracija je samo brzo rešenje za probleme sa Vision sistemom. Kad je to 
moguće, povežite letelicu na računar da izvrši potpunu kalibraciju koristeći DJI Assistant 2 za 
Mavic. Kalibrirajte samo na teksturiranim površinama kao što su trava ili kada su uslovi osvetljenja 
adekvatni. Ne kalibrirajte letelica na visoko reflektirajućim površinama, poput mermernih ili 
keramičkih pločica. 

Korišćenje Vision sistema  
Vizuelni sistem za dole i infracrveni senzor automatski se aktiviraju kada je letelica uključena. 
Daljnje akcije nisu potrebne. Pri korišćenju sistema za gledanje nadole, letelica može da lebdi 
tačno čak i bez GPS-a. 
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Sistem za gledanje prema dole obično se koristi u zatvorenim okruženjima u kojima GPS nije 
dostupan. Sistem za gledanje prema dole najbolje funkcioniše kada se letelica nalazi na visinama 
od 0,5 do 11 m. Molimo vas imajte na umu da funkcija Vision Positioning može da utiče ako je 
nadmorska visina iznad 11 m. 

 

Sledite dole navedene korake da biste koristili sistem vida nadole:  

1. Proverite da li je letelica u P režimu i postavite je na ravnu površinu. Molimo vas imajte na umu 
da sistem za gledanje nadole ne može pravilno raditi na površinama bez jasnih varijacija uzoraka. 

2. Uključite letelicu. Letelica lebdi u mestu posle poletanja. Indikatori statusa letelice trepere 
zeleno dva puta, što ukazuje da sistem za gledanje prema dole radi. 

Pomoću sistema za gledanje napred i nazad letelica može aktivno kočiti prilikom otkrivanja 
prepreke ispred. Sistemi za gledanje napred i nazad najbolje rade uz adekvatno osvetljenje i jasno 
označene ili teksturirane prepreke. 

Da bi se omogućilo dovoljno vremena za kočenje, letelica ne bi trebalo da leti više više od 50 km 
/ h kada leti napred ili više od  42 km / h kada leti unazad. Sistemi za bočni vid zahtevaju bolje 
osvetljenje i više teksturnih ili jasno označenih prepreka i ne mogu da osete dinamičke predmete, 
kao što su kretanje ljudi, vozila, grane drveća ili trepereća svetla.  

Sistemi za bočni vid dostupni su samo u ActiveTrack 2.0 i režimu stativa, kao i QuickShots pod 
modulima Circle, Helix i Boomerang (kada koristite firmvare v01.00.01.00 ili noviji). Ugaona brzina 
je ograničena na 24 ° / s, a bočna brzina leta je ograničena na 18 mph (29 mph). 

Napomena: 

Sistemi za bočni vid imaju ograničenu sposobnost da osete i izbegavaju prepreke i na 
performanse može uticati na okolno okruženje. Obavezno održavajte u vidnom polju letelicu i 
obratite pažnju na uputstva u DJI GO 4. DJI ne preuzima nikakvu odgovornost za bilo koju letelicu 
koja je oštećena ili izgubljena tokom korišćenja sistema Lateral Vision. 

Vision sistem ne može pravilno raditi na površinama koje nemaju jasan uzorak varijacije. Vision 
sistem je efikasan samo kada je letelica na visini od 0,5 do 50 metara.  
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Imajte na umu da na funkciju Vision Positioning može uticati visina letelicaa ako je iznad 11m. 
 
Pomoćno donje svetlo se automatski uključuje kada je svetlost okoline suviše slaba i visina leta 
je manja od 5 m. Imajte na umu da na performanse sistema Vision Sistem može uticati to kada 
je uklučeno pomoćno donje svetlo. Letite oprezno ako je GPS signal slab.  

Vision sistem NE MOŽE pravilno funkcionisati kada letelica leti nad vodom ili snegom- pokrivenim 
područjima.  

Imajte na umu da Vision sistem NE funkcioniše pravilno kad letelica leti prebrzo. Letite sa 
oprezom pri letenju brzinom preko 10 m / s na 2 m visine ili preko 5 m / s na 1 m visine .  

Upravljajte letelicaom oprezno u bilo kojoj od sledećih situacija:  

a. Let iznad jednobojnih površina (npr. čisto crna, čisto bela, čisto zelena).  

b. Let po visoko reflektirajućim površinama.  

c. Let iznad vode ili prozirnih površina. 

d. Let iznad pokretnih površina ili predmeta. 

e. Let u području gde se osvjetljenje često ili drastično menja.  

f. Let preko izuzetno tamnih (<10 luksa) ili svetlih (> 40 000 luksa) površina.  

g. Let iznad površina koje snažno reflektiraju ili apsorbuju infracrvene talase (npr. ogledala).  

h. Let iznad površina bez jasnih obrazaca ili teksture.  

i. Let iznad površina s ponavljajućim identičnim uzorcima ili teksturama (npr. pločice istog dizajna). 

j. Letite preko prepreka sa malim površinama (npr. grane drveća) 

Držite senzore čistim u svakom trenutku. NE dirajte senzore. Ne ometajte infracrvenu vezu 

Sensing Sistem. 

Vision sistem možda neće moći da prepozna uzorke na zemlji pri uslovima slabog osvetljenja 
(manje od 100 luksa). 

Ako brzina letelicaa prelazi 31 mph (50 km / h), Vision sistem nema dovoljno vremena da 

zakoči i zaustavi letelica na sigurnoj udaljenosti od prepreke. 

Ako vazduhoplov doživi sudar, potrebna je kalibracija kamere. Kalibrirajte prednje kamere 

ako DJI GO 4 zatraži da to učinite. 

Ne letite danima koji su kišni, mutni ili ako nema jasnog pogleda. 

Svaki put pre poletanja proverite sledeće: 

a. Pazite da na staklu infracrvenog senzora nema nalepnica ili bilo kakvih prepreka 

za Vision Sistem. 
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b. Ako na staklu infracrvenog sistema za senzor i vid ima nečistoća, prašine ili vode, 

očistite mekom krpom. Ne koristite nijedno sredstvo za čišćenje koje sadrži alkohol. 

c. Obratite se DJI službi za podršku ako dođe do oštećenja na staklu infracrvenog senzora i Vision 
sistema. 

Gornji infracrveni senzor prepoznaje samo ravne linije direktno iznad senzora a ne cele letelice. 
Uz to, mogu se otkriti velike prepreke poput krova, ali sitne prepreke poput listova ili električnih 
žica ne mogu.  

Letite oprezno i ne oslanjajte se isključivo na gornji infracrveni senzorski sistem za otkrivanje 
prepreka iznad letelice. 

Ne ometajte sistem za gledanje prema dole i infracrveni senzor za dole pre poletanja. Inače, 
letelica ne može ponovo da poleti posle sletanja i moraće da se ponovo pokrene. 

Inteligentni modovi leta  
Mavic 2 Pro / Zoom podržava inteligentne režime leta uključujući Hiperlapse, QuickShots, 
ActiveTrack 2.0, Tačka interesa (POI 2.0), Putne tačke (uskoro), TapFly i Cinema režim.  

Izaberite Inteligentni režim letenja u DJI GO 4. Osigurajte da je nivo baterije dovoljan i da letelica 
radi u P-mod pri korištenju Inteligentnih režima leta.  

Hiperlapse (Hyperlapse) 

Načini snimanja hiperlapsom uključuju Slobodno, Krug, Zaključavanje kursa i Tačke. 

 

 

 

 

 

 

 

 

 

 

Slobodno (FREE) 

Letelica automatski snima fotografije i generiše video interval. Slobodni režim se može koristiti 
dok je letelica na zemlji. Nakon poletanja kontrolišite nadmorsku visinu, brzinu leta i ugao gibanja 
letelice pomoću daljinskog upravljača. Držite upravljačke palice i ubrzavajte stalnom brzinom dve 
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sekunde a zatim pritisnite dugme C1. Brzina je fiksna i letelica i dalje leti tom brzinom dok 
fotografiše. Orijentacija letelice se i dalje može kontrolisati tokom ovog vremena. Pratite sledeće 
korake kad koristite Slobodno:  

1. Podesite vreme intervala i trajanje video zapisa. Na ekranu se prikazuje broj fotografija koje će 
biti snimljene i koliko će trajati vreme snimanja. 

2. Dodirnite dugme zatvarača da biste započeli. 

Krug (Circle) 

Letelica automatski snima fotografije dok leti oko odabranog objekta kako bi se stvorio vremenski 
video interval. Krug se može odabrati tako da se kreće u smeru kazaljke na satu ili u suprotnom 
smeru kazaljke na satu. Imajte na umu da letelica izlazi iz kruga ako se primi bilo koja naredba s 
daljinskog upravljača. Sledite dole navedene korake kad koristie Circle: 

1. Podesite vreme intervala i trajanje video zapisa. Na ekranu se prikazuje broj fotografija koje će 
biti snimljene i koliko će trajati vreme snimanja. 

2. Izaberite predmet na ekranu. 

3. Dodirnite dugme zatvarača da biste započeli. 

Zaključavanje kursa (Course Lock) 

Sa Mavic 2 Pro / Zoom-om, zaključavanje kursa može se koristiti na dva načina.  

Na prvi način, orijentacija letelice je fiksirana, ali subjekt se ne može izabrati.  

Na drugi način je orijentacija letelica je fiksna i letelica leti oko odabranog objekta. Sledite dole 
navedene korake da biste koristili zaključavanje kursa:  

1. Podesite vreme intervala i trajanje video zapisa. Na ekranu se prikazuje broj fotografija koje će 
biti snimljene i koliko će trajati vreme snimanja. 

2. Podesite pravac leta. 

3. Izaberite temu (ako je primenljivo). 

4. Dodirnite dugme zatvarača da biste započeli. 

Putne tačke (Waypoints) 

Letelica automatski fotografiše na putu leta od dve do pet usmerenih tačaka i generiše   video 
interval. Letelica može leteti redom od putne tačke br. 1 do br. 5 ili br. 5 do br. 1.  

Napomena da letelica izlazi iz režima ako se primi bilo koja naredba s daljinskog upravljača. 
Pratite dole navedeni korake za upotrebu režima.  

1. Podesite željene smerne tačke i smer objektiva. 

2. Podesite vreme intervala i trajanje video zapisa. Na ekranu se prikazuje broj fotografija koje će 
biti snimljene i koliko će trajati vreme snimanja. 
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3. Dodirnite dugme zatvarača da biste započeli. letelica će automatski generisati vremenski 
snimak rezolucije 1080p25, što je vidljivo u meniju Reprodukcija.  

Možete da sačuvate snimke u formatu JPEG ili RAV i da snimite snimke u ugrađenu memoriju ili 
SD karticu u podešavanjima fotoaparata. 

Napomena: Za optimalne performanse preporučuje se korišćenje Hiperlapse-a na nadmorskoj 
visini većoj od 50 m i da podesite razliku od najmanje dve sekunde između intervala vremena i 
zatvarača.  

Preporučuje se da  zaberete statički objekt (npr. visoke zgrade, planinski teren) na udaljenosti od 
letelice (dalje od 15 m). Ne birajte predmet koji je previše blizu letelice. 

Letelica koči i lebdi na mestu ako se tokom Hiperlapse uoči prepreka.  

Letelica generiše video samo ako je napravio najmanje 25 fotografija, što je potreban iznos da 
biste generisali video od jedne sekunde. Video se generiše kada se sa daljinskog upravljača izda 
naredba kontrolera ili ako se režim neočekivano završi (na primer kada se aktivira RTH slabe 
baterije).  

Moguće je izvršiti izbor i podesiti brzinu i trajanje leta za Hiperlapse (uz pomoć firmvare-a 
v01.00.01.00 ili novije verzije). 

 

QuickShots 
Načini snimanja QuickShots uključuju Dronie, Circle, Helix, Rocket, Boomerang, Asteroid i Dolly 
Zoom (dostupan samo sa Mavic 2 Zoom). Mavic 2 Pro / Zoom snima video zapis u skladu sa 
izabranim načinom snimanja, a zatim automatski generiše 10-sekundi video. Video snimak se 
tada može gledati, uređivati ili deliti na društvenim mrežama iz Playback-a.  
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Dronie: Letelica leti unazad i penje se, dok je kamera zaključana na objektu.  

 Krug: Letelica kruži oko teme.  

 Helix: Letelica se penje u spirali oko predmeta.  

 Rocket: Letelica se penje uz kameru koja je okrenuta na dole.         

Bumerang: Letelica leti oko subjekta ovalnom putanjom, uzdižući se kako leti  od 
 početne tačka i silazi dok leti nazad. Početna  i krajnja tačka čine temena duže ose 
 ovala.  Osigurajte da ima dovoljno prostora oko letelice kada koristite Boomerang: 
 Dopustite radijus od najmanje 30 m oko letelice i najmanje 10m  iznad  letelice. 

 Asteroid: Letelica leti unazad i prema gore, pravi nekoliko fotografija, a zatim leti  nazad 
ka polaznoj tački. Snimljeni video počinje panoramom sa najvišeg položaja, a  zatim 

se prikazuje spuštanje. Osigurajte da ima dovoljno prostora kada koristite  Asteroid. 
Dozvolite najmanje 40 m iza i 50 m iznad Letelicaa.  

 Dolly Zoom: Mavic 2 Zoom leti unazad i prema gore. Prilagođava zum tokom leta 
 zadržavajući odabrani objekt iste veličine dok se pozadina menja. Kada planirate da          

koristite Dolly Zoom, prvo odaberite udaljenost između vazduhoplova i objekta.   

Budite sigurni da je na zadnjoj strani letelice dostupno najmanje tri puta veća udaljenost 
tako da ima dovoljno prostora za letenje. 

 

Korišćenje QuickShots-a  
 

Proverite da li je letelica u P-režimu i da li je Inteligentna Baterija Leta dovoljno napunjena. Sledite 
dole navedene korake za upotrebu QuickShots: 

1. Poletite se i lebdite najmanje 2 m iznad zemlje. 

 

 

 

 

 

 

 

2. U DJI GO 4 tapnite na    , zatim odaberite QuickShots i sledite upute. 
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3. Odaberite željeni predmet u prikazu kamere (tapnite na krug na objektu ili prevucite okvir oko 
objekta) i izaberite režim snimanja. Dodirnite „GO“ da biste započeli snimanje. Letelica leti natrag 
u prvobitni položaj nakon završetka snimanja. 

4. Kucnite        za pristup video snimku. 

 

Izlaz iz QuickShots-a  

Prebacite preklopku za režim leta u S-režim ili T-režim da biste izašli iz QuickShots-a bilo kada 
tokom snimanja (kada je u DJI GO 4 omogućeno više načina leta). Pritisnite dugme Flight Pause 
na daljinskom upravljaču ili dodirnite       u DJI GO 4 ili kočnicu za slučaj nužde. 

Napomena: Koristite QuickShots na lokacijama koje su izvan zgrada i drugih prepreka. Budi 
sigurni da na putanji leta nema ljudi, životinja ili drugih prepreka. Letelica koči i lebdi na mestu 
kada se opazi prepreka.  

Uvek obratite pažnju na predmete oko letelice i koristite daljinski upravljač da biste  izbegli 
nesreće (poput sudara) ili gubljenja letelice iz vida.  

Budite posebno oprezni kada koristite QuickShots u bilo kojoj od sledećih situacija:  

a. Kada je subjekat duže vreme blokiran ili izvan vidne linije.  

b. Kada je predmet udaljen više od 50 m od vazduhoplova.  

c. Kada je predmet slične boje ili dezena sa okolinom. 

d. Kad je predmet u vazduhu. 
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e. Kad se subjekt brzo pomera.  

f. Osvetljenje je izuzetno slabo (<300 luksa) ili visoko (> 10.000 luksa).  

NE upotrebljavajte QuickShots na mestima u blizini zgrada ili na kojima je GPS signal slab. U 
suprotnom, staza leta će biti nestabilna. Morate poštovati lokalne zakone i propise o privatnosti 
kada koristite QuickShots. Imajte na umu da su sistemi za bočni vid omogućeni u QuickShots 
pod-modovima Circle, Helix i Boomerang (kada koristite firmvare v01.00.01.00 ili noviji). 

 

ActiveTrack 2.0  

 
ActiveTrack 2.0 omogućava vam da odaberete subjekt na ekranu svog mobilnog uređaja. Letelica 
prilagođava svoj let da prati subjekt. Nije potreban spoljni uređaj za praćenje. Mavic 2 Pro / Zoom 
može automatski da prepozna do 16 subjekata i koristi različite strategije praćenja za praćenje 
ljudi, vozila i brodica.  

Korišćenje ActiveTrack 2. 0  

Proverite da li je letelica u P-režimu i da li je Inteligentna Baterija Leta dovoljno napunjena. Pratite 
dole navedene korake za korišćenje ActiveTrack 2.0:  

1. Poletite se i lebdite najmanje 2 m iznad zemlje. 

 

 

 

 

 

 

U DJI GO 4 tapnite na      , a zatim izaberite ActiveTrack 2.0. 
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3. Za optimalno izvođenje preporučuje se odabir subjekta koga automatski prepoznaje letelica. 
Da biste to učinili, odaberite subjekt koja je prepoznat na ekranu i kucnite da potvrdite svoj izbor.  

Ako letelica nije prepoznala željeni subjekt, povucite odabir oko njega na ekranu i dodirnite da 
biste ga ručno izabrali.  

Međutim, kada se subjekt izabere ručno, to može uticati na sposobnost letelice da prati subjekt. 
Ako okvir postane crven, subjekt se ne može prepoznati i treba ga ponovo izabrati. 

4. Letelica automatski izbegava prepreke na svom putu leta. Ako letelica izgubi trag subjekt jer 
se kreće prebrzo ili je zatamnjen, ponovo izaberite subjekt za nastavak praćenja. 

ActiveTrack 2.0 uključuje sledeće pod-režimi: 

Trace - Praćenje Parallel - Paralelno Spotlight - Usmereno 

 
  

Letelica prati subjekt na stalnoj 
udaljenosti. Koristite roll  štap i 
tilt štap na daljinskom 
kontroleru za promenu 

Letelica prati subjekt pod 
stalnim uglom i rastojanjem od 
prednje strane . Upotrijebite roll 
štap na daljinskom upravljaču 

Letelica ne prati subjekt 
automatski, ali drži kameru 
usmerenom ka objektu tokom 
leta. Daljinski kontroler se 
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rastojanja, i koristite klizač u 
DJI GO 4 da letite u krugu oko 
predmeta. Uokvirivanje 
predmeta je podesivo pomoću 
leve palice i gimbal dial. 

za let kružno oko predmeta. 
Uokvirivanje predmeta je 
podesivo sa levim štapom i 
gimbal dugmetom. 
U ovom pod režimu, letelica 
koči i lebdi na mestu kada se 
otkrije prepreka. 

koristi za manevrisanje 
letelicom, ali kontrola 
orijentacije je onemogućena. 
Kadriranje predmeta se 
podešava levim štapom i 
gimbal dugmetom.  
Letelica koči odmah kad se 
otkrije prepreka. 

 

Napomena: 

Ne koristite ActiveTrack 2.0 u oblastima sa ljudima, životinjama, malim ili sitnim predmetima (npr. 
Grane drveća ili dalekovodi) ili prozirni predmeti (npr. voda ili staklo). 

Ručno upravljajte letelicom (pritisnite dugme Flight Pause ili prebacite prekidač Flight Mode na 
S-mod na daljinskom upravljaču) ili tapnite na      u hitnom slučaju  u DJI GO 4.  

Budite dodatno budni kada koristite ActiveTrack 2.0 u bilo kojoj od sledećih situacija:  

a. Praćeni subjekt se ne kreće po ravnoj površini.  

b. Praćeni subjekt drastično menja oblik tokom kretanja.  

c. Praćeni subjekt duže vreme nije vidljiv. 

d. Praćeni subjekt kreće se po snežnoj površini. 

e. Praćeni subjekt ima sličnu boju ili uzorak kao i okolno okruženje.  

f. Raspoloživa svetlost je preniska (<300 luksa) ili previsoka (> 10.000 luksa). Morate poštovati 
lokalne zakone i propise o privatnosti kada koristite ActiveTrack 2.0.  

Preporučuje se samo za praćenje ljudi (ali ne preporučuje se praćenje dece), vozila i čamaca. 
Letite oprezno prilikom praćenja drugih predmeta.  

Subjekt za praćenje može se nenamerno zamijeniti drugim predmetom ako prolaze  blizu jedan 
drugom. 

Postoje dve mogućnosti prilikom odabira ograničenja brzine praćenja. Bezbedni režim ograničava 
brzinu na ne više od 12 m / s i režim Mak do najviše 20 m / s. Imajte na umu da letelica ne može 
da izbegava prepreke ako brzina leta prelazi 12 m / s. 

Izlaz iz ActiveTrack-a 2. 0  
Pritisnite dugme Flight Pause na daljinskom upravljaču da biste odmah kočili. Pritisnite     na 
ekranu ili prebacite prekidač Flight Mode u S-mode na daljinskom upravljaču da biste izašli iz 
ActiveTrack 2.0. 

Posle izlaska ActiveTrack 2.0, letelica lebdi na mestu, a u tom trenutku možete da odlučite da 
letetite ručno, pratite druge subjekte ili se vratite kući.  



 

Interreg – IPA CBC Bulgaria – Serbia Programme  

CB007.2.13.212 

 
 

139 
 

Tačka interesa 2.0 (POI 2. 0)  
Izaberite statički predmet kao interesnu tačku. Podesite radijus kruga, visinu leta i brzinu leta. 
Letelica leti oko objekta u skladu sa ovim podešavanjima. Mavic 2 Pro / Zoom podržava izbor POI 
kroz GPS pozicioniranje i izbor na ekranu. 

 

 

 

 

 

 

 

 

 

 

 

 

1. Izaberite POI na ekranu: prevucite okvir oko željenog predmeta i dodirnite ikonu „GO“ na 
ekranu. letelica počinje da meri lokaciju subjekta i jednom leti oko njega nakon što uspešno utvrdi 
lokaciju. Pomoću gimbal kotačića prilagodite kadriranje objekta. Krug radijus, visina leta i brzina 
leta takođe se mogu podesiti tokom leta. 

Napomena: 

Preporučuje se da se izaberete statički objekt (npr. visoke zgrade, planinski teren) na bezbednoj 
udaljenost od letelice (dalje od 10 m). 

Ne birajte predmet koji je previše blizu letelice.  

Izbegavajte odabir subjekta bez jasnog uzorka (npr. vedro plavo nebo).  

Izbegavajte da odaberete predmete koji su premali.  

Odaberite predmet sa jasnim konturama. U suprotnom, objekt možda neće biti pravilno centriran 
na ekranu.  

Letelica se ne može kontrolisati dok se lokacija meri, ali merenje može biti zaustavljeno  pomoću 
kontrolnih palica, dugmeta Flight Pause, prekidačom za promenu načina rada leta ili ikone 
"STOP". 

2. Izaberite predmet putem GPS pozicioniranja: Ručno letite letelicom iznad objekta, a zatim 
pritisnite 
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dugme C1 ili odaberite u DJI GO 4 da biste potvrdili temu. Letite letelicom najmanje 5 m od 

Tačke interesa. Brzina leta i smer kruga mogu se podesiti u DJI GO 4. Dodirnite „GO“ da biste 
započeli 

let. Pomoću gimbal kotačića prilagodite kadriranje objekta. Radijus kruga, visina leta i brzina 
leta se takođe mogu podesiti tokom leta.  

Napomena: 

GPS pozicioniranje nema merenje visine. 

Preporučuje se podešavanje nagiba gimbal-a na -90 ° kako bi se olakšalo merenje GPS 
lokacije. 

 

Podešavanja parametara leta 

 
1. Brzina leta: Raspon brzine leta je 0-10 m / s, vrednost „+“ znači da letelica kruži oko tačke u 
smeru suprotnom od kazaljke na satu, a vrednost „-“ znači da letelica kruži tačkom u smeru 
kazaljke na satu.  

Podesite brzinu pomicanjem klizača na ekranu i pomoću ručice na daljinskom upravljaču 
povećajte vrednost. 

2. Kružni radijus: Podesite radijus pomicanjem klizača na ekranu i koristite ručicu za gas na 
daljinskom upravljaču kontrolera za povećanje vrednosti. 

3. Stav kruženja: Podesite stav pomeranjem klizača na ekranu i pomoću palice za gas na 
daljinskom upravljaču  povećavajte vrednosti. 

4. Ugao gimbal: Koristite palicu za skretanje za kontrolu gimbal kretanja i koristite gimbal kotačić 
za kontrolu nagiba. 

 Dodirnite ikonu da biste centrirali gimbal (Ako se za pozicioniranje GPS-a koristi GPS 
pozicioniranje, samo se  skretanje centrira u početnu poziciju. Ako se na ekranu izabere tačka 
interesa, i skretanje i nagiba se centriraju). 

5. Pravac kruga: Izaberite pravac pomeranjem dugmeta na ekranu. 

Izlaz iz Tačke Interesa  

 
Pritisnite na ekranu ili pritisnite dugme Leteća pauza da biste pauzirali režim tačke 
interesovanja. Pritisnite i zadržite dugme Leteća pauza da biste izašli iz režima tačke 
interesovanja.  

Napomena: 
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Letelica koči i lebdi na mestu kada se utvrdi prepreka tokom POI-ja. Ako je nos letelice usmeren 
ka tački interesa tokom leta, leteleica možda i nije u stanju da izbegnu prepreke.  

Koristite tačku interesa u širokom otvorenom prostoru. 

Putne tačke  

Letelica leti prema putnim tačkama redom prema podešavanjima. Orijentacija i brzina leta mogu 
se kontrolisati tokom leta. Putne tačke možete odabrati letenjem Mavic 2 Pro / Zoom-a do 
zamišljenih tačaka i snimanjem istih pojedinačno. Putne tačke takođe se mogu birati i uređivati 
na mapi pre poletanja:  

1. Na mapi dodajte tačke puta i tačke interesa. Kamera letelice ukazuje na tačku interesa kada 
putujete kroz putne tačke. 

2. Kucnite na tačke puta i interesantnu tačku za podešavanje nadmorske visine, brzine leta i 
drugih parametara. 

3. Povucite putne tačke i tačku interesa da biste prilagodili pozicije. 

4. Brzina leta, postavke bezbednosti i ponašanje Letelicaa mogu se konfigurirati nakon 
dovršetka leta putne tačke. 

5. Informacije o putnim tačkama i tačkama interesa mogu se sačuvati u aplikaciji tokom 
uređivanja u mapi i staza leta može se snimiti i ponoviti. 

Napomena: 

U izazovnim okruženjima poput onih okruženih visokim zgradama preporučuje se da ručno 
postavite putne tačke leteći do svake tačke. 

TapFly 

TapFly sadrži tri pod-načina; Naprijed, nazad i slobodno. Pod uslovom da je osvetljenje  
prikladno, letelica automatski izbegava prepreke koje otkrije.  

Napred: Letelica leti prema cilju uz pomoć prednjeg Vision sistema, prepoznavajući prepreke. 

Nazad: Letelica leti u suprotnom smeru od cilja pomoću zadnjeg Vision sistema otkriva moguće 
prepreke.  

Slobodno: Letelica leti prema cilju. Daljinski upravljač se može koristiti za manevrisanje 
letelicom. Letelica ne može da izbegne prepreke u ovom režimu. Letite oprezno.  

Korišćenje TapFly-a  

Proverite da li je vazduhoplov u P-režimu i da li je Inteligentna Baterija Leta dovoljno napunjena. 
Pratiti sledeće korake za korišćenje TapFly-a:  

1. Spustite se i lebdite najmanje 1 m iznad zemlje. 
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2. U DJI GO 4 tapnite na   , odaberite TapFly, a zatim odaberite pod-mod i sledite 
uputstvo. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Kucnite na cilj i pričekajte da se pojavi "GO". Dodirnite „GO“ da biste potvrdili izbor i letelica 
automatski leti do cilja. Ako se cilj ne može dostići, pojavljuje se prompt. Ako je to slučaj, 
izaberite drugi cilj i pokušajte ponovo. Cilj se može promeniti usred leta dodirivanjem ekrana. 

 

Izlaz iz TapFly-a  

Pritisnite dugme Flight Pause na daljinskom upravljaču ili povucite kontrolnu palicu u smjeru 
suprotnom od pravca leta i letelica koči i lebdi u mestu. Dodirnite ekran da biste nastavili 
TapFly. Pritisnite                    ili prebacite prekidač Flight Mode u S-mode da biste izašli iz 
TapFly-a. 

 

Napomena: NE upotrebljavajte TapFly u oblastima sa ljudima, životinjama, malim ili sitnim 
predmetima (npr. grane drveća ili dalekovodi) ili prozirnih predmeta (npr. vode ili stakla). TapFly 
možda neće ispravno raditi kada letelica leti nad vodom ili oblastima prekrivenim snegom. 
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Možda postoje odstupanja između očekivanih i stvarnih staza leta odabranih u TapFly-u. 

Opseg izbora za ciljni smer je ograničen. Ne možete izvršiti izbor u neposrednoj blizini gornje ili 
donje ivice ekrana.  

Cinematic Mode  

Tapnite na DJI GO 4 da biste izabrali Cinematic mod. U Cinematic modu se kočioni put letelicaa 
produžava i smanjuje se brzina njegove rotacije. letelica lagano usporava dok se ne zaustavi, 
snimci su glatki i stabilni čak i ako su upravljački ulazi isprekidani. 

 

Napredni pilotski pomoćni sistemi  

 
Funkcija Advanced Pilot Assistance Sistems (APAS) dostupna je u P-režimu. Kada je omogućen 
APAS, vazduhoplov i dalje reaguje na naredbe korisnika i planira svoj put u skladu sa obe 
kontrolne palice i okruženja leta.  

APAS olakšava izbegavanje prepreka, dobijanje glatkih snimaka, i daje bolje iskustvo letenja. 
Kada je omogućen APAS, pritisnite dugme Flight Pause na daljinskom upravljaču ili 
dodirnite    u DJI GO 4 da zaustavite letelicu.  

Letelica lebdi tri sekunde i čeka pilotske komande. Da biste omogućili APAS, tapnite na APAS u 
DJI GO 4.  

Napomene: 

APAS funkcija se automatski isključuje kada se koriste Inteligentni modovi leta i nastavlja se 
automatski nakon izlaska iz Inteligentnih režima leta.  

APAS funkcija je dostupna samo kada letite napred i nazad. Ako letelica leti levo ili udesno, APAS 
je onemogućen.  

Letelica lebdi na mestu kada dođe do prepreke koju je nemoguće izbeći. letelica ne može otkriti i 
izbeći prepreke koje se nalaze ispod njega.  

Obavezno koristite Napredni sistem pomoći pri upravljanju pilotima (APAS) kada su Vision 
Sistems su dostupni. Budite sigurni da nema ljudi, životinja, predmeta sa malim površinama (npr. 
grančice drveta) ili prozirnih predmeta (npr. staklo ili vode) duž željene staze leta.  

APAS možda neće pravilno funkcionisati kada letelice leti nad vodom ili snegom pokrivenim 
područjem.  

Budite posebno oprezni kada letite u izuzetno mračnim (<300 luksa) ili svetlim (> 10 000 luksa) 
okruženjima.  

APAS možda neće pravilno funkcionisati kada letelica leti blizu svojih granica leta ili u GEO 
zonama.  
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Obratite pažnju na statusnu traku letelice u DJI GO 4 i uverite se da letelica radi u APAS-u režim 
normalno.  

Flight Recorder  

Podaci o letu, uključujući telemetriju leta, informacije o statusu letelice i druge parametre, 
automatski su sačuvane u internoj  memoriji letelice. Podacima se može pristupiti pomoću DJI 
Assistant 2 za Mavic. 

Pričvršćivanje i odvajanje propelera  

Mavic 2 Pro / Zoom koristi propelere sa malim nivoom buke. Postoje dve vrste propelera, koje 
su dizajnirani da se vrte u različitim pravcima. 

 Bele oznake se koriste za označavanje koji propeleri idu na koje motore. 

Obeleženi Neobeleženi 

 

 

Stavljaju se na motore sa belim oznakama Stavljaju se na motore bez oznaka 

 

Pričvršćivanje propelera  

Pričvrstite propelere sa belim tragovima na motore sa belim tragovima i neoznačene propelere 
na motore bez oznaka. Pritisnite svaki propeler na motor i okrenite ga dok nije učvršćen.  

 

Odvajanje propelera  

Pritisnite propelere dolje na motore i zakrenite ih u pravcu otključavanja.  

Napomena: 

Lopatice propelera su oštre. Postupati sa pažnjom.  

Koristite samo originalne DJI propelere. Ne mešajte vrste propelera.  

Osigurajte da su svi propeleri u dobrom stanju pre svakog leta.  

Ne koristite stare, okrzane ili slomljene propelere.  
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Proverite da li su propeleri i motori sigurno postavljeni pre svakog leta.  

Da biste izbegli povrede, ne držite se dalje od propelera ili motora kada se vrte. 

Da ne biste oštetili propelere, postavite letelica u pravcu navedenom u nosaču kućišta tokom 
transporta ili skladištenja.  

Ne pritiskajte i ne savijajte propelere.  

Ako je propeler oštećen, to utiče na performanse leta. 

Osigurajte da su motori čvrsto i pravilno rotirani. Spustite letelicu odmah, ako motor je 
zaglavljen i ne može se slobodno okretati.  

Držite motore čiste i bez prašine.  

NE pokušavajte da menjate strukturu motora.  

NE dodirujte i ne dozvolite da vam ruke ili telo dođu u kontakt s motorima nakon leta,  mogu biti 
vrući.  

NEMOJTE blokirati ventilacione rupe na motorima ili na telu letelice.  

Proverite da li je zvuk rada motora normalan kada su uključeni. 

Inteligentna  baterija leta 

Inteligentna baterija Mavic 2 je 15,4 V baterija od 3850 mAh sa pametnim punjenjem / 
pražnjenjem fukncionalnošću. Za punjenje baterije koristite samo odobreni ispravljač napajanja 
od strane DJI. 

 

 

 

 

 

 

 

 

Karakteristike baterije  

1. Prikaz nivoa baterije: LED indikatori prikazuju trenutni nivo baterije. 

2. Funkcija automatskog pražnjenja: Da se spreči bubrenje, baterija se automatski prazni na 
manje od 60% maksimalnog nivoa baterije u praznom hodu duže od 10 dana. Potrebno je 
otprilike tri do četiri dana za pražnjenje baterije na 65%. Normalno je osetiti umerenu toplotu iz 
baterije koje se emituje tokom procesa pražnjenja. 
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3. Balansirano punjenje: Tokom punjenja naponi ćelija baterije se automatski uravnotežuju. 4. 
Zaštita od prekomernog punjenja: Baterija automatski prestaje da se puni  kada se potpuno 
napuni. 

5. Otkrivanje temperature: Baterija se puni samo kada je temperatura između 5 °i 40 ° C. 6. 
Zaštita od prekomerne struje: baterija se prestaje puniti ako se otkrije višak struje. 

7. Zaštita od prekomernog pražnjenja: pražnjenje se automatski zaustavlja radi sprečavanja 
viška pražnjenja. 

8. Zaštita kratkog spoja: Napajanje se automatski prekida ako se otkrije kratki spoj. 

9. Zaštita od oštećenja ćelije baterije: DJI GO 4 prikazuje upozorenje kada je oštećena ćelija 
baterije otkrivena. 

10. Način hibernacije: baterija se isključuje nakon 20 minuta neaktivnosti radi uštede energije. 
Ako je nivo baterije manji od 10%, baterija prelazi u stanje hibernacije da se spreči prekomerno 
pražnjenje. U režimu hibernacije,  indikatori nivoa baterije ne svete. Napunite bateriju da biste je 
probudili iz hibernacije. 

11. Komunikacija: Informacije o naponu, kapacitetu i struji baterije se prenose letelici. 

Napomena: Pre upotrebe pogledajte uputstva za bezbednost inteligentnih baterija leta Mavic 2. 
Korisnici snose potpunu odgovornost za sve operacije i upotrebu.  

 

Korišćenje baterije 

 

 

 

 

 

Provera nivoa baterije 
LED indikatori za nivo baterije prikazuju koliko napunjenosti ostaje. Ako je baterija isključena, 
pritisnite Napajanje dugmeta, a lampice za nivo baterije zasvetle da prikažu trenutni nivo 
baterije  

Uključivanje / Isključivanje  

Pritisnite taster za napajanje jednom, zatim ponovo pritisnite i držite dve sekunde da biste 
uključili ili isključili bateriju.  
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Obaveštenje o niskim temperaturama  

1. Kapacitet baterije se značajno smanjuje pri letenju u okruženjima niske temperature od -10 ° 
do 5 ° C. Preporučuje se letenje letelicom na mestu neko vreme da se zagreje baterija. 
Osigurajte da potpuno napunite bateriju pre poletanja. 

2. Baterije se ne mogu koristiti u ekstremno niskim temperaturama od -10 ° C. 

3. Kada ste u okruženjima niske temperature, završite let čim DJI GO 4 prikaže bateriju sa 
upozorenje nivoa slabe baterije. 

4. Da biste osigurali optimalne performanse baterije, držite temperaturu baterije iznad 20 ° C. 

5. Smanjeni kapacitet baterije u okruženjima sa niskim temperaturama smanjuje brzinu 
reagovanja na vetar letelice. Letite oprezno. 

6. Letite s dodatnim oprezom na velikim visinama iznad mora. 

Napomena: U hladnim sredinama ubacite bateriju u odeljak za baterije i uključite letelicu 
otprilike jednu do dve minute da se zagreje pre poletanja.  

 

Punjenje baterije  

Potpuno napunite Inteligentnu bateriju pre prvog korišćenja:  

1. Priključite ispravljač za napajanje na izvor napajanja (100-240 V, 50/60 Hz). 

2. Priključite inteligentnu bateriju leta na ispravljač za napajanje pomoću kabla za punjenje 
baterije sa isključenom baterijom. 

3. LED indikatori za nivo baterije prikazuju trenutni nivo baterije tokom punjenja. 

4. Inteligentna baterija leta je u potpunosti napunjena kada su sve LED lampe za nivo baterija 
isključene. Odvojite napajanje ispravljača kada je baterija potpuno napunjena. 

Vreme punjenja: 1 sat i 30 minuta.  

Napomena: NE punite inteligentnu bateriju odmah nakon leta jer temperatura baterije može biti 
previše visoka. Sačekajte da se ohladi do sobne temperature pre ponovnog punjenja.  

AC adapter prestaje da puni bateriju ako temperatura baterije nije unutar radnog opsega 5 ° do 
40 ° C.  

Idealna temperatura punjenja je 22 ° do 28 ° C.  

Hub za punjenje baterije (nije uključen) može napuniti do četiri baterije. 
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LED indikatori za nivo baterije tokom punjenja 

 LED 1  LED 2 LED 3 LED 4 

Nivo Baterije LED 
tokom punjenja 

    

Nivo baterije 0%~25% 25%~50% 50%~75%  Napunjena 

 

Zaštita baterije 

LED 2 trepće dva puta u 
sekundi 

Otkriven je preveliki tok 
struje 

LED 2 trepće tri puta u 
sekundi 

Otkriven je kratki spoj 

LED 3 trepće dva puta u 
sekundi 

Otkriven je preveliki tok 
struje 

LED 3 trepće tri puta u 
sekundi 

Otkriven je punjač 
prejakog napona 

LED 4 trepće dva puta u 
sekundi 

Temperatura punjenja je 
preniska 

LED 4 trepće tri puta u 
sekundi 

Temperatura punjenja je 
previsoka 

 

 



 

Interreg – IPA CBC Bulgaria – Serbia Programme  

CB007.2.13.212 

 
 

149 
 

Nameštanje Inteligentne baterije leta 

Umetnite Inteligentnu bateriju leta u odeljak za bateriju letelice. Proverite da li je montirana 
čvrsto, i da su zasunci kliknuli na mesta. 

 

 

 

 

 

 

 

 

 

Uklanjanje inteligentne baterije letenja 

Stisnite reze za bateriju na bočnim stranama Inteligentne baterije leta da biste izvukli bateriju iz 
odeljka za bateriju.  

Napomena: 

Nikada ne stavljajte ili uklanjajte bateriju dok je uključena. Proverite da li je baterija čvrsto 
postavljena. 

Gimbal i kamera  
Gimbal  

Mavic 2 Pro / Zoom tri-osovinski klip pruža stabilizaciju za kameru, omogućavajući vam 
snimanje slike i stabilne slike i video snimke. Gimbal ima opseg nagiba od -90 do +30. Gimbal 
postavke kao što su Gimbal Način rada i Gimbal Auto Calibration mogu se odabrati 
dodirom na .  

Koristite gimbalni kotačić na daljinskom upravljaču za kontrolu nagiba kamere. Alternativno, 
udjite u prikaz kamere u DJI GO 4. Pritisnite ekran dok se ne pojavi plavi krug i povucite krug 
gore ili dole da biste upravljali nagibom kamere. Prevlačenjem kruga ulevo i udesno kontroliše 
orijentaciju letelice.  

Način rada Gimbala  

Dostupna su dva načina rada gimbal. Prelazite između različitih režima rada na stranica sa 
podešavanjima kamere za DJI GO 4.  

Follow režim: Ugao između orijentacije cilindra i nosa letelicaa uopšte ostaje konstantan svo 
vreme. 
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FPV režim: Gimbal se sinhronizuje sa kretanjem letelicaa, kako bi pružio pogled iz prvog lica 
tokom lete.  

Napomena: Kad se letelica uključuje, ne tapkajte i ne kucajte po gimbal. Da bi zaštitili gimbal 
tokom polijetanja, uvijek uzlijetanje s otvorenog i ravnog tla.  

Precizni elementi na gimbalu mogu se oštetiti prilikom sudara ili udara, što može prouzrokovati 
da gimbal ne funkcioniše normalno.  

Izbegavajte da dođe do prašine ili peska na gimbalu, posebno kod gimbal motora.  

Greška gibalnog motora može se pojaviti u sledećim situacijama:  

a. Letelica je na neravnom terenu ili je kretanje ometeno.  

b. Gimbal doživljava prekomernu spoljnu silu, kao na primer tokom sudara. NE primenjujte 
spoljnu silu na gimbal nakon što je gimbal uključen. NE dodajte nikakve dodatno opterećenje 
gibala jer to može dovesti do nepravilnog funkcionisanja ili čak do trajnog oštećenja motora.  

Pre uključivanja letelice, obavezno uklonite zaštitni poklopac. Takođe obavezno montirajte 
zaštitni poklopac kada se letelica ne koristi.  

Letenjem u gustoj magli ili oblacima gimbal može da postati vlažan, što dovodi do privremenog 
otkaza. Gimbal se vraća u punu funkcionalnost kada se osuši.  

Kamera  

Mavic 2 Pro koristi 1 " CMOS senzor (koji su zajednički razvili DJI i Hasselblad) poseduje 
objektiv podesivog otvora sa opsegom F2.8-F11. Kamera podržava automatsko fokusiranje, koji 
se može fokusirati od 1 m do beskonačnosti. Filteri na kameri se mogu zameniti. Mavic 2 Pro 
kamera snima do 4K30fps video zapisa i 20 MP fotografije, podržava režime snimanja kao što 
su Single shot, Burst, Interval, Panorama, usporeni prikaz i poboljšani HDR.  

Mavic 2 Zoom koristi 1 / 2.3 "CMOS senzorsku kameru, podržava 2k optičko zumiranje, a 
objektiv je 24-48 mm (ekvivalent 35 mm). Kamera podržava automatsko fokusiranje, koje se 
može fokusirati od 0,5 m do beskonačnost. Kamera takođe podržava zamenu filtera. Mavic 2 
Zoom kamera snima do 4K30fps video i 12 megapiksela fotografije, podržava režime snimanja 
kao što su Single shot, Burst snimanje, Interval, Panorama, usporeni pokret i poboljšani HDR. 
Mavic 2 Zoom podržava 2k optičko zumiranje i 2k digitalno zumiranje tokom snimanja videa u 
1080p24 / 25/30. 

 

Napomena: Uverite se da su temperatura i vlaga pogodni za fotoaparat tokom korišćenja i 
skladištenja. 

Za čišćenje sočiva koristite sredstvo za čišćenje sočiva da biste izbegli oštećenja.  

NEMOJTE blokirati nikakve ventilacione rupe na fotoaparatu jer proizvedena toplota može 
oštetiti uređaj i povrijediti korisnika.  
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Čuvanje fotografija i video zapisa  

Mavic 2 Pro / Zoom dolazi sa 8 GB interne memorije i takođe podržava upotrebu microSD-a 
kartica za čuvanje fotografija i video zapisa. Zbog toga je potrebna microSD kartica sa ocenom 
brzine UHS-I brzine 3 brzine čitanja i pisanja koje su potrebne za video podatke visoke 
rezolucije. 

Napomena: Ne uklanjajte microSD karticu iz letelice dok je uključena. U protivnom, microSD 
kartica može biti oštećena.  

Da bi se osigurala stabilnost sistema kamere, pojedinačni video snimci ograničeni su na 30 
minuta.  

Pre upotrebe proverite podešavanja kamere da biste bili sigurni da su konfigurisana po želji.  

Pre snimanja važnih slika ili video zapisa, snimite nekoliko slika da biste proverili da kamera radi 
tačno.  

Fotografije ili video snimci se ne mogu preneti ili kopirati iz kamere ako je Inteligentna baterija 
leta isključena.  

Obavezno ispravno isključite Inteligentnu bateriju leta. U suprotnom, parametri vaše kamere 
NEĆE biti sačuvani i snimljeni video snimci mogu biti oštećeni. 

Bez obzira na razlog, DJI nije odgovoran za bilo koji neuspeh da se slika ili video snima ili ne 
snima na način koji nije lako čitljiv.  

Video Editovanje 

Mavic 2 Pro podržava video formate MP4 i MOV, pružajući  Normal, D-Log i HLG boju režime. U 
normalnom režimu su podržani formati kodova H.264 i H.265. Samo u režimu D-Log ili HLG 
Podržana je H.265.  

Za Mavic 2 Pro, Full FOV smanjuje uzorke sa 5,5K senzora na rezoluciju 4K dok HV sužava 
centar za bolji kvalitet slike, ali manje FOV.  

Potpuni FOV prikaz je 75 °, a HK pogled 55 °. Možete da izaberete između njih u skladu sa 
stvarnim zahtevima za fotkografisanje.  

Mavic 2 Zoom podržava video formate MP4 i MOV, pružajući normalne i D-Cine režime. 
Podržani su formati kodova H.264 i H.265. 

 

DJI je testirao sledeće softvere i preporučuju se za reprodukciju ili uređivanje video zapisa. 

Software Mac Version Win Version 

Adobe Premier Pro CC 2018 v12.1.1 (10) v12.1.1 (10) 

DaVinci Resolve v15.0 free v14.3 Studio 

Apple Final Cut Pro Ks v10.4.3 N/A 

Apple QuickTime v10.4 (928.5.1) N/A 
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Apple iMovie v10.4.2 N/A 

VLC Player v3.0.2 v3.0.2 

 

Ispravljanje video distorzije  

Mavic 2 Pro i Mavic 2 Zoom snimaju 8-bitne video zapise, istovremeno automatski ispravljajući 
distorziju video zapisa koje se obično nalaze u medijumu.  

Međutim, samo Mavic 2 Pro može snimati 10-bitne video zapise. 10-bitni video snimci su glatkiji 
od 8-bitnih video zapisa, što je korisno za post-produkcijsku modulaciju u boji.  

Molimo vas imajte na umu da automatska korekcija izobličenja videa nije dostupna za 10-bitne 
video snimke na Mavic 2 Pro.  

Na raspolaganju je nekoliko softverskih programa za ispravljanje izobličenja video zapisa, kao 
što je DaVinci Resolve, Adobe Premiere i Apple Final Cut Pro Ks.  

Video snimci različitih rezolucija imaju različite tipove distorzija.  

U tabeli ispod prikazane su preporučene vrednosti za ispravljanje izobličenja kada se koriste 
različiti softveri. 

 Imajte na umu da će se ispravljanjem izobličenja ukupni kvalitet videa smanjiti. 

 DaVinci Resolve Adobe Premiere* Apple Final Cut Pro X 

HQ 0.180 -4 0.02 

Full FOV 0.245 -9 0.05 

2.7K 0.240 -8 0.05 

FHD 1080 24/25/30/48/60 0.245 -9 0.05 

FHD 120P 0.180 -4 0.02 

 

* Adobe Premiere koristi unapred podešene parametre za korekciju izobličenja. Korisnici ne 
moraju da ručno unose vrednost 

Daljinski upravljač  
Ovaj odeljak opisuje funkcije daljinskog upravljača i uključuje uputstva za kontrolu letelice i 
kamere. 
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Daljinski upravljač  

U daljinski upravljač ugrađena je DJI-jeva tehnologija daljinskog prenosa OcuSinc 2.0, koja nudi 
maksimalni domet prenosa od 8 km i prikazivanje videa iz letelicua do DJI GO 4 na vaš mobilni 
uređaj rezolucije do 1080p.  

Lako upravljajte letelicom i kamerom pomoću dugmadi na upravljaču. Uključeni LCD ekran daje 
podatke o letelici u stvarnom vremenu i lako odvojive upravljačke palice daljinski upravljača 
omogućuju da se upravljač lakše čuva.  

U široko otvorenom prostoru bez elektromagnetnih smetnji, OcuSinc 2.0 nesmetano prenosi 
video veze brzinom do 1080p, bez obzira na to kako se menja stav leta.  

Daljinski upravljač radi u dva režima, 2.4 GHz i 5,8 GHz, automatski birajući najbolji kanal 
prenosa. OcuSinc 2.0 smanjuje kašnjenje do 120-130 ms poboljšanjem performansi kamere 
putem algoritma za dekodiranje video zapisa i bežične veza.  

Automatski fokus se podržava tokom snimanja čak i pri slabom osvetljenju. Mavic 2 Pro 
podržava podešavanje blende i zatvarača, a Mavic 2 Zoom podržava zumiranje pomoću 
uvećanja Brojčanikom za podešavanje. 

Ugrađena baterija ima kapacitet od 3950 mAh i maksimalno vreme rada 2 sata i 15 minuta. 
Daljinski upravljač puni mobilni uređaj s mogućnošću punjenja od 500 mA @ 5V. Daljinski 
kontroler automatski puni Android uređaje. Za iOS uređaje prvo budite sigurni da je punjenje 
omogućeno u DJI GO 4. Punjenje za iOS uređaje je podrazumevano onemogućeno i mora biti 
omogućeno svaki put daljinski upravljač je uključen.  

Upotreba daljinskog upravljača  

Pritisnite taster za napajanje da biste prikazali trenutni nivo baterije na LCD ekranu. Pritisnite 
jednom, a zatim ponovo, i držite za uključivanje ili isključivanje daljinskog upravljača. 

 

 

 

 

 

 

Punjenje baterije  

Priključite isporučeni ispravljač za napajanje na priključak za napajanje na daljinskom 
upravljaču. Potrebno je otprilike 2 sata i 15 minuta da se potpuno napuni baterija daljinskog 
upravljača. Uklonite RC kabl sa daljinskog upravljača pre punjenja. 
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Kontrola kamere  

Upotrijebite kotačić za podešavanje blende / okidača (Aperture/Shutter Adjustment Dial) za 
podešavanje parametara blende i zatvarača (Mavic 2 Pro samo).  

Upotrebite dugme za snimanje (Record button) za pokretanje / zaustavljanje snimanja. 

 Pomoću dugmeta Fokus / Okidač (Focus/Shutter )automatski  fokusirate i fotografišete. 
Koristite dugme za podešavanje zuma (Zoom Adjustment Dial) da biste zumirali  (samo Mavic 2 
Zum). 

 

 

 

 

 

 

Kontrola letelice  
Upravljačke palice kontrolišu orijentaciju ( yaw ) zrakoplova, kretanje naprijed / nazad ( pitch ), 
visinu (trottle) i kretanje ulevo / udesno (roll).  

Režim upravljana palicama određuje funkciju svakog pokreta palice.  

Dostupna su tri unapred programirana režima (režim 1, režim 2 i režim 3) i prilagođeni modovi 
se mogu konfigurisati u DJI GO 4. Podrazumevani režim je režim 2.  

U svakom od tri unapred programirana režima, Mavic 2 lebdi u mestu sa stalnom orijentacijom 
kada su obe palice centrirane.  

Gurajući kontrolnu palicu dalje od srednjeg položaja obavlja se funkcija prikazana na slici ispod: 

 

Left stick – leva palica 
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Right stick – desna palica 
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Daljinski Upravljač  Označava smer nosa Primedbe 

 

 

Pomicanjem leve palice gore ili 
dole menjate visinu letelice. 
Gurnite palicu gore da se 
popnete i dole da se spustite. 
Što je više palica gurnuta dalje 
od centra, brže će letelica 
promeniti visinu. Uvek gurajte 
palicu lagano  da sprečite 
iznenadnu i neočekivanu 
promenu visine. 

 

 

Pomicanje leve palice ulevo ili 
udesno komanduje 
orijentacijom letelice. Gurnite 
štap ulevo da rotirate letelicu u 
smeru suprotnom od kazaljke 
na satu i udesno da rotirate 
letelicu u smeru kazaljke na 
satu. Što je više palica gurnuta 
dalje od centra, brže će se 
letelica okretati. 

  Pomicanjem desne palice gore-
dole menjate nagib nosa 
letelice. Gurnite unapred palicu 
da poletite napred i nadole da 
letite unazad. Što je više palica 
gurnuta dalje od centra, brže će 
se letelica kretati. 

  Pomicanje desne palice ulevo 
ili udesno menja se nagib krila 
letelice. Gurnite palicu ulevo da 
letite levo i udesno da letite 
desno. Što se više palica gura 
dalje od srednjeg položaja, to 
će se brže  letelica kretati. 

 

Napomena: Preporučuje se da uklonite upravljačke palice i odložite ih u otvore za skladištenje 
na daljinskom upravljaču. 
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Prekidač za režim leta  

Prebacite prekidač za odabir željenog načina leta.  

Režim pozicionog leta  

S S-režim 

P P-režim 

T T-režim 

 

Bez obzira u kom se položaju prekidač nalazi na daljinskom upravljaču, Mavic 2 Pro / Zoom 
počinje u P-modu podrazumevano.  

Za promenu načina letenja, prvo idite na prikaz kamere u programu DJI GO 4, tapnite na   i 
omogućite „Višestruki načini leta“ (“Multiple Flight Modes”). Nakon toga, prebacivanjem 
prekidača na P, a zatim na S ili T na menjajte načine letenja. 

RTH dugme  

Pritisnite i držite taster RTH za pokretanje postupka Povratak kući (RTH) gde se letelica vraća 
do poslednje zabeležene početne tačke. Ponovo pritisnite ovo dugme da biste otkazali RTH i 
vratili kontrolu nad letelicom. Pogledajte odeljak Povratak na početnu tačku za više informacija o 
RTH. 

 

 

 

 

 

 

 

 

 

Dugme C1 i C2  

Funkcije tastera C1 i C2 se podešavaju u DJI GO 4. Zadana konfiguracija za dugme C1 je 
Središnji fokus, a zadana konfiguracija za C2 taster je Reprodukcija.  

 

Upozorenje daljinskog upravljača  

Daljinski upravljač oglašava upozorenje tokom RTH ili kada je nivo baterije nizak (6% do 15%). 
RTH i nizak nivo upozorenje za bateriju može se otkazati pritiskom na dugme za napajanje. 
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Upozorenje o kritičnom nivou baterije (manje od 6%), međutim, ne može se otkazati. Optimalna 
zona prenosa  

Signal između letelice i daljinskog upravljača najpouzdaniji je kada su antene postavljene u 
odnosu na letelicu kao što je prikazano u nastavku. 

 

 

 

LCD ekran  

LCD ekran prikazuje različita stanja sistema, uključujući telemetriju leta u stvarnom vremenu i 
nivoe baterije. Pogledajte donju sliku za značenje svake ikone na LCD ekranu. 

GPS signal strength - Snaga GPS signala 
Aircraft battery level- Nivo beterije letelice 
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System status prompt – sistemski prompt 
Flight mode* - Režim leta * 
RC signal strength - Jačina RC signala 
Motor rotation speed – Brzina rotacije motora 
RC battery level - Nivo baterije RC 
Distance to the ground - Udaljenost od zemlje 
Flight distance - Dužina leta 
Exposure compensation - Kompenzacija ekspozicije 
Flight altitude – Visina leta 

 

Povezivanje daljinskog upravljača  

Daljinski upravljač povezan je sa vašom letelicom pre isporuke. Povezivanje je potrebno samo 
kada koristite novi daljinski upravljač po prvi put. Sledite ove korake za povezivanje novog 
daljinskog upravljača:  

1. Uključite letelicu i daljinski upravljač. 

2. Pokrenite DJI GO 4. 

3. Unesite "Camera" i dodirnite a zatim tapnite na dugme     da biste ga potvrdili. Daljinski 
upravljač je spreman za povezivanje. 

4. Pronađite dugme za vezu na boku letelice, kao što je prikazano na slici ispod. Pritisnite vezu 
dugme za početak povezivanja. Pokazatelj povezivanja statusa prikazuje potpuno zelenu boju 
nakon što je daljinski upravljač uspešno povezan sa letelicom, a LCD ekran na daljinskom 
upravljaču prikazuje  informacije o letelici. 

 

 

 

 

 

 

Osigurajte da je daljinski upravljač unutar 0,5 m radijausa od letelice tokom veze.  

Daljinski kontroler će prekinuti vezu sa letelicom ako se novi daljinski kontroler poveže na istu 
letelicu.  

Napomena: Potpuno napunite daljinski upravljač pre svakog leta.  

Ako je daljinski upravljač uključen i NE koristi se pet minuta, oglasiće se upozorenje. Nakon 10 
minuta, automatski će se isključiti. Pomerite palice da biste otkazali uzbunu.  

Podesite stezanje mobilnog uređaja da biste osigurali da je mobilni uređaj siguran. 
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Proverite da li su antene daljinskog upravljača razvučene i prilagođene na odgovarajući položaj 
postizanje optimalnog kvaliteta prenosa.  

Popravite ili zamenite daljinski upravljač ako je oštećen. Oštećena antena daljinskog upravljača 
uveliko smanjuje performanse.  

Bateriju punite najmanje jednom u tri meseca da biste održali zdravlje baterije.  

Osigurajte da su upravljačke palice pravilno montirane. 

 

DJI GO 4 App  
U ovom odeljku predstavljene su glavne funkcije DJI GO 4 aplikacije. 

Ova aplikacija se koristiti za kontrolu gimbala, kamere i drugih funkcija letelice. Aplikacija sadrži 
Oprema (Equipment,), Editor, SkyPixel i Me sekcije koji se koriste za konfigurisanje letelice, te 
za uređivanje i deljenje svojih fotografija i video zapisa sa drugima.  

Oprema  

Meni uređaja  

Ako već nije odabran, izaberite Mavic 2 Pro / Zoom iz menija uređaja u gornjem levom uglu 
ekrana.  

Funkcijski meni  

Kliknite      u  gornjem desnom uglu ekrana da biste otvorili meni Funkcija. Meni ima pet opcija:  

Skeniraj QR kod: Skenirajte QR kod da biste se povezali sa letelicom. 

Akademija: Koristite simulator leta, gledajte tutorijale i čitajte uputstva za proizvod.  

Flight Records: Pristupite svim podacima o letu.  

GEO zone: Pročitajte informacije o GEO zonama.  

Find My Drone: Nabavite koordinate mapa poslednje snimljene lokacije vašeg letelice i 
komandujte letelicom da treperi svojim LED diodama i ispušta zvučni signal.  

Camera Viev  

Uđite u prikaz kamere na ekranu Oprema sa vašim mobilnim uređajem povezanim na letelicu. 
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1. Traka statusa sistema 

 Ova ikona označava status leta letelice i prikazuje razne poruke upozorenja.  

2. Status detekcije prepreka 

 Crvene trake se prikazuju kada su prepreke blizu letelice. Narandžaste trake se prikazuju kada 
su prepreke u dometu otkrivanja. 

3. Traka indikatora nivoa baterije 

Indikator nivoa baterije omogućava dinamičan prikaz nivoa baterije. Obojene zone na indikatoru 
nivoa baterije predstavljaju nivoe snage potrebne za obavljanje različitih funkcija.  

4. Režim leta 

Tekst pored ove ikone označava trenutni način letenja. Tapnite da biste konfigurisali postavke 
kontrolera leta. Ova podešavanja vam omogućavaju da izmenite ograničenja leta i postavite 
nove vrednosti. 

5. Parametri kamere 

Prikazuje parametre kamere i kapacitet interne memorije i microSD kartice. 

 Mavic 2 Pro: Prikazuje parametre kamere i kapacitet interne memorije i microSD kartice.     
Takođe prikazuje parametre fokusa.  
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 Mavic 2 zum: Prikazuje parametre kamere i kapacitet interne memorije i microSD kartice. 
Takođe prikazuje režim fokusiranja kamere, AE vrednost i parametre fokusa.  

6. Snaga GPS signala 

Prikazuje trenutnu jačinu GPS signala. Bele trake označavaju odgovarajuću snagu GPS-a. 

7. Status Vision sistema 

Dodirnite ovo dugme da biste omogućili ili onemogućili funkcije koje pružaju Vision sistemi, a 
ono će prikazati status za sve Vision sisteme . Zelena ikona označava da je odgovarajući Vision 
sistem dostupan. Crvena ikona označava da odgovarajući Vision sistem nije dostupan. 

8. Signal daljinskog upravljača 

Ova ikona prikazuje jačinu signala daljinskog upravljača. Ikona će treptati kada se primete 
smetnje tokom leta. Kada u DJI GO 4 nema dodatnih upozorenja, to znači da smetnje neće 
uticati na rad i opšte iskustvo leta. 

9. Snaga HD video veze 

Ova ikona prikazuje snagu HD video veze između letelice i daljinskog upravljača. Ikona će 
treptati kada se tokom leta prepozna smetnja. Kad nema dodatnih upozorenja u DJI GO 4, 
znači da smetnja neće uticati na rad i ukupni iskustvo leta. 

10. Podešavanja baterije 

Prikazuje trenutni nivo baterije. Tapnite da biste pogledali meni sa informacijama o bateriji, 
podesili različite pragove upozorenja ili pregledali istoriju upozorenja za bateriju. 

11. Dugme za fokusiranje / merenje 

Dodirnite za prelazak između režima fokusiranja i merenja. Kucnite za odabir objekta za 
fokusiranje ili merenje. Automatsko fokusiranje bez prestanka će se automatski aktivirati u 
skladu sa statusom letelice i kamere nakon omogućavanja automatskog fokusiranja. 

12. Opšte postavke 

Dodirnite za ulazak u meni „Opšta podešavanja“ da biste podesili merne jedinice, omogućili / 
onemogućili livestream i podesite postavke prikaza rute leta. 

13. Zaključavanje automatske ekspozicije 

Dodirnite da biste zaključali vrednost ekspozicije. 

14. Gimbal klizač 

Prikazuje ugao nagiba gimbala. 

15. Foto / video preklopnik 

Dodirnite za prebacivanje između režima za snimanje fotografija i video zapisa. 
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16. Dugme za fotografisanje / snimanje 

Dodirnite za početak snimanja fotografija ili snimanja video zapisa. 

17. Podešavanja kamere  

Dodirnite da biste ušli u meni „Podešavanja kamere“. 

Dodirnite      da biste podesili ISO postavke fotoaparata, okidača i automatsku ekspoziciju 
fotoaparata.  

Dodirnite       za odabir načina snimanja fotografija. Mavic 2 podržava Single Shot, Burst Shot, 
Interval Snimanje i razne panoramske režime.  

Dodirnite       za otvaranje menija Opšte postavke kamere.  

18. Reprodukcija 

Dodirnite da uđete u Reprodukciju i pregledate fotografije i video zapise čim ih snimite. 

19. Letna telemetrija 

D 30M: Udaljenost između letelice i matične tačke.  
H 10,0M: Visina od matične tačke.  
HS 10.0M / S: horizontalna brzina letelice.  
VS 2.0M / S: Vertikalna brzina letelice.  

20. Mapa 

Dodirnite da biste videli mapu 

 

 

 

 

21. Napredni pilotski sistemi za pomoć 

Dodirnite da biste omogućili / onemogućili funkciju APAS. APAS funkcija je onemogućena ako 
su Prednji i Zadnji Vision Sistemi  onemogućeni ili nedostupni.  

22. Inteligentni modovi leta 

Dodirnite za odabir Inteligentnih režima leta.  

23. Smart RTH 

Dodirnite da biste pokrenuli Smart RTH i vratili letelicu u poslednju snimljenu početnu tačku.  

24. Automatski polijetanje / slijetanje 

Kucnite za pokretanje automatskog poletanja ili sletanja.  
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25. Nazad 

Dodirnite za povratak u glavni meni.  

Napomena: Imajte na umu sledeće kada koristite režim Panorama:  

Koristite režim panorame u statičkoj sceni. Ako se subjekt pomera tokom snimanja, finalna 
panorama fotografija može izgledati nenormalno.  

Upotrebite Panoramu u široko otvorenom području i snimajte na visini od 5 m ili više. 

Upotrebite Panoramu u području s mnogo objektima i izbegavajte snimanje iznad vode ili 
snega.  

Koristite Panoramu kada letelica može da lebdi u mestu mirno. Ne koristite ovaj način rada  
kada leti pod jakim vetrom.  

Editor 

Inteligentni video editor ugrađen je u DJI GO 4. Nakon snimanja nekoliko video klipova i 
preuzimanja na mobilnom uređaju, idite na Editor na početnom ekranu. Zatim možete da 
izaberete predložak i određeni broj klipova koji se automatski kombinuju da bi se stvorio kratak 
film koji se može deliti odmah.  

SkyPixel  

Pregledajte i delite fotografije i video zapise na stranici SkyPixel.  

Ja  

Ako već imate DJI nalog, moći ćete da učestvujete u raspravama na forumu i delite svoje 
kreacije sa zajednicom. 

Napomena: 

Obavezno napunite svoj mobilni uređaj pre nego što pokrenete DJI GO 4.  

Mobilni internet podaci su potrebni kada koristite DJI GO 4. Molimo kontaktirajte svog mobilnog 
operatera za cenu prenosa podataka.  

Ako koristite telefon kao svoj mobilni ekran, NE prihvatajte telefonske pozive i ne koristite  
funkcije slanja poruka tokom leta.  

Pažljivo pročitajte sve bezbednosne savete, poruke upozorenja i odricanja. Budite upoznati sa 
srodnim propisima u vašoj oblasti. Vi ste jedini odgovorni za upoznavanje svih relevantnih 
propisa i letenja na način koji je u skladu sa istima.  

a. Pročitajte i shvatite poruke upozorenja pre upotrebe automatskog poletanja i automatskog 
sletanja.   

b. Pročitajte i shvatite poruke upozorenja i odricanje odgovornosti pre postavljanja nadmorske 
visine iznad podrazumevanih vrednosti. 
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c. Pročitajte i shvatite poruke upozorenja i odricanje odgovornosti pre prelaska između režima 
leta. 

d. Pročitajte i shvatite poruke upozorenja i odricanja odgovornosti u blizini ili u zonama 
nedostupnosti. 

e. Pročitajte i shvatite poruke upozorenja pre upotrebe Inteligentnih režima leta.  

Spustite svoj letelicu odmah na sigurnu lokaciju ako se u aplikaciji pokaže upozorenje. 

Pregledajte sve poruke upozorenja na kontrolnom spisku koji se prikazuje u aplikaciji pre 
svakog leta.  

Upotrebite simulator u aplikaciji za vježbanje svojih veština leta ako nikad niste upravljali 
letelicom ili ako nemate dovoljno iskustva da pouzdano upravljate letelicom.  

Način početnik je podrazumevano omogućen kada prvi put pokrenete aplikaciju. Visina ii 
udaljenost leta su ograničeni pri letenju u početničkom režimu. 

Preporučujemo vam let u početničkom režimu za usavršavanje letačkih veština. Početni režim 
onemogućite samo kada možete da letite letelicom sa samopouzdanjem.  

Keširajte podatke mape područja u kojem namjeravate leteti letlicom povezujući se s internetom 
pre svakog leta.  

Aplikacija je osmišljena da vam pomogne u radu. Molimo vas da koristite svoje logičko 
rasuđivanje i NE oslanjajte se na aplikaciji za kontrolu vaše letelice. 

Vaša upotreba aplikacije podleže DJI GO 4 Uslovima korišćenja i Politici privatnosti DJI-ja. 
Molimo pročitajte ih pažljivo u aplikaciji. 

Let 
Nakon završetka pripreme za let, preporučuje se upotreba simulatora leta u DJI GO 4 da 
ojačajte svoje veštine letenja i vežbate bezbedno letenje.  

Osigurajte da se svi letovi obavljaju na otvorenom.  

Pogledajte odeljke za daljinski upravljač i DJI GO 4 za informacije o korišćenju daljinskog 
upravljača i aplikaciju za kontrolu letelice.  

Zahtevi za bezbedan let 

1. Ne koristite letelicu u teškim vremenskim uslovima, uključujući brzine vetra veće od 10 m / s, 
sneg, kiša i magla. 

2. Letite na otvorenim prostorima. Visoke konstrukcije i velike metalne konstrukcije mogu uticati 
na tačnost kompasa i GPS sistem. 

3. Izbegavajte prepreke, gužve, visokonaponske vodove, drveće i vodene površine. 

4. Smanjite smetnje izbegavajući područja sa visokim nivoom elektromagnetizma, kao što su 
lokacije u blizini dalekovoda, bazne stanice, električne podstanice i tornjeve za emitovanje. 
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5. Performanse letelice i baterije podležu faktorima okruženja, kao što su gustina vazduha i 
temperatura. Budite vrlo oprezni kada letite od 6000 m i više nadmorske visine, baterije i  
performanse letelice mogu biti smanjene. 

6. Mavic 2 ne može koristiti GPS unutar polarnih područja. Koristite nadole Vision sistem tokom 
letenja na takvim lokacijama. 

Granice leta i GEO zone  

Pridržavajte se svih zakona i propisa tokom leta Mavic 2 Pro / Zoom.  

Ograničenja leta primjenjuju se kao podrazumevane da pomognu korisnicima da pravljaju ovim 
proizvodom sigurno i legalno.  

Ograničenja leta uključuju ograničenja visine, ograničenja rastojanja i GEO zone.  

Granice visine, ograničenja rastojanja i GEO zone istovremeno rade kada je u pitanju sigurnost 
leta tokom leta u P-režimu.  

Visina leta i ograničenja rastojanja  

Granice visine leta i granice udaljenosti mogu se promeniti u DJI GO 4. Podešavanje 
maksimalne visine leta ne može da pređe 500 m. Na osnovu ovih podešavanja, letelica će leteti 
u ograničenom cilindru, kao što je prikazano ispod: 

 

 

 

 

 

 

 

 

 

 

GPS signal jak    Trepće zeleno 

 Ograničenje leta DJI GO 4 App Indikator statusa 
letelice 

Maksimalna visina Visina letelice ne može da 
prelazi navedenu vrednost 

Upozorenje: Visina 
dostignut limit. 

N/A 

Maksimalno 
rastojanje 

Udaljenost leta mora biti unutar 
maksimalnog radijusa 

Upozorenje: Udaljenost 
dostignut limit 

N/A 

GPS signal slab   Treperi žuto 
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Maksimalna visina Visina je ograničena na 5 m 
kada je GPS signal slab i 
nadole Vision Sistem aktiviran.  
Visina je ograničeno na 30 m 
kada je GPS signal slab i  
nadole  Vision Sistem je 
neaktivan 

Upozorenje: Granica 
visine dostignuta 

N/A 

Maksimalna 
udaljenost 

Bez ograničenja   

 

Napomena: Ako letelica dosegne jedno od ograničenja, i dalje možete da upravljate letelicom, 
ali ne možete leteti dalje. Ako letelica leti izvan maksimalnog radijusa, automatski će leteti 
nazad unutar dometa kada je GPS signal jak. Iz bezbednosnih razloga nemojte leteti u blizini 
aerodroma, autoputa, železničkih stanica, železničkih linija, gradskog centra ili drugih osetljivih 
područja. Letite letelicom samo unutar vašeg vidnog polja. 

GEO zone  

Sve GEO zone navedene su na zvaničnoj veb lokaciji DJI na adresi http://vvv.dji.com/flisafe. 
GEO zone su podeljeni u različite kategorije i obuhvataju lokacije kao što su aerodromi, 
granicama između zemalja i na osetljivim lokacijama poput elektrana. 

Kontrolna lista pre leta 

1. Osigurajte da su uređaj za daljinsko upravljanje, mobilni uređaj i Inteligentna baterija leta 
potpuno napunjeni. 

2. Uverite se da je inteligentna baterija leta i propeleri pravilno postavljeni. 

3. Osigurajte da su propeleri letelice razvučeni. 

4. Osigurajte da gimbal i kamera rade normalno. 

5. Osigurajte da ništa ne ometa motore i da rade normalno. 

6. Uverite se da je DJI GO 4 uspešno povezan sa avionom. 

7. Osigurajte da su objektiv kamere i senzori Vision Sistema čisti. 

8. Koristite samo originalne DJI delove ili delove koje je sertifikovao DJI. Neovlašćeni delovi ili 
delovi koji nisu iz DJI-ja sertifikovanih proizvođača mogu uzrokovati kvarove na sistemu i 
ugroziti sigurnost. 

 

Automatski poletanje / sletanje  

Automatski polijetanje  

1. Pokrenite DJI GO 4 i tapnite na „GO FLY“ da biste ušli u Camera View. 

2. Ispunite sve korake na kontrolnoj listi pre leta.  
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3. Dodirnite      . 

4. Ako su uslovi sigurni za poletanje, pomerite klizač da biste ga potvrdili. Letelica će uzleteti i 
lebdeti 1,2 m iznad zemlje. 

Napomena: 

Indikator statusa letelice pokazuje da li letelica koristi GPS i / ili nadole Vision sistem za kontrolu 
leta. Više informacija potražite u odeljcima LED-a za letelicu i statusne indikatore. Preporučuje 
se da se sačeka dok GPS signal ne bude jak pre korišćenja automatskog poletanja.  

Automatsko sletanje  

Automatsko sletanje koristite samo ako indikator statusa letelice treperi zeleno. Sledite dole 
navedene korake da biste koristili funkciju automatskog sletanja:  

1. Kucnite       . 

2. Ako su uslovi sigurni za sletanje, kliznite klizač da biste ga potvrdili. Letelica će započeti 
proceduru automatskog sletanja. Upozorenja će se pojaviti u DJI GO 4 ako letelica utvrdi da 
uslovi nisu prikladni za prizemljenje. Obavezno reagujte odmah. 

Napomena: Automatsko sletanje može se prekinuti odmah dodirom na ekran u DJI GO 4 
aplikaciji. 

 

Pokretanje / zaustavljanje motora  

Pokretanje motora  

Za pokretanje motora koristi se komanda kombinovane palice (CSC). Obe palice gurnite prema 
unutrašnjin ili spoljnim donjim uglovima za pokretanje motora. Jednom kada se motori počnu 
vrteti, otpustite obe palice istovremeno.  

 

 

 ili 

 

 

Zaustavljanje motora 

Postoje dva načina za zaustavljanje motora:  

1. metod: Kada se avion spusti, pritisnite i držite levi štap dole. Motori se zaustavljaju nakon tri 
sekunde 

2. metod : Kada avion sleti, sprovedite isti CSC koji je korišćen za pokretanje motora, kao što je 
opisano gore. Motori se odmah zaustavljaju. Otpustite obe palice nakon što motori stanu. 
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   Metod 1    Metod 2 

Zaustavljanje motora usred leta  

Zaustavljanje motora usred leta uzrokovaće pad letelice. Motori se smeju zaustaviti usred  leta u 
vanrednim situacijama kao što je sudar, motor je zastao, letelica se kotrlja u vazduhu ili je 
letelica izvan kontrole i brzo se uspinje / spušta. Za zaustavljanje motora sredinom leta, koristite 
isti CSC koji je korišten za pokretanje motora.  

Probni let  

Postupci poletanja / sletanja  

1. Postavite letelicu na otvorenom, ravanom prostoru tako da je indikator statusa letelice 
okrenut prema vama. 

2. Uključite letelicu i daljinski upravljač. 

3. Pokrenite DJI GO 4 i uđite u Viev Camera. 

4. Sačekajte dok indikator statusa letelice trepće zeleno, što označava da je matična tačka 
zabeležena i sada je sigurno leteti. 

5. Nežno pritisnite papučicu gasa da biste poleteli ili koristili automatsko poletanje. 

6. Povucite ručicu gasa ili koristite auto-sletanje da biste spustili letelicu. 

7. Isključite letelicu i daljinski upravljač. 

Video predlozi i saveti  

1. Kontrolna lista pre leta je osmišljena kako bi vam pomogla da sigurno letite i osigurate 
snimanje videa tokom leta. Pre svakog leta prođite kroz punu kontrolnu listu. 

2. Izaberite željeni režim rada gimbala u DJI GO 4. 

3. Snimajte video samo kada letite u P-režimu ili T-režimu. 

4. NE letite u lošim vremenskim uslovima, poput kiše ili vetra. 

5. Izaberite podešavanja kamere koja najbolje odgovaraju vašim potrebama. Podešavanja 
uključuju format fotografije i ekspoziciju. 

6. Izvršite testove leta kako biste utvrdili rute leta i pregledali scene. 

7. Lagano gurnite upravljačke palice kako bi kretanje letelice bilo glatko i stabilno. 
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Kalibracija kompasa  

Preporučuje se da se kompas kalibriše u bilo kojoj od sledećih situacija kada letite napolju: 1. 
Leteći na lokaciji udaljenoj 50 km (50 km) od mesta na kome je dron poslednji put leteo.  

2. Letelica nije letela duže od 30 dana. 

3. U DJI GO 4 i / ili indikatori statusa vazduhoplova trepere kao upozorenje o smetnji kompasa 
naizmenično crveno i žuto. 

NE kalibririšite kompas na mestima na kojima mogu da se jave magnetne smetnje, na primer u 
blizini naslaga magnetita ili velikim metalnim konstrukcijama kao što su parking konstrukcije, 
čelikom ojačani podrumi, mostovi, automobili ili skele. NEMOJTE nositi predmete (poput 
mobilnog telefona) koji sadrže feromagnetne materijale u blizini letelice tokom kalibracije.  

Nije neophodno kalibrisati kompas kada letite u zatvorenom prostoru.  

Procedura kalibracije  

Izaberite otvoreni prostor da biste izvršili sledeći postupak.  

1. Dodirnite sistemsku traku u programu DJI GO 4, odaberite „Kalibriraj“ i sledite uputstva na 
ekranu. 

2. Držite letelicu vodoravno i zakrenite ga za 360 stepeni. Indikator statusa aviona postaće  
zelen. 

3. Držite letelicu vertikalno, sa nosom okrenutim prema dole, i zakrenite ga za 360 stepeni oko 
vertikalne ose. 

4. Ako indikator statusa letelice treperi crveno, kalibracija nije uspela. Promenite lokaciju i 
isprobajte postupak kalibracije ponovo 

 

 

 

 

 

 

 

Informacije o meniju na LCD ekranu daljinskog upravljača 

BAT xx PCT Nivo baterije na daljinskom upravljaču. 

SHUTDOWN_ Daljinski upravljač se isključuje. 

CHARGING_ Daljinski upravljač se puni. 

USB PLUGGED Mavic 2 je povezan sa računarom. 
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FC U-DISK Kontrolor leta čita podatke. 

UPGRADING Nadogradnja. 

BINDING Avion se obavezuje sa daljinskim upravljačem. 

Pre leta 

CONNECTING_ Daljinski upravljač povezuje se sa avionom. 

SYS INITING Sistem se pokreće. 

READY TO GO Spreman da poleti. 

Režimi leta 

BEGINNER U početničkom režimu. 

GPS MODE U režimu P-GPS. 

OPTI MODE U P-OPTI režimu. 

ATTI MODE U P-ATTI režimu. 

SPORT MODE U sportskom režimu. 

TRIPOD U režimu stativa. 

Status leta 

TAKING OFF Skinuti. 

LANDING Sletanje. 

GOING HOME Povratak kući. 

MAX ALT. Avion je dostigao maksimalnu visinu. 

MAX RADIUS Avion je dostigao maksimalni radijus. 

OBSTACLE Otkrivena je prepreka. 

NO FLY ZONE Avion se nalazi u zoni bez letanja. 

Status inteligentnih režima leta 

APAS MODE Korišćenje APAS-a. 

HYPERLAPSE Korišćenje Hiperlapse-a. 

QUICKSHOT Korišćenje QuickShots-a. 

ACTIVETRACK Korišćenje ActiveTrack-a. 

TAP FLY Korišćenje TapFly-a. 

POI MODE U modu interesovanja 

WAY POINT U režimu putnih tačaka 

Informacije o upozorenju i greškama sistema 

SYS WARNING+CHECK APP Sistem Upozorenje Pogledajte DJI GO 4 za više 
informacija. 

UNACTIVATED+CHECK APP Avion nije aktiviran. Pogledajte DJI GO 4 za 
više informacija. 
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MAG INTERF+CHECK APP Greška kompasa. Pogledajte DJI GO 4 za više 
informacija. 

BATTERY ERR+CHECK APP Greška baterije. Pogledajte DJI GO 4 za više 
informacija. 

SD ERR+CHECK APP Greška microSD kartice. Pogledajte DJI GO 4 
za više informacija. 

CALIBRATING Kalibracija IMU / Nije ponovo pokrenula letelicu 
nakon završetka kalibracije. 

STICK ERR+RE-CTR STCK Kontrolna palica nije centrirana. Ponovo 
centrirajte. 

WHEEL ERR+RE-CTR WHEL Levi točkić na daljinskom upravljaču nije 
centriran. Ponovo centrirajte. 

STICK ERR Greška kontrolne palice. Kalibrirajte upravljačke 
palice u DJI GO 4. 

MECH ERR Greška daljinskog upravljača. Kalibrirajte 
daljinski upravljač u uređaju DJI GO 4. Ako se 
ovaj problem i dalje nastavi, obratite se DJI-
jevoj podršci. 

SD FULL microSD kartica je puna. 

NO PROP Nema priključenih propelera. 

BAT TEMP HI Inteligentna baterija leta je previše vruća. 

BATTERY ERR Greška inteligentne baterije u letu. 

BAT TEMP LO Inteligentna baterija leta je previše hladna. 

LOW BATTERY Inteligentna baterija leta slaba. 

RC LOW BAT Baterija daljinskog upravljača je prazna. 

NO RC SIGNL Signal daljinskog upravljača je izgubljen. 

RC TEMP HI Daljinski upravljač je previše vruć. 

NO RTH Avion se ne može vratiti kući. 
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Sadržaj: 
 

Montaža                                                                                                                            1 
Osnovni pojmovi                                                                                                               1 
Upravljanje pažnjom gledalaca                                                                                         4 
Bipolarna organizacija prostora                                                                                        5 
Pravac pogleda                                                                                                                 6 
Neprekidnost toka radnje                                                                                                  9 
Usklađivanje radnje u redosledu kadrova                                                                         9 
Izmene u veličini plana slike i ugla snimanja                                                                  11 
Poštovanje pravca                                                                                                          13 
Poštovanje jasnog kontinuiteta                                                                                       15 
Trajanje                                                                                                                           19   
Tempo: Ritam                                                                                                                 20 
Greške u montaži                                                                                                            22 
Korekcija boja                                                                                                                 23 
Korekcija boja u Adobe Premiere Pro, vežba:                                                                25 
Lumetri Scopes u Adobe Premiere Pro                                                                          31 
DLog-M                                                                                                                           35 
Montiranje sa više kamera                                                                                              40 
Prečice za Adobe Premiere Pro                                                                                     47 
After Effects                                                                                                                    50 
Izgled programa i osnove                                                                                               50 
Rad u After Effects                                                                                                         52 
Izrada projekta i uvoz snimaka                                                                                       53 
Stvaranje kompozicije i rad sa lejerima                                                                          58 
O lejerima (slojevima)                                                                                                     60 
Dodavanje efekta za ispravljanje boje                                                                            62 
Animiranje kompozicije                                                                                                   66 
Priprema kompozicije teksta                                                                                           66 
Panel sa alatkama                                                                                                          68 
Uređivanje teksta                                                                                                            69 
Animiranje teksta sa unapred postavljenim animacijama                                               69 
O vremenskom kodu i trajanju                                                                                        70 
Timeline panel                                                                                                                71 
Razumevanje vremenskog grafikona ( time graph )                                                       71 
Efekti animiranja pomoću keyframe-ova                                                                         72 
Promena neprozirnosti pozadine                                                                                    74 
Pregled vašeg rada                                                                                                         75 
Maske i  animacija maski                                                                                                77 
Stvaranje kompozicije                                                                                                     78 
Izrada maske pomoću alata Pen                                                                                    79 
Uređivanje maske                                                                                                           80 
O modovima maskiranja                                                                                                 80 
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Izrada zakrivljenih maski                                                                                                 81 
Savijanje ručica smera                                                                                                    83 
Feathering ( omkešavanje ) ivice maske                                                                        84 
Zamena sadržaja maske                                                                                                84 
Premeštanje i promena veličine snimka                                                                         85 
Dodavanje refleksije                                                                                                       87 
Primena režima mešanja  ( Blending )                                                                            90 
Rad sa Photoshop-om i After Effects                                                                             91 
Video FX                                                                                                                         92 
Renderovanje i snimanje                                                                                                95 
Pravljenje obrazaca za red rendera                                                                                96 
Izrada šablona za podešavanje rendera za probni prikaz                                              96 
Izrada obrazaca za izlazne module                                                                                98 
O kompresiji                                                                                                                  102 
Priprema filmova za mobilne uređaje                                                                           103 
Prikazivanje filmova pomoću Adobe Media Encoder-a                                                103 
Renderovanje filma sa visokim  kvalitetom emitovanja                                                103 
Dodavanje još jednog unapred podešenog kodiranja u red                                         105 
Prikazivanje filmova                                                                                                      106 
Prečice                                                                                                                          107 
Dron                                                                                                                              109 
Uvod                                                                                                                             109 
Priprema letelice                                                                                                           110 
Priprema daljinskog upravljača                                                                                     113 
Dijagram letelice                                                                                                           114 
Aktivacija                                                                                                                       118 
LED-ovi i indikator statusa                                                                                            119 
Izbegavanje prepreka tokom RTH-a                                                                             123 
Korišćenje Vision sistema                                                                                             126 
Inteligentni modovi leta                                                                                                 129 
QuickShots                                                                                                                   131 
Korišćenje QuickShots-a                                                                                              132 
ActiveTrack 2.0                                                                                                             133 
Podešavanja parametara leta                                                                                       137 
Izlaz iz Tačke Interesa                                                                                                  138 
Napredni pilotski pomoćni sistemi                                                                                140 
Korišćenje baterije                                                                                                        144 
Gimbal i kamera                                                                                                            147 
Kontrola letelice                                                                                                            152 
DJI GO 4 App                                                                                                               158 
Let                                                                                                                                163 
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